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1 Introduction

1.1 About this manual
The AMS Machine Works Online Help guides you through using the software after
installation.

For information on the installation, see the AMS Machine Works System Guide
(MHM-97926). The System Guide includes information on installing the software and
performing administrator functions. The System Guide is included with the installation
files. Emerson recommends administrators to read the System Guide before attempting
installation and before reading the Online Help.

Table 1-1: Referenced Documents

MHM Numbrer Document name

MHM-97924-PBF AMS Asset Monitor Operating Manual

MHM-97932-PBF AMS Machine Works v1.7 System Guide

1.2 Symbols
Note
This symbol marks passages that contain important information.

 CAUTION

This symbol marks operations that can lead to malfunctions or faulty measurements, but
will not damage the device.

1.3 Where to get help
Emerson provides a variety of ways to reach your Product Support team to get the answers
you need when you need them:

Phone Toll free 800.833.8314 (U.S. and Canada)

+1.512.832.3774 (Latin America)

+63.2 702.1111 (Asia Pacific, Europe, and Middle East)

Email Guardian.GSC@Emerson.com

Web http://www.emerson.com/en-us/contact-us

To search for documentation on AMS Machinery Manager, visit https://
www.emerson.com/en-us/catalog/ams-ams-machinery-manager.

To view toll free numbers for specific countries, visit http://www.emerson.com/
technicalsupport.
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1.4 Terms of use
Software License Agreement

LICENSOR PROVIDES THE SOFTWARE SOLELY ON THE TERMS AND CONDITIONS SET
FORTH IN THIS AGREEMENT AND ON THE CONDITION THAT LICENSEE ACCEPTS AND
COMPLIES WITH THEM. BY OPENING THE SOFTWARE PACKAGE, INDICATING ASSENT
ELECTRONICALLY, OR DOWNLOADING, INSTALLING, COPYING, OR USING THE
SOFTWARE, THE LICENSEE AGREES TO ACCEPT THE TERMS AND CONDITIONS OF THIS
SOFTWARE LICENSE AGREEMENT (THE “AGREEMENT”) AND AGREE THAT THE LICENSEE IS
LEGALLY BOUND BY ITS TERMS. IF LICENSEE IS A CORPORATION, GOVERNMENTAL
ORGANIZATION, OR OTHER LEGAL ENTITY, THEN THE INDIVIDUAL ACCEPTING THESE
TERMS HEREBY REPRESENTS AND WARRANTS THAT THEY HAVE THE RIGHT, POWER, AND
AUTHORITY TO ENTER INTO THIS AGREEMENT ON BEHALF OF LICENSEE AND BIND
LICENSEE TO THESE TERMS. IF LICENSEE DOES NOT AGREE WITH THESE TERMS AND
CONDITIONS, DO NOT CONTINUE DOWNLOADING, INSTALLING, COPYING OR USING THE
SOFTWARE AND RETURN THE SOFTWARE FOR A REFUND.

Fisher Rosemount Systems, Inc., an Emerson Automation Solutions company (“Emerson”)
is the licensor of the Software. As used in this Agreement, the term “Software” refers to
software, firmware, and all related access keys, license management devices,
documentation (e.g., manuals and specifications) and libraries as well as revisions or
updates to the foregoing provided by Emerson or its distributor to Licensee. The term
“Documentation” means user manuals or operating instructions provided by Emerson
with the Software. “Proposal” means the applicable Emerson proposal describing the
Software.

LICENSE

Subject to Licensee’s compliance with this Agreement and payment of applicable fees,
Emerson grants Licensee a non-transferable, non-sublicensable, non-exclusive limited
license during the License Term to use the Software provided to Licensee solely: (a) for
Licensee’s internal business purpose, (b) in accordance with the Documentation, and (c)
by and through its Authorized Users. Emerson may, from time to time, revise or update
the Software and, in so doing, incurs no obligation to furnish such revisions or updates to
Licensee, except as otherwise provided in a separate written agreement. The “License
Term” means the period of time that Licensee is authorized to access the Software as
specified in the Proposal. If the “License Term” is not defined in the Proposal, then the
License Term will be twelve months.

RESTRICTIONS

Licensee may not exceed any limits applicable to Licensee’s use of the Software (e.g., as
may be identified in this license, the Product Terms, the applicable data sheet, the
Proposal, or the Documentation (collectively, the “Product Descriptions”)) nor use any
features of the Software for which Licensee have not purchased a license. To the extent
the Product Descriptions include a number of users, systems, tags, or other parameter,
Licensee may not use more than the specified parameter (or, as applicable, use the
Software in support of more than the specified parameter) without purchasing an
additional license. Emerson may use technological and/or other measures to prevent
unlicensed access to, or use of, the Software or its features, and Licensee acknowledges
and agrees to the use of such measures, and that Licensee shall not actually, nor attempt
to, remove, disable, circumvent, or otherwise create or implement any workaround to,
any such copy protection or security features. LICENSEE MAY NOT USE OR COPY THE
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SOFTWARE EXCEPT AS EXPRESSLY PROVIDED IN THIS LICENSE OR THE PRODUCT TERMS.
Licensee must reproduce and include the copyright notice on any copy Licensee is
expressly permitted to make in the Product Terms. LICENSEE MAY NOT REVERSE
ENGINEER, DECOMPILE, DECODE, OR OTHERWISE ATTEMPT TO DERIVE OR ACCESS THE
SOURCE CODE OF THE SOFTWARE, MODIFY, TRANSLATE, ADAPT, OR CREATE DERIVATIVE
WORKS OF THE SOFTWARE OR ANY COPY (PERMITTED ABOVE), IN WHOLE OR IN PART.
This Agreement and the Software may only be transferred or assigned (by operation of law
or otherwise) with Emerson’s written consent and upon payment of applicable transfer
fees. Unless otherwise expressly permitted in writing, Licensee may not use the Software
to provide hosted services, subscription services, training services, consulting services,
service bureau, time sharing, or rental use to third parties or otherwise provide the
Software or extend the benefit of the Software to any third party other than an Authorized
User that uses the Software for Licensee’s benefit. Licensee may not use the Software in
violation of any governmental law, regulation, or rule or use the Software for purposes of
competitive analysis of the Software, the development of a competing software product
or service, or any other purpose that is to the Licensor's commercial disadvantage. No
license, express or implied, is granted under any intellectual property directly or indirectly
owned by Emerson which does not specifically read on the Software as provided
hereunder, nor shall any license, except the license specifically granted herein, be implied
in law, implied in equity, or exist under the doctrine of patent exhaustion.

Responsibility for Use of Software

Licensee may permit subcontractors to access and use the Software solely (i) in
compliance with the terms of this Agreement and (ii) for Licensee’s benefit. Licensee shall
ensure that all such users comply with the terms of this Agreement. Notwithstanding the
foregoing, under no circumstances may Licensee provide access to the Software to a
competitor of Emerson. Licensee is responsible and liable for all uses of Licensee’s
instance(s) of the Software. Specifically, and without limiting the generality of the
foregoing, Licensee is responsible and liable for all actions and failures to take required
actions with respect to the Software by its authorized users or by any other person or
entity to whom Licensee or an authorized user may provide access to or use of the
Software.

SECURITY ASSESSMENTS

In the event Licensee wishes to assess the vulnerability of the Software (including
conducting a penetration test or any other form of vulnerability assessment or test),
Licensee agree to obtain Emerson’s prior written consent. Emerson will not unreasonably
withhold or unduly delay such consent, but Licensee agree that Emerson may require that:
(i) Emerson participate in any such tests/assessments, (ii) receive the results of such tests/
assessments, and (iii) Licensee not publish, distribute, or otherwise make available the
results (in whole or part) to any third party without the express written consent of
Emerson. Emerson may further require that any such tests/assessments be conducted in
accordance with and subject to a separate written agreement between Licensee and
Emerson.

DIGITAL SIGNATURES

Emerson may attach or otherwise associate digital signatures to files of the Software to aid
detection of subsequent modifications to such files. However, in attaching or associating
such digital signatures, Emerson does not (i) guarantee that the Software or the files can
be trusted, nor (ii) assume any liability or claim authorship with regard to third party files.

DATA PRIVACY AND USE
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When Licensee downloads, installs or uses the Software, Emerson may use automatic
means to collect information about Licensee’s device and about its use of the Software.
Licensee also may be required to provide certain information about Licensee or its users as
a condition to downloading, installing or using the Software or certain of its features or
functionality, and the Software may provide Licensee with opportunities to share
information about Licensee or its users with others. Emerson may collect information,
including but not limited to information relating to the manner or frequency of use of the
Software. This includes data that Emerson collects as part of Emerson’s services. Some of
the data Emerson collects is relatively static, such as data about the product (for example,
serial numbers and device IDs and the Emerson model and serial number), but other data
is more dynamic, such as information about current and past product usage levels,
information about abnormal product functioning, information about the status and
location of products used with the Software and/or Licensee’s device. Emerson collects
this data from Licensee and the product and transmit it through Licensee’s network and/or
Internet services. Monitoring may continue until the Software is deleted or the services are
cancelled or terminated. Note that if Licensee does not allow us to collect this information,
Emerson may not be able to provide the full capabilities of products and services. All
information Emerson collects through or in connection with this Software and the use of
the Software in connection with Emerson products is subject to the Emerson privacy
notice found at https://www.emerson.com/en-us/privacy-notice (“the Privacy Notice”).
Emerson will collect, use and disclose Licensee’s personal information and the personal
information of its additional users as set out in that Privacy Notice, and Licensee and the
additional users or third parties Licensee has granted access or control consent to us doing
so. The Privacy Notice applies subject to requirements of local law. In the event of a
conflict between the Privacy Notice and applicable data protection laws, the stricter
obligation applies. Furthermore, the data that is generated and collected by the Software
may be stored in a hosted environment at a location identified to Licensee in the
documentation for the Software. Licensee is solely responsible for compliance with all
applicable local, state and federal data sovereignty laws, regulations and restrictions as it
relates to the movement of data generated and collected by the Software. Licensee agrees
that Emerson may use all data that it collects or receives: (i) for purposes of supporting the
Software, verifying compliance with the terms of this Agreement, enforcing Emerson’s
rights, or performing services for Licensee; and (ii) once aggregated with data received
from other Emerson customers, for purposes of improving Emerson’s products or for any
other commercial purpose.

TITLE

Licensee acknowledges and agrees that the Software are licensed and not sold. Licensee
does not acquire any ownership interest in the Software under this Agreement, or any
other rights thereto, other than the limited license expressly granted above. Emerson and
its licensors reserve and shall retain their entire right, title, and interest in and to the
Software and all intellectual property rights in the Software, except as expressly granted to
the Licensee in this Agreement. Licensee’s right to use the same is at all times subject to
the terms and condition of this Agreement. Licensee acknowledges and agrees that the
Software is Emerson’s confidential information and will not be disclosed by Licensee to any
third party without Emerson’s prior written consent.

TERM; SUSPENSION

The term of this Agreement shall be for the License Term unless terminated earlier as
permitted below. Emerson may terminate this Agreement or suspend Licensee’s access to
the Software immediately upon written notice if Licensee breaches any material term or
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condition of this Agreement or fails to pay amounts owed for the Software and fails to cure
such breach or failure within thirty (30) days of a written notice from Emerson. Licensee
may cease use of the Software at any time but may not terminate this Agreement prior to
the end of the License Term. Upon expiration of the License Term or the earlier
termination of this Agreement as permitted above, Licensee agrees to promptly (i)
destroy the Software together with all copies in any form and confirm such destruction in
writing to Emerson or (ii) return the Software and all copies to Emerson. Any termination
of the Agreement shall not relieve Licensee of its obligation to pay, at the time of
termination, the applicable license fees for the remainder of the License Term. All fees paid
for the Software are non-refundable.

WARRANTY DISCLAIMER

TO THE MAXIMUM EXTENT PERMITTED BY LAW, THE SOFTWARE IS PROVIDED "AS IS"
WITHOUT WARRANTY OF ANY KIND AND EMERSON DISCLAIMS ANY AND ALL
WARRANTIES, CONDITIONS, REPRESENTATIONS, AND GUARANTEES WITH RESPECT TO
THE SOFTWARE, EITHER EXPRESS OR IMPLIED, ARISING BY LAW, USAGE OF TRADE,
COURSE OF DEALING, COURSE OF PERFORMANCE, PRIOR ORAL OR WRITTEN
STATEMENTS, OR OTHERWISE INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NON-
INFRINGEMENT. EMERSON MAKES NO REPRESENTATIONS OR WARRANTIES ON BEHALF
OF ITS LICENSORS. WITHOUT LIMITING THE FOREGOING, EMERSON DOES NOT WARRANT
(I) THAT THE SOFTWARE WILL BE FREE FROM ANY INTERRUPTIONS, DELAYS,
INACCURACIES, SERVER DOWN-TIME, ERRORS, OR OMISSIONS, (II) THE PERFORMANCE
OR RESULTS LICENSEE MAY OBTAIN BY USING THE SOFTWARE, OR (III) THE SOFTWARE
WILL MEET LICENSEE’S REQUIREMENTS. NO REPRESENTATION OR OTHER AFFIRMATION
OF FACT, INCLUDING STATEMENTS REGARDING CAPACITY, SUITABILITY FOR USE, OR
PERFORMANCE OF THE SOFTWARE, NOT CONTAINED IN THIS AGREEMENT SHALL BE
DEEMED TO BE A WARRANTY, CONDITION, REPRESENTATION, OR GUARANTY BY
EMERSON. LICENSEE SHALL BE SOLELY RESPONSIBLE FOR MAINTAINING ALL APPROPRIATE
BACKUPS OF ITS DATA.

INTELLECTUAL PROPERTY INFRINGEMENT

Emerson will defend Licensee against any claim that the Software developed by Emerson
infringes a third party’s intellectual property right (including patent, copyright, design
right and trademark) protectable under the laws of the country where the Software is first
used (an “Intellectual Property Claim”). Emerson will only pay any final judgment or
settlement entered into by Emerson resulting from the action. Should an Intellectual
Property Claim arise, or if Emerson reasonably believes an Intellectual Property Claim will
arise, then Emerson may, at its sole option and expense, provide a commercially
reasonable alternative. This may include procuring for Licensee the right to continue using
the Software or replacing them with a non-infringing item or changing them to become
non-infringing or refunding their price. Emerson’s indemnity obligations are conditioned
upon Licensee: (a) promptly notifying Emerson in writing that an Intellectual Property
Claim has been threatened or filed; (b) allows Emerson complete control of the defense
and settlement of the claim; and (c) gives all reasonable help and cooperation requested
by Emerson for the defense.

Emerson will not be liable for infringement, and Licensee will indemnify Emerson, if the
claim arises from any of the following: (i) Licensee’s equipment, materials, specifications,
designs, processes or other technical information; (ii) Software is used by Licensee in
combination with other items not furnished by Emerson; or (iii) Licensee modifies or
otherwise causes the Software to become infringing. THE INDEMNIFICATION RIGHTS OF
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LICENSEE UNDER THIS SECTION 10 SHALL BE THE EXCLUSIVE REMEDY OF LICENSEE WITH
RESPECT TO CLAIMS OF INTELLECTUAL PROPERTY INFRINGEMENT.

LIMITATIONS OF LIABILITY

TO THE FULLEST EXTENT PERMITTED UNDER APPLICABLE LAW AND NOTWITHSTANDING
ANYTHING TO THE CONTRARY IN THIS AGREEMENT OR ELSEWHERE: (I) IN NO EVENT
SHALL THE AGGREGATE LIABILITY OF EMERSON AND ITS AFFILIATES EXCEED THE FEES
PAID FOR THE SOFTWARE, IF THE LICENSE TERM IS PERPETUAL, OR THE AVERAGE ANNUAL
FEES PAID FOR THE SOFTWARE, IF THE LICENSE TERM IS NOT PERPETUAL; (II) IN NO EVENT
SHALL EMERSON OR ANY EMERSON AFFILIATE BE LIABLE FOR ANY DAMAGES ARISING
FROM A CYBER ATTACK OR ANY INDIRECT, INCIDENTAL, PUNITIVE, CONSEQUENTIAL,
EXEMPLARY, SPECIAL, LOSS OF DATA, OR LOST PROFITS DAMAGES OF ANY KIND
(INCLUDING ANY LOST REVENUE, PROFITS, SAVINGS, BUSINESS OPPORTUNITIES, USE, OR
GOODWILL) HOWEVER ARISING, REGARDLESS OF WHETHER SUCH DAMAGES ARE
FORESEEABLE.

THE LIMITATIONS OF LIABILITY ABOVE SHALL APPLY: (A) TO ALL CLAIMS IN THE
AGGREGATE ARISING UNDER OR RELATING TO THIS AGREEMENT OR THE SUBJECT
MATTER OF THIS AGREEMENT; (B) REGARDLESS OF THE LEGAL OR EQUITABLE THEORY
UNDER WHICH THE CLAIM ARISES, INCLUDING BREACH OF CONTRACT, TORT (INCLUDING
NEGLIGENCE), INDEMNITY, STRICT LIABILITY, OR OTHERWISE; (C) REGARDLESS OF
WHETHER EMERSON HAS BEEN ADVISED OF THE POSSIBILITY OR LIKELIHOOD OF SUCH
DAMAGES; AND (D) REGARDLESS OF IF THE REMEDIES UNDER THIS AGREEMENT FAIL OF
THEIR ESSENTIAL PURPOSE. THE LIMITATION OF LIABILITY IS AN AGGREGATE LIMIT AND
WILL NOT BE INCREASED BY THE EXISTENCE OF MORE THAN ONE CLAIM.

THE DISCLAIMER OF WARRANTIES AND LIMITATIONS OF LIABILITY CONTAINED IN THIS
AGREEMENT ARE FUNDAMENTAL PARTS OF THE BASIS OF THE PARTIES’ BARGAIN
HEREUNDER, AND LICENSEE ACKNOWLEDGES THAT SUCH PROVISIONS REPRESENT A
REASONABLE ALLOCATION OF RISK. IF THE FOREGOING LIMITATION OF LIABILITY IS
UNENFORCEABLE UNDER APPLICABLE LAW, THEN EMERSON’S LIABILITY UNDER THIS
LICENSE SHALL BE LIMITED TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW.

GOVERNING LAW

This Agreement, and all matters concerning its construction, interpretation, performance
or validity, shall be governed by the laws of the State of Missouri, excluding its conflict
laws. Each Party shall institute and maintain any legal suit, action, or proceeding arising
out of or relating to this Agreement in the federal or state courts in each case located in
the State of Missouri. EACH PARTY HEREBY IRREVOCABLY AND UNCONDITIONALLY: (A)
CONSENTS AND SUBMITS TO THE EXCLUSIVE JURISDICTION OF THE AFOREMENTIONED
COURTS; AND (B) WAIVES ANY OBJECTION TO THAT CHOICE OF FORUM BASED ON VENUE
OR TO THE EFFECT THAT THE FORUM IS NOT CONVENIENT. The 1980 United Nations
Convention on Contracts for the International Sale of Goods does not apply to this
Agreement.

EXPORT RESTRICTIONS

The Software, Documentation, and any related technical data included with, or contained
in, such Software, and any products utilizing any such Software, Documentation, or
technical data (collectively, "Regulated Products") may be subject to US export control
laws and regulations, including the Export Administration Regulations and the
International Traffic in Arms Regulations. The Customer shall not, and shall not permit any
third parties to, directly or indirectly, export, reexport, or release any Regulated Products
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to any jurisdiction or country to which, or any party to whom, the export, reexport, or
release of any Regulated Products is prohibited by applicable federal or foreign law,
regulation, or rule. The Customer shall comply with all applicable federal and foreign laws,
regulations, and rules, and complete all required undertakings (including obtaining any
necessary export license or other governmental approval), prior to exporting or
reexporting any Regulated Products.

U.S. GOVERNMENT RIGHTS

The Software is commercial computer software, as such term is defined in 48 C.F.R.
§2.101. Accordingly, if the Licensee is the US Government or any contractor therefor,
Licensee shall receive only those rights with respect to the Software and Documentation
as are granted to all other end users under license, in accordance with (a) 48 C.F.R.
§227.7201 through 48 C.F.R. §227.7204, with respect to the Department of Defense and
their contractors, or (b) 48 C.F.R. §12.212, with respect to all other US Government
licensees and their contractors.

NUCLEAR APPLICATIONS

THE SOFTWARE IS NOT FOR USE IN ANY NUCLEAR AND RELATED APPLICATIONS. Licensee
accepts the Software with the foregoing understanding and agree to indemnify and hold
harmless Emerson from any claims, losses, suits, judgments and damages, including
incidental and consequential damages, arising from such use, whether the cause of action
be based in tort, contract or otherwise, including allegations that Emerson’s liability is
based on negligence or strict liability.

THIRD PARTY SOFTWARE

To the extent that a third-party owns any portion of the Software licensed under this
Agreement, such third-party owner shall be a beneficiary of this Agreement and shall have
the right to enforce its rights under this Agreement independently of Emerson. Any third-
party Software, not licensed under this Agreement, shall be subject to third-party owner’s
applicable license agreement and registration requirement, and Licensee authorizes
Emerson to provide its contact information, including company name, mailing address,
telephone number, ship-to recipient address, and primary contact’s name, mailing
address, telephone number, and email address, to such third-party owner for the purposes
of product registration, support, and compliance with applicable import and export
control laws, regulations, orders, and requirements.

GEOGRAPHIC RESTRICTIONS

The Software is provided for use only within (a) the Republic of India, for Software which is
delivered to Licensee in the Republic of India, (b) the People’s Republic of China, for
Software which is delivered to Licensee in the People’s Republic of China, (c) Malaysia, for
Software which is delivered to Licensee in Malaysia, or (d) the Republic of Indonesia, for
Software which is delivered to Licensee in the Republic of Indonesia. If the Software is
delivered to Licensee in one of the foregoing countries, Licensee agree to use the Software
only within the Republic of India, the People’s Republic of China, Malaysia, or the Republic
of Indonesia as applicable. If Licensee transfers the Software to any other country, this
license is automatically terminated, and the transfer shall be void.

AUDIT

Licensee agree that Emerson may audit Licensee’s facility and records to confirm
compliance with the terms of this Agreement during the License Term and for two years
thereafter. Emerson agrees to provide reasonable written notice prior to conducting such
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an audit and agrees to conduct the audit during regular business hours without
unreasonably interfering with Licensee’s normal business operation. No more than one
audit may be conducted in any twelve-month period unless Emerson reasonably and good
faith believes that Licensee is in violation of the terms of this Agreement. The Licensee
shall cooperate with Licensor's personnel conducting such audits and provide all
reasonable access requested by the Licensor to records, systems, equipment, information,
and personnel, including machine IDs, serial numbers, and related information.

ENTIRE AGREEMENT

LICENSEE ACKNOWLEDGES THAT LICENSEE HAS READ THIS AGREEMENT, UNDERSTANDS
IT, AND AGREES TO BE BOUND BY ITS TERMS AND CONDITIONS. LICENSEE FURTHER
AGREES THAT IT IS THE COMPLETE AND EXCLUSIVE STATEMENT OF THE AGREEMENT
BETWEEN THE PARTIES WHICH SUPERSEDES ANY PROPOSAL OR PRIOR AGREEMENT,
ORAL OR WRITTEN, AND ANY OTHER COMMUNICATIONS BETWEEN THE PARTIES
RELATING TO THE SUBJECT MATTER OF THIS AGREEMENT. This Agreement is for the sole
benefit of the parties hereto and their respective successors and permitted assigns and
nothing herein, express or implied, is intended to or shall confer on any other person or
entity any legal or equitable right, benefit, or remedy of any nature whatsoever under or
by reason of this Agreement. This Agreement may only be amended, modified, or
supplemented by an agreement in writing signed by each party hereto. No waiver by any
party of any of the provisions hereof shall be effective unless explicitly set forth in writing
and signed by the party so waiving. Except as otherwise set forth in this Agreement, no
failure to exercise, or delay in exercising, any right, remedy, power, or privilege arising
from this Agreement shall operate or be construed as a waiver thereof; nor shall any single
or partial exercise of any right, remedy, power, or privilege hereunder preclude any other
or further exercise thereof or the exercise of any other right, remedy, power, or privilege. If
any term or provision of this Agreement is invalid, illegal, or unenforceable in any
jurisdiction, such invalidity, illegality, or unenforceability shall not affect any other term or
provision of this Agreement or invalidate or render unenforceable such term or provision
in any other jurisdiction.

For purposes of this Agreement, (a) the words "include," "includes," and "including" shall be
deemed to be followed by the words "without limitation"; (b) the word "or" is not exclusive;
and (c) the words "herein," "hereof," "hereby," "hereto," and "hereunder" refer to this
Agreement as a whole. Unless the context otherwise requires, references herein: (x) to
Sections, Annexes, Schedules, and Exhibits refer to the Sections of, and Annexes,
Schedules, and Exhibits attached to, this Agreement; (y) to an agreement, instrument, or
other document means such agreement, instrument, or other document as amended,
supplemented, and modified from time to time to the extent permitted by the provisions
thereof and (z) to a statute means such statute as amended from time to time and
includes any successor legislation thereto and any regulations promulgated thereunder.
This Agreement shall be construed without regard to any presumption or rule requiring
construction or interpretation against the party drafting an instrument or causing any
instrument to be drafted.

The headings in this Agreement are for reference only and do not affect the interpretation
of this Agreement.

PRODUCT TERMS:

ADDITIONAL TERMS FOR AMS Machine Works Software: In no case may Licensee use AMS
Machine Works Software for control of plant processes. You may make, install, and use a
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reasonable number of copies of the Software solely for the purpose of facilitating your use
of the Software.
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2 Overview
AMS Machine Works combines predictive maintenance techniques with comprehensive
analysis tools to provide easy and accurate assessment of the machinery health in your
facility. AMS Machine Works brings together related data and prioritizes assets and alarms
based on your configuration.

AMS Machine Works v1.7 includes support for AMS Asset Monitor, AMS Wireless Vibration
Monitor, AMS 9420 Wireless Vibration Transmitter, Ovation Machinery Health Monitor
and AMS 6500 ATG Online Vibration System.

AMS Machine Works provides an intuitive dashboard to help keep up with day-to-day
activities and machinery health. AMS Machine Works continues to be part of the
Plantweb™ Digital Ecosystem offering additional applications and asset sources.

AMS Machine Works applications

Configuration and interaction with the software happens through these applications,
which can be launched from a web browser:

• Asset Explorer — access and manage assets in your plant.

• Analysis Dashboard — view the status of your machines, devices, and the software at a
glance.

• Device Configuration — configure data collections.

• Event Viewer — view system generated events.

• Machine Configuration — configure monitored machines, map measurement points
to device channels and set up alerts.

• Machine Journal — create journal entries and collaborate on maintenance issues for
your plant's machines and devices.

• User Manager — control and monitor access to various areas of the software.

• Vibration Analyzer — analyze data from machines and devices. Vibration Analyzer can
be launched from a web browser, which will open the thick client application. However,
the vibration analyzer thick client application will have to be installed in the client
machine first.

Essential system functions are performed by web services. These services may or may not
have a user interface. Examples of services include management of the database
connections and regulation of communication within the system.

An OPC UA server is available for sending scalar data from AMS Machine Works to any OPC
UA-compliant client system.

Assets

An asset is any physical component such as a device, machine, or equipment being
monitored, or the logical representation of a physical asset.

In AMS Machine Works, assets are typically physical pieces of equipment, such as
machinery or monitoring devices. Examples include: motor, pump, fan, turbine, AMS 9420
Wireless Vibration Transmitter, the Emerson Wireless Gateway, and other devices.
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Interfaces

An interface collects data from devices about the devices themselves and about the
machines they are monitoring.

An example of an interface is the AMS Machine Works Wireless Interface. The AMS
Machine Works Wireless Interface collects data from wireless vibration devices using a
HART TCP connection to a wireless gateway.

2.1 AMS Machine Works Architecture
AMS Machine Works has three distinct architecture layers:

1. Interface Layer — connects to devices and collects vibration data

2. Services Layer — process the vibration data for health, alerts, aggregation, and
calculating further measurements

3. Application Layer — contains several web applications for data presentation,
configuration, maintenance, security, and data integration
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Figure 2-1: AMS Machine Works Architecture

2.2 System components
The system is comprised of many components, described in the table below. Refer to the
System Guide for information about where the components are installed.
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Table 2-1: System components

Component Description

AMS Machine Works Web Services The AMS Machine Works Web Service provides the essential
software components and interfaces to Device
Configuration, Machine Configuration, AMS Machine Works
Analysis Dashboard, and Machine Journal.

AMS Machine Works Web Service allows you to create
machines in Asset Explorer, perform analysis in AMS
Machine Works Vibration Analyzer, and log Journal Entries in
Machine Journal. It obtains data from various other
components, which can be installed on different servers.

AMS Machine Works Historian AMS Machine Works Historian keeps records of data so you
can analyze the trends in vibration data.

AMS Machine Works Interface
Router

AMS Machine Works Interface Router directs vibration data
traffic into the AMS Machine Works Historian.

AMS 6500 ATG Interface AMS 6500 ATG Interface Service allows you to bring data
into AMS Machine Works from an AMS 6500 ATG.

Ovation MHM Interface Ovation MHM Interface interacts with the Ovation
Machinery Health Waveform Recorder of an Ovation system
to allow you to collect prediction data from Ovation
Machinery Health Monitor modules.

Emerson Wireless Interface Emerson Wireless Interface brings data into AMS Machine
Works from wireless devices such as the AMS 9420 Wireless
Vibration Transmitter and AMS Wireless Vibration Monitor.

AMS Machine Works Vibration
Analyzer

Allows you to analyze vibration data.
AMS Machine Works installation must be complete before
you can install this component.

AMS Asset Monitor Interface AMS Asset Monitor Interface Service allows you to bring data
into AMS Machine Works from an AMS Asset Monitor.
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3 Device Configuration
The Device Configuration application allows you to set up the different types of data you
want to collect from devices and how often you want to collect it. The fundamental data
acquisition settings for the devices must already be configured using their respective
programs. The software does not attempt to change the fundamental data acquisition
settings of the devices.

Device Configuration is launched from the Analysis Dashboard or the Asset Explorer utility.

You set up Collections in AMS Machine Works using Device Configuration to save the
desired measurements for further analysis in the Analysis Dashboard and Vibration
Analyzer.

3.1 Device Configuration User Interface
Device Configuration has a very similar interface for all of the device types supported by
AMS Machine Works. However, there are a few differences based on the features and
capabilities of each device type. As an example, the Device Configuration dialog of the
AMS 6500 ATG is shown below, for the purpose of presentation of the general elements of
the user interface.
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Figure 3-1: Device Configuration: AMS 6500 ATG

A. Site navigation — Contains the name and location of the device you are configuring.
B. Collection Schedules — View the current list of Collections defined for this device.
C. Buffer Settings — Define how often selected data will be updated in the AMS Machine Works Analysis

Dashboard.
D. Device — Select a part of the device to display a list of available device measurements.
E. Collection Schedule — View or change the name and collection interval.
F. Demand Collection — Request that a Collection be processed immediately rather than waiting for the

collection time defined schedule.
G. Save Configuration — Save the configuration.
H. Reload Configuration — Select to start over with the already saved configuration, or select Restore Default

from the drop down menu to reload the configuration from the device.
I. User — Shows the user currently logged in.
J. Print Configuration — Display the configuration as a report in print preview mode.

K. Collection tab — View added measurements for the selected device, card, or channel.
L. Available measurements tab — View available measurements for the selected device, card, or channel.

M. Tag Licensing — Displays the total number of vibration tags currently in use by AMS Machine Works out of
how many it is licensed for. Adding more devices will not be possible while the licensed amount is exceeded
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Figure 3-2: Device Configuration: Available measurements tab

A. Filter applied — "Peak" filter applied causes a presentation of selected measurement types
B. Filter not applied — Peak To Peak filter icon shown
C. Search — Find desired measurements by typing the measurement name
D. P icon — Indicates a primary measurement
E. Lock icon — Indicates measurement type that is calculated in the device (Measurements with no lock icon

indicates calculations that are performed on the data after it is loaded into AMS Machine Works.)
F. Check mark icon — Indicates that a measurement has been added to the collection
G. Add icon — Click to add a measurement to the collection

Note
As a rule, measurements labeled with P are primary measurements collected at a fastest
rate (1 sec) by the device when compared to other native measurements collected from
the device.
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Figure 3-3: Device Configuration: Collection tab

A. Show details — View measurement details and make changes in enabled fields, if needed.
B. Check boxes — Place a check mark or remove a check mark in all of the displayed measurements.
C. Clock icon — Indicates a minimum time limit for time-based collections containing this measurement. Hover

the mouse over the icon to see the estimated time for collection.
D. Lock icon — Indicates measurement type that is calculated in the device (Measurements with no lock icon

indicate calculations that are performed on the data after it is loaded into AMS Machine Works.)
E. Remove icon — Click to remove the measurement from the collection.
F. Store — Place a check mark to store the data for use by AMS Machine Works, for future use in applications

such as Vibration Analyzer. Clearing the Store check box will prevent the data from storing to Historian.
However, that data can still be published to other systems via OPC UA.

G. Publish — Place a check mark to Publish data to latest values in Asset explorer and to other systems via OPC
UA. OPC UA will have to be installed in the AMS Machine Works Server and OPC UA client will have to be
configured. Publish is applicable only to scalar values. Waveforms and spectra are not available via OPC UA
currently.

3.2 Buffer Settings
Certain devices in our product portfolio are classified as online devices that can publish
data at a much faster rate than other devices (such as AMS 6500 ATG and Ovation MHM).
The Buffer Settings option defines how often the data from the device will be updated in
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the AMS Machine Works Analysis Dashboard. This allows the Analysis Dashboard to be
updated much faster than the allowable intervals chosen in Collection Schedule, which are
sent to the AMS Machine Works Historian for long term storage and analysis in Vibration
Analyzer. However, even if the Analysis Dashboard buffer controls are disabled, the
Analysis Dashboard will still display any data collected using the Collection Schedules.

From the Buffer Settings menu, you can select the  icons to enable the data to be

updated on the Analysis Dashboard, and select the  icons to edit the settings.

Note
Buffer settings are only applicable to AMS 6500 ATG and Ovation MHM devices. Buffer
Settings are not applicable for AMS Asset Monitor and Wireless Devices.
Ovation MHM and AMS 6500 ATG devices are online devices and can publish data at a
much faster rate. The Buffer settings in AMS Machine Works provides the mechanism to
store them at a faster rate for the short term (to be visualized in Analysis Dashboard) while
storing the data at a slower rate in the long-term database.

For AMS Asset Monitor, the rate at which the data is updated in the Analysis Dashboard is
determined by the settings defined in the AMS Asset Monitor User Interface (under Data
Collections Tab for Waveforms and Scalar update rate for Scalars)

For Wireless devices, the rate at which the data is updated in the Analysis Dashboard is the
same as the update rate defined in the collections for long term storage and visualizing it
in vibration analyzer

Figure 3-4: Device Configuration: Buffer General Settings
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Figure 3-5: Device Configuration: Buffer Advanced settings

3.3 Device Configuration recommended practices
Add measurements to collections only as needed for analysis

Evaluate which measurements you need before adding them to a collection schedule.
Only add a measurement to a collection schedule after carefully determining that it is
necessary for analysis. Long waveforms, waveforms, and spectra are data-heavy
measurements. While it is convenient to add all the measurements, collecting
unnecessary data needlessly uses system resources which could impact performance.

Create collections in groups for analysis

The more measurements there are in the collection, the more time it takes to complete a
Demand collection. When you have long waveforms in a collection, the demand
acquisition can take several minutes to complete. Demand collection times can also vary
depending on the type of the device. For wireless devices, usually hours for waveforms and
spectra collection and several minutes for scalars. For AMS Asset Monitor, AMS 6500 ATG,
and Ovation MHM devices, usually minutes for waveforms, spectra and scalar data
collection.

3.4 Configure device collection schedules in bulk
AMS Machine Works Device configuration application for wireless devices comes with the
capability to bulk configure device collection schedules for several wireless devices at once
using a single device as the master.

Note
This bulk configuration setting is not available for devices such as AMS Asset Monitor, AMS
6500 ATG, or Ovation Machinery Health Waveform Recorder. However, for those devices
you can use copy and paste between cards or channels in order to configure Collections.

1. Open the Device Configuration application for a wireless device.
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2. Complete the device configuration for all collection schedules by selecting the
collection interval, selecting the required measurements, selecting store, and
publish options.

3. Save the device. Now this device becomes the master for the bulk configuration.

4. Select Bulk configure option on the top right of the screen (It is recommended to
bulk configure by selecting devices in a gateway. Don’t bulk configure for the entire
system at once).

5. Select a gateway.

6. Review the devices that should have the same device collection schedules and
measurement selections as saved in the master device. Check the devices if you
want the configuration to be configured in bulk.

7. Once selection is complete, click Submit.

8. This should configure the selected devices with the collection schedule and
measurement selections as configured in the master device.

9. Repeat this, as needed, for devices in other gateways.

Figure 3-6: Bulk Configure Devices

Note
• Bulk configuration functionality is now improved and can complete the bulk

configuration even if the devices have different F-MAX, LOR, or other measurement
settings in the field.

• If the difference between the master device and the bulk configure device is very
different, then those measurements that are different are not copied over; but every
other measurement that is the same should be configured successfully. For Example:
Interval bands are configured in different axis. i.e. Master device has IB1 to IB4
configured on Z-axis; bulk configure device has IB1 to IB4 configured on X-axis).

3.5 Combined Measurement Locations
Combined measurement locations appear at the bottom of each card in Device
Configuration.
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Combined measurements are applicable to AMS 6500 ATG and Ovation MHM devices
only. The ATG channels can be configured in AMS Machine Studio as combined
measurements to enable a CML pseudo channel which can be mapped to machine train
measurement points and used for further analysis. Data from CML channels can be used
for Orbit Analysis since the data from the X and Y channels are collected at the same time.

Figure 3-7: Combined Measurement Locations selected

3.6 Collection Schedules
Collection schedules are logical entities to group the types of data collected from a device.
For AMS 6500 ATG and Ovation MHM, collection schedules are user defined and
customizable. You can create up to 25 collection schedules per device. We recommend to
limit to 3-4 per device. If you have the ATG assigned to more than one machine, it might
be logical to create 3-4 collections by machine. Our recommendation is the following:

• Native scalar variables

• Native waveforms and spectrums along with non-Native scalar variables

However, for Wireless and Asset monitor devices, these logical entities are fixed1.

By default, one collection task, a default collection schedule, is created when an AMS 6500
ATG device is added to AMS Machine Works. This collection task contains all the scalar
parameters that are native to (that is, calculated by) the device itself. It does not contain
any bulk data or parameters calculated by the interface that require bulk data to be read
from the device.

3.7 Device configuration and store on alert
In order to configure store-on-alert, at least one collection task must exist for the device
whose channel will be mapped to the measurement location on the machine where the
alert will be created in Machine Configuration.

1 Creating custom collection tasks does not apply to wireless devices. The system provides a set of predefined collection tasks. An important
reason for this difference is to help the user manage battery life for wireless devices.
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Related information

Configure Store on Alert for AMS 6500 ATG
Configure Store on Alert for AMS Wireless Vibration Monitor
Configure Store on Alert for AMS 9420
Configure Store on Alert for Ovation Machinery Health Module
Configure Store on Alert for AMS Asset Monitor
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4 Machine Configuration
You can set up monitored assets ("machines") and monitoring assets ("asset sources") in
the system from Machine Configuration. This is launched from the Analysis Dashboard or
the Asset Explorer utility.

Machine trains

When you create a machine, you are actually creating a machine train. Just like an
individual machine, machine trains are created from templates. The following are some
basic components of a machine train template:

Driver A machine that acts as the driving component in the train — For example,
a motor.

Intermediate An optional component, such as a gearbox, that connects the Driver and
Driven.

Driven The machine component that is being driven and is typically performing
some process function, such as pumping.

You can only configure one machine train at a time, but you can use Bulk Edit to make
copies of the machine train to populate your site with identical machine trains.

4.1 Machine Configuration User Interface
Machine Configuration guides you through creating the components of the machine train.
You can configure up to three machine components per machine train. For example,
configure a driver component such as a motor, an intermediate component such as a
gearbox and a driven component such as a pump, fan, agitator, blower, or generator. You
will need at least one machine component in your train to successfully create a machine in
AMS Machine Works.

Figure 4-1: Machine Configuration navigation

A. Location where new machine train will be created
B. Wizard progress indicator and tab selector
C. Username of logged in user
D. Previous and Next navigate between steps

To navigate between steps, click Previous or Next or select any step in the Wizard
progress indicator. You can only proceed to the next screen after completing all required
information on the current screen. You can skip between any screens already completed.
If you skip through the steps without configuring the details, the Machine Configuration
application will supply default values.
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Note
While Machine Configuration will allow you to accept default values for many fields, in
order to perform thorough machine health analysis, Emerson recommends that you
provide as complete and accurate information about your machines as possible.

4.2 Add a Machine Train

Procedure

1. In the Asset Explorer utility, select a location in the Location navigator.

2. From the Home ribbon menu, click New Train.
The Machine Configuration user interface appears in a new browser window. The
navigation wizard is at step 1. Machine Train Details.

3. In the Machine Train Information section, enter a name and a description for the
machine train.

4. Select one or more components.

Note
You can set up a single machine component in your machine train by selecting only
one component. However, to add an entire machine train, select a driver
component, an optional intermediate component, and a driven component.

When you select a component, an image replaces the gray box.

Figure 4-2: Machine Train Details with a motor added as the Driver Component

5. Click Next.
The navigation wizard advances to 2. Machine Details screen.

6. In Machine Details, enter a name and description for each machine component.
Each component is shown on the left side of the screen. If you selected only one
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component for this machine train, only one component icon is listed on the left. If
you selected driver, intermediate, and driven components, each component has an
icon displayed on the left.

7. Configure the details for each of the components manually or by using a pre-
configured machine component.

8. Click Search Library to select from a library of pre-configured machine
components.

9. An additional custom measurement location can be added by selecting Add
Custom Position below the machine component icon, if needed.

10. Click Add Bearing and look up your bearing by manufacturer, model, or other
identification.

11. When you locate the bearing, click the + icon in the Add column beside the bearing
to add it to the machine

You can create a custom bearing, if needed. Click Create Custom Bearing and add
the information about your bearing. Supply the most accurate information possible.
Otherwise, analysis features will be negatively impacted.

12. If you have other components like this, you can save this configuration to the
library. Click Save to Library.

13. Click Next.
The navigation wizard advances to 3. Channel Mappings.

14. In the Network Devices list, select one or more monitoring devices. Then, drag and
drop the sensors or channels onto the matching measurement locations on the
machine.

Click Add Device if your device is not listed. If your machine has more than one
monitoring device, select all applicable monitoring devices.

15. Click Add Measurement Location to create a combined measurement location, if
required.

Note
For a combined measurement location, you can change the orientation to
Horizontal + Vertical. You can also drag and drop a combined measurement
location in this custom measurement location.

16. Click Next.
The navigation wizard advances to 4. Machine Alerts.

17. In Machine Alerts, select Add Alerts.

Click the type of alarm to filter the alarms displayed in the list of alarms. View the
lists of alerts on the All Alerts tab.

The Add Alerts window displays the alerts from the device. You can select from
predefined alarms.

If alerts are defined within the device itself, you may choose to reuse these alerts as
the machine alerts. However, in many cases you may want to modify, disable or
create entirely new alerts for machines.
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Note
Any changes made to alerts for machines will not be downloaded to the devices
monitoring the machines. Use the configuration applications provided with the
devices to edit the configurations of the devices.

18. Place a check in the box beside one or more alerts and then click Add.
The added alerts appear in the Machine Alerts list.

19. If the alert needs additional values, fill in any additional required alarm values. Click
x to remove an alert from the list.

Expand the alert to display configuration types and Store on Alert.

20. Click Next.
The navigation wizard advances to 5. Summary.

21. Review the configuration settings. The Machine Train will be saved automatically
when the Summary page displays.

22. Click Print to save a PDF report of the configuration. Exit the print preview by
printing the report or by clicking Cancel.

23. Click Bulk Edit if you want to make copies of this configuration.

24. To change any settings, use the wizard navigation to go to the step needed to make
a change. If you make changes, save the configuration before closing Machine
Configuration.

25. Close the Machine Configuration tab in the browser.

The new machine train appears in Asset Explorer.

Note
Another way to create a new Machine Train is to use the copy and paste functions in Asset
Explorer for copying an entire Machine Train. However, Emerson recommends you do not
use the cut, copy, paste, or delete functions on the individual components of the Machine
Train.

4.3 View or print a summary of a machine train
configuration
You can print a summary of the machine train configuration that you have already created.

Prerequisites

Install a PDF generator as a printer on the computer if you want to save the report as a
PDF. Contact your IT department if you do not have a PDF option in your list of printers.

Procedure

1. In the Asset Explorer utility, select a machine train from the Location navigator.

2. From the Home ribbon, click Edit → Edit Machine.
The Machine Configuration user interface appears in a new browser window.

3. In the wizard navigation, select 5. Summary.

4. In Machine Train Summary, click Print.
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A new window displays a print preview of the summary.

5. Click Print to print the summary or click Cancel to close print preview.

4.4 Copy Trains and Alerts to edit machines in bulk
The Copy Trains and Copy Alerts options are available in the Machine Configuration user
interface. During machine configuration, these options appear at the summary step after
you have configured your machine train. To make copies of a machine you have already
created, in Asset Explorer select a component of the machine train and select Edit → Edit
Machine, then click 5. Summary in the Machine Configuration navigation menu.

When editing a machine train, you have the option to create a duplicate of the current
machine train an arbitrary (n) number of times under a specified location in the hierarchy.
This will copy machine details except for mappings of device channels to machine
measurement locations. The prediction alert levels are copied. However, they will not be
processed by the system until you map one or more device channels where those alerts
can be evaluated at the device level. After you add a device to the machine, you can return
to the Summary menu and apply the prediction alert levels to a specified set of machines.
The Copy Alerts button is available to copy only the alerts.

Procedure

1. From the Summary in Machine Configuration, click Copy Train.

The Copy Train dialog appears.

2. In the Copy Train tab, select the location in the hierarchy where you want to copy
the configuration.. Select the number of copies to create and click Submit.

Figure 4-3: Copy Train dialog

The dialog closes and returns to the Machine Configuration Summary page. The
machines you created are now visible in the Locations tab of Asset Explorer and
other applications that show the Locations hierarchy.

3. To copy the alerts, from the Summary in Machine Configuration, click Copy Alerts.

The Copy Alerts dialog appears.
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4. In the Copy Alerts dialog, select the machine component that you want to copy the
alerts from. On the right side of the dialog, select the machine train or component
you want to receive the copied alerts. Click Submit.

Figure 4-4: Copy Alerts dialog

The dialog closes and returns to the Machine Configuration Summary page. The
alerts you copied are now applied to the machines you selected.
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5 AMS Asset Monitor

5.1 Adding an AMS Asset Monitor as an Asset
Source
You can add the AMS Asset Monitor as an asset in AMS Machine Works. When added, it
appears as an asset source in the Asset Explorer Network hierarchy.

Prerequisites

Note
For more detailed information about the prerequisite steps to adding an AMS Asset
Monitor to AMS Machine Works, see AMS Asset Monitor Operating Manual Chapter 3.2
- External Interfaces (MHM-97924-PBF).

• Check the configuration in the AMS Asset Monitor web interface for the correct IP
addresses to enter in AMS Machine Works.

• Enable the AMS Machine Works Interface in the AMS Asset Monitor Web Interface.
This requires logging in as Administrator or Operator.

• An AMS Machine Works User must be created in the AMS Asset Monitor Web
Interface: on the left-side navigation bar go to the Userstab > New User and in the
Roles section choose AMS Machine Works User. The user credentials created in this
step will be used for adding AMS Asset Monitor as an asset source in AMS Machine
Works.

• A data collection has to be created in the AMS Asset Monitor Web Interface with at
least one asset source added to ensure Waveform / Spectra are stored: on the left-side
navigation bar go to the Data collections tab, under Basic tick Enabled, then under
Schedule & Predicate set up a schedule that corresponds to your needs and setup.
Click on + Add Source to add at least one Waveform source before moving to the next
step.

Note
The minimal interval for data storage is 1 hour for a single AMS Asset Monitor and the
maximum recommended interval for data storage is 1 month. A standard
recommended interval for data storage is 1 week. For recommended schedule settings
see Table 5-1

• A Scalar Values publish rate must be configured in the AMS Asset Monitor Web
Interface: on the left-side navigation bar go to the Systemtab > Configure > AMS
Machine Works interface and set up a Scalar values publish rate.

 CAUTION

The publish rate for scalar values will impact the performance of AMS Machine Works.
Please refer to the table below for the recommended configuration settings.
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Table 5-1: AMS Asset Monitor data storage and publish rates

Data Type Short Term Historian (configured in
AMS Asset Monitor)

Long Term Historian (configured in
AMS Machine Works)

Min1 Default Max Min Default Max

Scalars 60 sec 1800 sec 3600 sec 30 min 1 hour 24 hours

Waveform /
Spectrum

1 hour 1 week 1 month N/A N/A N/A

1 Minimum rates are only recommended for a single AMS Asset Monitor at a time

Note
Unlike other Emerson Devices compatible with AMS Machine Works, which can be tasked
by AMS Machine Works to send over their data, AMS Asset Monitor sends its data to AMS
Machine Works on the basis of scalar value publish rate settings and data collection
settings only, independently of any configuration made in AMS Machine Works. Likewise,
asset configuration in the AMS Asset Monitor Web Interface is done independently of asset
configuration in AMS Machine Works and is utilized for data analysis in AMS Asset Monitor
only. For more details on asset configuration and the AMS Asset Monitor Web Interface,
please refer to theAMS Asset Monitor Operating Manual Chapter 6.5 - Assets
(MHM-97924-PBF).

Adding an AMS Asset Monitor as an Asset Source

Procedure

1. In the Asset Explorer utility, select the Network tab, expand AMS Machine Works
and select Asset Monitor Interface.

2. From the Home ribbon menu, select Add Asset Source.

Note
The Add Asset Source button is only displayed if the user has
MANAGEASSETSOURCE permission.

The Add AMS Asset Monitor dialog appears.

3. In the dialog, enter the following:

Field Description

Name The name for the AMS Asset Monitor.

Primary IP Address The Primary IP Address is required.

Username The username for a user with the AMS Machine Works User role
created in the AMS Asset Monitor web interface.

Password The password for a user with the AMS Machine Works User role
created in the AMS Asset Monitor web interface.

4. Click Add Device.

A new node with the name provided appears below AMS Asset Monitor Interface in the
Network navigator.
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Postrequisites

Select the new node and click Configure Asset Monitor from the Home ribbon menu to
configure collection schedules and measurement parameters to add to AMS Machine
Works.

5.2 Configure AMS Asset Monitor data collection
for analysis
Procedure

1. From Asset Explorer, select the NETWORK tab.

2. Expand AMS Machine Works → AMS Asset Monitor Interface and and select a
device from the list of devices.

3. Click Configure Asset Monitor in the ribbon menu.
The Device Configuration application opens in a new browser window.

Figure 5-4: Device Configuration: AMS Asset Monitor

Note
The configuration should be available immediately. If the AMS Machine Works User
credentials where input incorrectly, an AMS Asset Monitor is still added to AMS
Machine Works but it will not deliver any data and the confgiration will not be
available, displaying instead the following pop-up. In this case, remove the AMS
Asset Monitor as an asset source and re-add it, ensuring the AMS Machine Works
User credentials are input correctly.
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Figure 5-5: Device not discovered error pop-up

The default Collections are displayed in the list of collections. These are grouped by
the types of data available to collect:

• Device Diagnostics

• External Data Points

• Primary Variables

• Waveforms & Spectra

4. Select a collection in the list to view or change an existing collection.

A limited number of collections can be created. The number of available collections
displays in the Collections list.

5. In the Collection Schedule tab, for each Collection Name you can change the
Collection Interval Type, and Duration (except for Waveforms & Spectra, which
must be changed in the Asset Monitor Web Interface).

6. In the Device Measurements section, click the arrow beside one or more
measurements to view the details of the added measurement.

7. 7. For each measurement, choose an option to Store and Publish the
measurements.

• Place a check mark in the Store column to store the measurement for later
analysis.

• Place a check mark in the Publish column to make the data available to
Plantweb™ Optics or other applications via OPC UA.

8. Click Save Configuration.

After you save a collection, data will be collected according to schedule. You can also
perform a demand collection to trigger the data collection immediately.
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5.3 Perform a Demand Collection from an AMS
Asset Monitor
You can perform a Demand Collection on all collections. This lets you start a data
collection immediately instead of waiting until the next scheduled collection interval.

Prerequisites

Configure a collection task for the AMS Asset Monitor in AMS Machine Works. The
collection must be saved first.

Procedure

1. From Asset Explorer, select the NETWORK tab.

2. Expand AMS Machine Works → AMS Asset Monitor Interface and click the name
of the AMS Asset Monitor to select it.

3. Click Configure AMS Asset Monitor.
The Device Configuration screen opens in a new browser window.

4. Click Demand Collection. This will affect all collections.

5. Close the configuration.

The data obtained by this collection is available to view in AMS Machine Works Vibration
Analyzer.

Note
The more measurements there are in the collection, the more time it takes to complete a
demand collection. When you have long waveforms in your collection, it may take several
minutes to complete.

5.4 Tips for adding AMS Asset Monitor in AMS
Machine Works
After adding an AMS Asset Monitor to AMS Machine Works, allow AMS Machine Works to
completely discover the device, including CHARMs, channels, and configuration before
further configuration in AMS Machine Works. This usually takes 5 to 15 minutes. AMS
Machine Works may let you configure the AMS Asset Monitor using Device Configuration.
However, the long waveform parameters may not have been fully discovered. Emerson
recommends waiting at least 15 minutes before configuring the AMS Asset Monitor in
AMS Machine Works Device Configuration.

Wait until the AMS Asset Monitor is completely discovered before configuring a machine
train and mapping AMS Asset Monitor channels to the machine train's measurement
locations. If you need to configure the machine train, in the Machine Configuration steps,
skip the channel mappings and alert configuration until the AMS Asset Monitor is fully
discovered.

While adding an AMS Asset Monitor to AMS Machine Works, if any of the connection
information does not match the device, such as an incorrect IP address, username, or
password, delete the AMS Asset Monitor from Asset Explorer and add the device again.
The connection parameters cannot be edited after they are added. However, the
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description of the device in the Properties tab in Asset Explorer can be edited after the
AMS Asset Monitor is added.

5.5 Configure Store on Alert for AMS Asset Monitor
Unlike for other devices, configuring Store on Alert for AMS Asset Monitor is a single-step
process done by configuring alert settings in Machine Configuration.

Prerequisites

This procedure assumes the device's other collections are configured and the machine
train is already configured.

Procedure

Configure the alert settings.

a) In the Asset Explorer utility, select a machine train in the Location navigator.

b) From the Home ribbon menu, click Edit → Alarm Edit.
The Machine Configuration user interface appears in a new browser window.

c) Click Add Alerts.

Figure 5-6: Machine Configuration

d) In the Add Alerts dialog, place a checkmark beside the measurement and adjust the
settings for each alert level, if needed. Click Add.

e) For AMS Asset Monitor, Store on Alert settings are enabled by default for all alert
levels. All the measurements selected in the device configuration are stored for any
alert trigger.

f) Expand the measurement, select All Locations or By Location

Figure 5-7: Alerts
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g) Click Save Changes.

h) Wait for the Machine Train saved successfully message, then click OK and close the
Machine Configuration dialog.

View the measurements in the Dashboard by navigating to the Machine Details and
viewing the available measurements and by viewing the collections in Vibration Analyzer.
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6 AMS 6500 ATG

6.1 Add an AMS 6500 ATG as an Asset Source
You can add the AMS 6500 ATG as an asset in AMS Machine Works. When added, it
appears as an asset source in the Asset Explorer Network hierarchy.

Prerequisites

• Check the configuration in AMS Machine Studio for the correct IP addresses and port
number to enter in AMS Machine Works.

• Ensure the device already has collection tasks, collection triggers, and whitelists
include the IP address of the server on which AMS Machine Works' AMS 6500 ATG
Interface is installed.

• If the AMS 6500 ATG is connected to AMS Machinery Manager, it must be disconnected
from AMS Machinery Manager before you connect it to AMS Machine Works. The
device cannot be connected to both systems.

Procedure

1. In the Asset Explorer utility, select the Network tab, expand AMS Machine Works
and select AMS 6500 ATG Interface.

2. From the Home ribbon menu, select Add Asset Source.

Note
The Add Asset Source button is only displayed if the user has
MANAGEASSETSOURCE permission.

The Add AMS 6500 ATG dialog appears.

3. In the dialog, enter the following:

Field Description

Name The name for the AMS 6500 ATG.

Primary IP Address The Primary IP Address is required.

Secondary IP Address The Secondary IP Address is required only if redundant
communication is already configured for the device. Otherwise,
leave the default setting of 0.0.0.0.

Modbus Port Number The port to receive MODBUS data from the device. Use 502 for
the default port.

Configuration Port
Number

The port for receiving configuration information from the device.
Use 4841 for the default port.

4. Click Add Device.

A new node with the name provided appears below AMS 6500 ATG Interface in the
Network navigator.
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Note
Please wait for 10 to 15 minutes before proceeding to Configure ATG in order to allow it
to discover all capabilities. Configuring the ATG to quickly could lead to configuration
issues.

Postrequisites

Select the new node and click Configure ATG from the Home ribbon menu to configure
collection schedules and measurement parameters to add to AMS Machine Works.

6.2 Configure AMS 6500 ATG data collection for
analysis
The AMS 6500 ATG is configured in the AMS Machine Studio program. The configuration
done by AMS Machine Works defines the information requested from the AMS 6500 ATG.
The software does not attempt to write configuration data to the AMS 6500 ATG.

You must set up data collection in AMS Machine Works using Device Configuration to save
the desired measurements for further analysis in Vibration Analyzer.

Prerequisites

The AMS 6500 ATG must already have a collection task defined in AMS Machine Studio.

Procedure

1. From Asset Explorer, select the NETWORK tab.

2. Expand AMS Machine Works → AMS 6500 ATG Interface and click the name of the
AMS 6500 ATG to select it.

3. Click Configure ATG in the ribbon menu.
The Device Configuration application opens in a new browser tab.

4. In the Collection list, click Add Collection.

A limited number of collections can be created. The number of available collections
displays in the Collections list.

5. In the Collection Schedule tab, enter a Collection Name, Collection Interval Type,
and Duration.

6. In the left tab of Device Measurements, choose available measurements by using
navigation in the device list and applying filters in the measurements list.

The list displays measurements depending on the selection on the device list on the
left side of the screen. Select the system rack level (top) to display measurements in
the system. To display only the measurements per card, select the card.

Use the filter toolbar to narrow your selection with filter buttons. Also, you can type
a custom search filter and click  to show matching measurements. Click  to add
the filter or click the X to remove the filter.
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Figure 6-1: Device Configuration: Available measurements tab

A. Filter not applied—Peak filter icon shown
B. Filter applied—Peak to Peak filter icon shown
C. Search—Find desired measurements by typing the measurement name
D. P icon—Indicates a primary measurement
E. Lock icon—Indicates measurement type that is calculated in the device (Measurements with no lock icon

indicate calculations that are performed on the data after it is loaded into AMS Machine Works.)
F. Check mark icon—Indicates that a measurement has been added to the collection
G. Add icon—Click to add a measurement to the collection

7. In the left tab in Device Measurements, click  beside one or more measurements
to add to the collection.

Note
After filtering the measurements, if you need to add all of the measurements
shown, select Add all at the bottom right corner.

The number of items in the Collection Schedule tab increments by the number of
items added from the left tab.

8. Select the Default Collection Schedule tab to display the measurements added in
the collection by using navigation in the device list and applying filters in the
measurements list.
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The list displays measurements depending on the selection on the device list on the
left side of the screen. Select the system rack level (top) to display measurements in
the system. To display only the measurements per card, select the card.

Figure 6-2: Device Configuration: Collection Schedule tab

A. Show details—View measurement details and make changes in enabled fields, if needed.
B. Check boxes—Place a check mark or remove a check mark in all of the displayed rows.
C. Clock icon—Indicates an amount of time required to collect the measurement. Hover the mouse over the

icon to see the estimated time for collection.
D. Lock icon—Indicates measurement type that is calculated in the device (Measurements with no lock icon

indicate calculations that are performed on the data after it is loaded into AMS Machine Works.)
E. Remove icon—Click to remove the measurement from the collection.
F. Store—Place a check mark to store the data for use by Machine Works, for future use in applications such as

Vibration Analyzer. Clearing the Store check box will prevent the data from storing to Historian. However,
that data can still be published to other systems via OPC UA.

G. Publish—Place a check mark to publish data to other systems via OPC UA.

9. In the Collection Schedule tab, click the arrow beside one or more measurements
to view the details of the added measurement.

10. Click X beside a measurement to remove it from the collection, if needed.
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The number of items in the Collection Schedule tab decreases by the number of
items removed from the right tab.

11. For each measurement, choose an option to Store and Publish the measurements.
• Place a check mark in the Store column to store the measurement for trending

over time such as in Vibration Analysis.

• Place a check mark in the Publish column to publish data to Latest Values tab.

12. Click Save Configuration.

If you make changes you do not want to save, click Reload Configuration to start
over with the already saved configuration. The Restore Default option is also
available which resets the configuration to the default from the device before being
added to AMS Machine Works.

After you save a collection, data begins to collect on schedule. You can also perform a
demand collection on the selected collection to trigger the data collection immediately.

6.3 Perform a Demand Collection from an AMS
6500 ATG
You can perform a Demand Collection on selected collections. This lets you start a data
collection immediately instead of waiting until the next scheduled collection interval.

Prerequisites

Configure a collection task for the AMS 6500 ATG in AMS Machine Works. The collection
must be saved first.

Procedure

1. From Asset Explorer, select the NETWORK tab.

2. Expand AMS Machine Works → AMS 6500 ATG Interface and click the name of the
AMS 6500 ATG to select it.

3. Click Configure ATG.
The Device Configuration screen opens in a new browser tab.

4. Select the collection task you want to collect now.

5. Select the Demand Collection tab.

The Demand Collection tab shows the status as a line with checkpoints of the data
collection process.

6. Click Demand Collection.

Tip
If the Demand Collection is inactive, try saving the collection first.

7. Close the configuration.

The data obtained by this collection is available to view in AMS Machine Works Vibration
Analyzer.
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Note
The more measurements there are in the collection, the more time it takes to complete a
demand collection. When you have long waveforms in your collection, it may take several
minutes to complete.

6.4 Tips for adding AMS 6500 ATG in AMS Machine
Works
After adding an AMS 6500 ATG to AMS Machine Works, allow AMS Machine Works to
completely discover the device, including cards, channels, and configuration before
further configuration in AMS Machine Works. This usually takes 5 to 15 minutes. AMS
Machine Works may let you configure the AMS 6500 ATG using Device Configuration.
However, the long waveform parameters may not have been fully discovered. Emerson
recommends waiting at least 15 minutes before configuring the AMS 6500 ATG in AMS
Machine Works Device Configuration.

Wait until the AMS 6500 ATG is completely discovered before configuring a machine train
and mapping AMS 6500 ATG channels to the machine train's measurement locations. If
you need to configure the machine train, in the Device Configuration steps, skip the
channel mappings and alert configuration until the AMS 6500 ATG is fully discovered

Ensure the AMS 6500 ATG firmware is updated before adding the device to AMS Machine
Works. If the AMS 6500 ATG health displays as zero, and data does not appear in AMS
Machine Works, review the steps for preparing the AMS 6500 ATG for AMS Machine Works
to see if any configuration settings do not match. Also, in AMS Machine Works review error
messages in the Event Viewer logs.

While adding an AMS 6500 ATG, if any of the connection information does not match the
device, such as an incorrect IP address, Modbus TCP port number, or ATG service port
number, delete the AMS 6500 ATG from Asset Explorer and add the device again. The
connection parameters cannot be edited after they are added. However, the description
of the device in the Properties tab in Asset Explorer can be edited after the AMS 6500 ATG
is added.

6.5 Configure Store on Alert for AMS 6500 ATG
Configuring Store on Alert is a two-step process. First, in Device Configuration, create a
collection with an interval type of Store on Alert. Second, configure the alert settings in
Machine Configuration.

Prerequisites

This procedure assumes the device's other collections are configured and the machine
train is already configured.

Procedure

1. Create the Store on Alert collection in Machine Configuration.

a) From Asset Explorer, in the NETWORK tab, expand AMS Machine Works →
AMS 6500 ATG Interface and click the name of the AMS 6500 ATG to select
it.
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b) Click Configure ATG in the ribbon menu.
The Device Configuration application opens in a new browser tab.

c) In the Collection list, click Add Collection.

d) In the Collection Schedule tab, enter a Collection Name and for Collection
Interval Type, select Store On Alert.

Note
Emerson recommends adding "Store on Alert" or "(SoA)" to the name of the
collection to help you identify the collection later when configuring the alert
settings.

Figure 6-3: Configure Store on Alert for AMS 6500 ATG

e) In Device Measurements, in the left tab, click  beside one or more
measurements to add to the collection.

f) In the right tab, place a check mark in the Store column for each
measurement in the Store on Alert collection.
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Figure 6-4: Configure Store on Alert for AMS 6500 ATG

g) If you want to collect this measurement normally, and not only when in alert,
be sure the measurements are also in a separate collection schedule with
Collection Interval Type set to a time.

Figure 6-5: Configure Store on Alert for AMS 6500 ATG

h) Click Save Configuration.

2. Configure the alert settings.

a) In the Asset Explorer utility, select a machine train in the Location navigator.

b) From the Home ribbon menu, click Edit → Alarm Edit.

Online Help AMS 6500 ATG
July 2022

AMS Machine Works v1.7 51



The Machine Configuration user interface appears in a new browser window.

c) Click Add Alerts.

Figure 6-6: Machine Configuration

d) In the Add Alerts dialog, place a checkmark beside the measurement and
adjust the settings for each alert level, if needed. Click Add.

e) Expand the measurement, select All Locations or By Location and select
Store on Alert Settings.

Figure 6-7: Alerts

f) In the Store on Alert dialog, place a checkmark in the box beside the
measurement and select the alert level from the menu. Click OK.
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Figure 6-8: Store on Alert Settings

g) Click Save Changes.

h) Wait for the Machine Train saved successfully message, then click OK and
close the Machine Configuration dialog.

View the measurements in the Dashboard by navigating to the Machine Details and
viewing the available measurements and by viewing the collections in Vibration Analyzer.

Related information

Device configuration and store on alert
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7 Emerson Wireless Gateway
The AMS Machine Works Wireless Interface allows you to bring data from an Emerson
Wireless Gateway and connected devices into AMS Machine Works. Once installed, you
can do the following from AMS Machine Works:

• Add an Emerson Wireless Gateway

• Remove the Emerson Wireless Gateway

• Configure AMS 9420 data collection and storage

• Map AMS 9420 sensor channels to machine measurement points

• Configure AMS Wireless Vibration Monitor devices.

• Map AMS Wireless Vibration Monitor sensor channels to machine measurement points

Note
In Asset Explorer, the Latest Values tab does not populate any values for the Gateway.
Click on the devices under the Gateway to show data in the Latest Values tab.

7.1 Add an Emerson Wireless Gateway to AMS
Machine Works
When you connect an Emerson Wireless Gateway to AMS Machine Works you can set up
your system quickly by mapping the devices in your site. If you do not have a gateway
connected, you can set up your site with locations, assets, and machines and add devices
later.

Prerequisites

• The Emerson Smart Wireless Gateway is already configured with the devices you intend
to join in AMS Machine Works.

• Port 5094 is open on the network and enabled in the Emerson Smart Wireless Gateway.

Procedure

1. In the Asset Explorer utility, select the Network tab, expand AMS Machine Works
→ Wireless Interface.

2. From the Home ribbon, select Add Asset Source. The Add Asset Source button is
only displayed if the user has MANAGEASSETSOURCE permission.

3. In the dialog, enter the following:

Table 7-1: Device Configuration: Add Emerson Wireless Gateway 

Field Description

Name The name for the Gateway. This is a name you supply. It does not
have to match a setting on the gateway.

IP Address The Gateway IP address.
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Table 7-1: Device Configuration: Add Emerson Wireless Gateway (continued)

Field Description

Port Number Use 5094 for an unsecured HART connection.

Note
The above values are default port numbers. Check the Gateway
web interface to ensure you enter the correct port number.

Enable Secure Protocol Confirm the IP address is entered, and then check the box to
enable the use of security protocols. If after checking the box the
IP dissapears, uncheck the box, enter your IP adress and then
check the box again.

Note
Before connecting with this option, you must first perform the
following steps:
• Install the Emerson Wireless Gateway 1420 Security Setup

Utility.

• Enable secure communication for the Gateway.

 CAUTION

Enabling secure protocol is not recommended as this can lead to
potential connection issues.

 CAUTION

Ensure that all entered information (Name, IP address, port number) is correct.
Inputting any of these incorrectly may lead the EWGService.exe process to cause
performance issues. If this happens, remove the device from Machine Works
completely.

4. Click Add Wireless Gateway.

The Emerson Wireless Gateway appears in the Network navigator. You can now configure
data collection from each device and map channels from the devices to measurement
locations on machines.

Note
You can easily connect to a different Emerson Wireless Gateway by opening the
Properties tab of the selected Emerson Wireless Gateway in the Asset Explorer and editing
the Gateway IP Address parameter under General Information. Inputting the IP address
of a different Emerson Wireless Gateway will result in that Gateway replacing the old one.
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Figure 7-1: Changing the Gateway IP Address of an Emerson Wireless Gateway within
Asset Explorer

Related information

Enable secure communication with an Emerson Wireless Gateway

7.2 Enable secure communication with an Emerson
Wireless Gateway
If the gateway is configured to use secure communication, follow this procedure to enable
connections to the gateway.

Perform these steps on the server hosting the Wireless Interface only after installing and
setting up the proxy using the Emerson Wireless Gateway's Security Setup Utility.

Prerequisites

Install the latest version of Security Setup Utility (v1.5.7 or later) for the Emerson Wireless
1420 Gateway on the server where the Wireless Interface is installed.

Use the Security Setup Utility to set up the proxy and exchange the security certificate with
the gateway, following setup instructions provided in the Emerson Wireless Gateway
Reference Manual. After this configuration is complete, you need to know the Local Port
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number to use for the connection in AMS Machine Works. Please refer to KBA
NK-2000-0761 for more details on setting up a secure HART-IP proxy.

Procedure

1. Launch the Rosemount Security Setup application.

2. Select Add HART-IP Proxy from the drop-down menu.

3. Right-click on the icon that appears and select Properties.

4. Fill out the Edit Properties dialog that appears and click OK:

• Hostname: Can be anything

• Address: IP address of the 1420 Gateway

• Server Port: 5095 for the Secure HART-IP port on the gateway

• Local Port: PC port to be used with proxy. This will be entered into AMS
Machine Works Add Asset dialogue in Device Config

5. Click File and select Save.

6. Fill out the Certificate Information dialogue that appears. This information will
appear in the 1420 Gateway web interface once the certificate is exchanged.

7. Fill out the Authenticate dialogue that appears. User and Password are the ones
used to sign in on the 1420 Gateway’s web interface

Once the certificate is exchanged with your 1420 Gateway, the Status property under
File>Properties will change to Good. It is also possible to ensure that the certificate was
exchanged properly within the 1420 Gateway web interface.

7.3 Troubleshooting - Emerson Wireless Gateway
Emerson Wireless Gateway process is using 100% of CPU.

Device does not exist

The wireless gateway does not exist, or you may have entered incorrect information.

• Ensure that all entered information of the gateway (Name, IP Address, port number) is
correct. Inputting any of these incorrectly may cause the EWGService.exe process to
cause performance issues.

• Restart the service, and then delete the gateway that has incorrect information.
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8 AMS Wireless Vibration Monitor

8.1 Configure AMS Wireless Vibration Monitor
data collection for analysis
The AMS Wireless Vibration Monitor is configured in the AMS Device Manager or Field
Communicator such as AMS TREX. The configuration accomplished by AMS Machine
Works defines the information requested from the device. The software does not attempt
to write configuration data to the device.

You must set up data collection in AMS Machine Works using Device Configuration to save
the required measurements for further analysis in Vibration Analyzer.

Prerequisites

• The device must already be configured and joined to an Emerson Wireless Gateway.

• Add the Emerson Wireless Gateway to AMS Machine Works.

Procedure

1. From Asset Explorer, select the NETWORK tab.

2. Expand AMS Machine Works → Wireless Interface, select the Emerson Wireless
Gateway, and select the device from the list of devices.

3. Click Configure Device in the ribbon menu.
The Device Configuration application opens in a new browser tab.

Figure 8-1: Device Configuration: AMS Wireless Vibration Monitor
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The default Collections are displayed in the list of collections. These are grouped by
the types of data available to collect:

• Device Variables

• Diagnostic Thumbnails

• Spectra

• Store On Alert

• Waveforms

4. Select a collection in the list to view or change an existing collection.

5. In the Collection Schedule tab, for each Collection Name, you can change the
Collection Interval Type and Duration.

6. In the Device Measurements section, click the arrow beside one or more
measurements to view the details of the added measurement.

7. For each measurement, choose an option to Store and Publish the measurements.
• Place a check mark in the Store column to store the measurement for later

analysis.

• Place a check mark in the Publish column to make the data available to
Plantweb™ Optics or other applications via OPC UA.

8. Click Save Configuration.

If you make changes you do not want to save, click Reload Configuration to start
over with the already saved configuration. The Restore Default option is also
available which resets the configuration to the default from the device before being
added to AMS Machine Works.

After you save a collection, data begins to collect on schedule. You can also perform a
demand collection to trigger the data collection immediately.

8.2 Configure Store on Alert for AMS Wireless
Vibration Monitor
Configuring Store on Alert is a two-step process. First, in Device Configuration, add
measurements to the collection named Store on Alert. Second, configure the alert
settings in Machine Configuration.

Prerequisites

This procedure assumes the device's other collections are configured and the machine
train is already configured.

Procedure

1. Add measurements to the Store on Alert collection in Machine Configuration.

a) From Asset Explorer, in the NETWORK tab, expand AMS Machine Works →
Wireless Interface, expand a gateway, and click an AMS Wireless Vibration
Monitor to select it.
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b) Click Configure Device in the ribbon menu.
The Device Configuration application opens in a new browser window.

c) In the Collection list, click Store on Alert.

d) In Device Measurements, place a check mark in the Store column for each
measurement to add in the Store on Alert collection.

Figure 8-2: Configure Store on Alert for AMS Wireless Vibration Monitor

e) If you want to collect this measurement normally, and not only when in alert,
be sure the measurements are also in one of the other default collection
schedules.
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Figure 8-3: Configure Store on Alert for AMS Wireless Vibration Monitor

f) Click Save Configuration.

2. Configure the alert settings.

a) In the Asset Explorer utility, select a machine train in the Location navigator.

b) From the Home ribbon menu, click Edit → Alarm Edit.
The Machine Configuration user interface appears in a new browser window.

c) Click Add Alerts.
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Figure 8-4: Machine Configuration

d) In the Add Alerts dialog, place a checkmark beside the measurement and
adjust the settings for each alert level, if needed. Click Add.

e) Expand the measurement, select All Locations or By Location and select
Store on Alert Settings.

Figure 8-5: Alerts

f) In the Store on Alert dialog, place a checkmark in the box beside the
measurement and select the alert level from the menu. Click OK.

AMS Wireless Vibration Monitor Online Help
July 2022

62 AMS Machine Works v1.7



Figure 8-6: Store on Alert Settings

g) Click Save Changes.

h) Wait for the Machine Train saved successfully message, then click OK and
close the Machine Configuration dialog.

View the measurements in the Dashboard by navigating to the Machine Details and
viewing the available measurements and by viewing the collections in Vibration Analyzer.

Related information

Device configuration and store on alert

Online Help AMS Wireless Vibration Monitor
July 2022

AMS Machine Works v1.7 63



9 AMS 9420

9.1 Configure AMS 9420 data collection for
analysis
The AMS 9420 Wireless Vibration Transmitter is configured in the AMS Device Manager or
Field Communicator such as AMS TREX. The configuration done by AMS Machine Works
defines the information requested from the AMS 9420. The software does not attempt to
write configuration data to the AMS 9420.

You must set up data collection in AMS Machine Works using Device Configuration to save
the required measurements for later analysis in Vibration Analyzer.

Prerequisites

• The AMS 9420 must already be configured and joined to an Emerson Wireless
Gateway.

• Add the Emerson Wireless Gateway to AMS Machine Works.

Procedure

1. From Asset Explorer, select the NETWORK tab.

2. Expand AMS Machine Works → Wireless Interface, select the Emerson Wireless
Gateway, and select the AMS 9420 from the list of devices.

3. Click Configure Device in the ribbon menu.
The Device Configuration application opens in a new browser window.

Figure 9-1: Device Configuration: AMS 9420
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The default collection types are displayed in the list of collections. These are
arranged by groups of variables to be collected by type:

• Burst Variables

• Device Variables

• Energy Bands

• Store On Alert

• Thumbnails

• Waveforms & Spectra

4. Select a collection in the list to view or change an existing collection.

5. In the Collection Schedule tab, for each Collection Name you can set the
Collection Interval Type and Duration.

6. In the Device Measurements section, display the measurements in the collection
by using navigation in the device list.

The list displays measurements depending on the selection on the device list on the
left side of the screen. Select the device level (top) to display measurements in the
device. To display only the measurements per sensor, select the sensor.

7. In the Device Measurements tab, click the arrow beside one or more
measurements to view the details of the added measurement.

8. For each measurement, choose an option to Store and Publish the measurements.
• Place a check mark in the Store column to store the measurement for later

analysis.

• Place a check mark in the Publish column to make the data available to
Plantweb™ Optics or other applications via OPC UA.

9. Click Save Configuration.

If you make changes you do not want to save, click Reload Configuration to start
over with the already saved configuration. The Restore Default option is also
available which resets the configuration to the default from the device before being
added to AMS Machine Works.

After you save a collection, data begins to collect on schedule. You can also perform a
demand collection to trigger the data collection immediately.

9.2 Configure Store on Alert for AMS 9420
Configuring Store on Alert is a two-step process. First, in Device Configuration, add
measurements to the collection named Store on Alert. Second, configure the alert
settings in Machine Configuration.

Prerequisites

This procedure assumes the device's other collections are configured and the machine
train is already configured.
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Procedure

1. Add measurements to the Store on Alert collection in Machine Configuration.

a) From Asset Explorer, in the NETWORK tab, expand AMS Machine Works →
Wireless Interface, expand a gateway, and click an AMS 9420 to select it.

b) Click Configure Device in the ribbon menu.
The Device Configuration application opens in a new browser window.

c) In the Collection list, click Store on Alert Sensor 1 or Store on Alert Sensor
2.

d) In Device Measurements, place a check mark in the Store column for each
measurement to add in the Store on Alert collection.

Figure 9-2: AMS 9420 Device Configuration

e) If you want to collect this measurement normally, and not only when in alert,
be sure the measurements are also in one of the other default collection
schedules.
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Figure 9-3: AMS 9420 Device Configuration

f) Click Save Configuration.

2. Configure the alert settings.

a) In the Asset Explorer utility, select a machine train in the Location navigator.

b) From the Home ribbon menu, click Edit → Alarm Edit.
The Machine Configuration user interface appears in a new browser window.

c) Click Add Alerts.

Figure 9-4: Machine Configuration
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d) In the Add Alerts dialog, place a checkmark beside the measurement and
adjust the settings for each alert level, if needed. Click Add.

e) Expand the measurement, select All Locations or By Location and select
Store on Alert Settings.

Figure 9-5: Alerts

f) In the Store on Alert dialog, place a checkmark in the box beside the
measurement and selet the alert level from the menu. Click OK.

Figure 9-6: Store on Alert

g) Click Save Changes.

h) Wait for the Machine Train saved successfully message, then click OK and
close the Machine Configuration dialog.

View the measurements in the Analysis Dashboard by navigating to the Machine Details
and viewing the available measurements and by viewing the collections in Vibration
Analyzer.
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Related information

Device configuration and store on alert
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10 Ovation Machinery Health Module

10.1 Prepare Ovation Machinery Health Waveform
Recorder to connect to AMS Machine Works
Follow these tips to prepare your Ovation Machinery Health Waveform Recorder to
connect to AMS Machine Works. Always refer to the Ovation Developer Studio
documentation for procedures and more information.

Procedure

• Use Ovation Developer Studio software to configure Ovation Machinery Health Module
channels.

• In Ovation Developer Studio, place a checkmark in the box Collect Prediction
Waveform Data.

• Below Collect Prediction Waveform Data, set the FMax (Hz) for the prediction data to
be collected by AMS Machine Works. Prediction data can be set to up to 12,800 lines of
resolution. This is a different setting than the fixed 800 lines used for protection
purposes. AMS Machine Works uses high resolution data for calculation of analysis
results and visual presentation.

10.2 Add an Ovation Machinery Health Waveform
Recorder as an Asset Source
You can add an Ovation Machinery Health Waveform Recorder as an asset source for AMS
Machine Works. AMS Machine Works connects to the Ovation Machinery Health
Waveform Recorder, which then allows data to be collected from the Ovation Machinery
Health Modules registered with the Machinery Health Waveform Recorder. Each
connected Machinery Health Waveform Recorder appears as an asset source in the Asset
Explorer Network hierarchy.

Prerequisites

Note
Ensure the Ovation Machinery Health Module is configured, and the Machinery Health
Waveform Recorder is operating.

Procedure

1. In the Asset Explorer utility, select the Network tab, expand AMS Machine Works
and select Ovation Interface.

2. From the Home ribbon menu, select Add Asset Source.
The Add Ovation Machinery Health Monitor dialog appears.

3. In the dialog, enter the following:
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Field Description

Name The name for the Machinery Health Waveform Recorder.

IP Address The IP Address is required.

Port Number The port for receiving configuration information and data from
the device. For default ports, see the Ovation Ports & Services
document, available upon request.

4. Click Add Machinery Health Waveform Recorder.

A new node with the name provided appears below Ovation Interface in the Network
navigator. Expand the Machinery Health Waveform Recorder icon to see the connected
modules.

Postrequisites

Select the new node and click Configure Module from the Home ribbon to configure
measurement parameters to add to AMS Machine Works.

10.3 Configure Ovation Machinery Health Monitor
data collection for analysis
The Ovation Machinery Health Monitor module is configured in Ovation Developer Studio.
The configuration done by AMS Machine Works defines the information requested from
the Machinery Health Waveform Recorder. The software does not attempt to write
configuration data to the device.

You must set up data collection in AMS Machine Works using Device Configuration to save
the desired measurements for further analysis in Vibration Analyzer.

Prerequisites

The module must already have the prediction waveform enabled for the associated
Ovation Machinery Health Module channel and FMax defined in Ovation Developer Studio.

Procedure

1. From Asset Explorer, select the NETWORK tab.

2. Expand AMS Machine Works → Ovation Interface and click the name of the
Ovation module to select it.

3. Click Configure Module in the ribbon menu.
The Device Configuration application opens in a new browser window.

Online Help Ovation Machinery Health Module
July 2022

AMS Machine Works v1.7 71



Figure 10-1: Device Configuration: Ovation Machinery Health Monitor

4. To create a new collection, click Add Collection above the Collection Schedules
list.

A limited number of collections can be created. The number of available collections
displays in the Collections list.

5. In Default Collection Schedule, in the Collection Schedule tab, enter a Collection
Name, Collection Interval Type, and Duration.

6. In the left tab of Device Measurements, choose available measurements by using
navigation in the device list and applying filters in the measurements list.

The list displays measurements depending on the selection on the device list on the
left side of the screen. Select the module (top) to display measurements from the
channels. To display only the measurements per channel, select the channel.

Use the filter toolbar to narrow your selection with filter buttons. Also, you can type
a custom search filter and click  to show matching measurements. Click + to add
the filter or click x to remove the filter.
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Figure 10-2: Device Configuration: Available measurements tab

A. Filter applied — High Resolution Waveform filter icon shown
B. Search — Find desired measurements by typing the measurement name
C. Checkmark icon — Shows measurement added to the collection
D. Add icon — Click to add measurement to the collection
E. P icon — Indicates a primary measurement. Primary measurements may be collected more frequently than

other measurements.
F. Lock icon — Indicates measurement type that is calculated in the device (Measurements with no lock icon

indicate calculations that are performed on the data after it is loaded into AMS Machine Works.)

7. In the left tab in Device Measurements, click  beside one or more measurements
to add to the collection.

Note
After filtering the measurements, if you need to add all of the measurements
shown, select Add all at the bottom right corner.

The number of items in the Collection Schedule tab increments by the number of
items added from the left tab.

8. Select the Collection Schedule tab to display the measurements added in the
collection by using navigation in the device list and applying filters in the
measurements list.

The list displays measurements depending on the selection on the device list on the
left side of the screen. Select the module level (top) to display all available
measurements across the entire module. To display only the measurements per
channel, select the channel of interest.
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Figure 10-3: Device Configuration: Collection Schedule tab

A. Show details — View measurement details and make changes in enabled fields, if needed.
B. Store — Place a checkmark in each row to store the measurement for future use by applications such as in

Vibration Analyzer. Place a checkmark in the column to select all visible rows. Clearing the Store checkbox
will prevent the data from storing to Historian. However, that data can still be published to other systems via
OPC UA.

C. Publish — Place a checkmark in each row to publish data to other systems via OPC UA. Place a checkmark in
the column to select all visible rows.

D. Clock icon — Indicates an amount of time required to collect the measurement. Hover the mouse over the
icon to see the estimated time for collection.

E. Lock icon — Indicates measurement type that is collected in the device (Items with no lock icon indicates a
calculation is performed on the data after it is loaded into AMS Machine Works.)

F. Remove icon — Click to remove the measurement from the collection.

9. In the Collection Schedule tab, click the arrow beside one or more measurements
to view the details of the added measurement.

10. Click x beside a measurement to remove it from the collection, if needed.
The number of items in the Collection Schedule tab decreases by the number of
items removed from the right tab.

11. For each measurement, choose an option to Store and Publish the measurements.

12. Click Save Configuration.

If you make changes you do not want to save, click Reload Configuration to start
over with the already saved configuration. The Restore Default option is also
available which resets the configuration to the default from the device before being
added to AMS Machine Works.

After you save a collection, data begins to collect on schedule. You can also perform a
demand collection on the selected collection to trigger the data collection immediately.
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10.4 Configure Store on Alert for Ovation Machinery
Health Module
Configuring Store on Alert is a two-step process. First, in Device Configuration, create a
collection with an interval type of Store on Alert. Second, configure the alert settings in
Machine Configuration.

Prerequisites

This procedure assumes the device's other collections are configured and the machine
train is already configured.

Procedure

1. Create the Store on Alert collection in Machine Configuration.

a) From Asset Explorer, in the NETWORK tab, expand AMS Machine Works →
Ovation Interface and click the name of the Ovation Machinery Health
Module to select it.

b) Click Configure ATG in the ribbon menu.
The Device Configuration application opens in a new browser window.

c) In the Collection list, click Add Collection.

d) In the Collection Schedule tab, enter a Collection Name and for Collection
Interval Type, select Store On Alert.

Note
Emerson recommends adding "Store on Alert" or "(SoA)" to the name of the
collection to help you identify the collection later when configuring the alert
settings.
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Figure 10-4: Device Configuration: Ovation Machinery Health Module

e) In Device Measurements, in the left tab, click  beside one or more
measurements to add to the collection.

f) In the right tab, place a checkmark in the Store column for each
measurement in the Store on Alert collection.

Figure 10-5: Device Measurements

g) If you want to collect this measurement normally, and not only when in alert,
be sure the measurements are also in a separate collection schedule with
Collection Interval Type set to a time.
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Figure 10-6: Device Configuration: Ovation Machinery Health Module

a) Click Save Configuration.

2. Configure the alert settings.

a) In the Asset Explorer utility, select a machine train in the Location navigator.

b) From the Home ribbon menu, click Edit → Alarm Edit.
The Machine Configuration user interface appears in a new browser window.

c) Click Add Alerts.
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Figure 10-7: Machine Configuration

d) In the Add Alerts dialog, place a checkmark beside the measurement and
adjust the settings for each alert level, if needed. Click Add.

e) Expand the measurement, select All Locations or By Location and select
Store on Alert Settings.

Figure 10-8: Alerts

f) In the Store on Alert dialog, place a checkmark in the box beside the
measurement and select the alert level from the menu. Click OK.
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Figure 10-9: Store on Alert Settings

g) Click Save Changes.

h) Wait for the Machine Train saved successfully message, then click OK and
close the Machine Configuration dialog.

View the measurements in the Dashboard by navigating to the Machine Details and
viewing the available measurements and by viewing the collections in Vibration Analyzer.

Related information

Device configuration and store on alert
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11 Analysis Dashboard
An intuitive graphical dashboard delivers clear visibility to overall machine, device, and
system health at a glance. The information displayed is persona-based, ensuring team
members receive only the data that is relevant to their position. Users can easily identify if
there are any issues which require their attention and drill down for further analysis.

Note
Ensure a proper configuration of the machines and devices with alerts to get reliable
information on the user interface.

11.1 Analysis Dashboard colors and icons
Standardized elements such as a color system, different alert levels, and icons help to
distinguish the types of notifications.

Used colors

Buttons and status diagrams are colored depending on their functions and meanings.

Table 11-1: General color meaning

Color Meaning

 Blue Information

 Green Good

 Yellow Advise

 Orange Warning

 Red Critical

 Gray Unknown

Icons

Icons are used to indicate the availability of important information.

Table 11-2: Icons

Icon Meaning

The exclamation mark within a red, solid circle marks
information areas that requires the attention of the user.

The number within a blue solid circle added to a button
indicates the number of items selected from the menu that
can be opened by the button.
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11.2 Analysis Dashboard user interface
The System View displays the overall health status for different elements within the AMS
Machine Works database. It shows the three Key Performance Indicators (KPIs) – Machine
Status, Device Measurement Status, and Device Status and provides a context sensitive list
of applicable machines or devices depending on the selected KPI. A notification of system
status is provided, with a trend of the historical database occupancy indicating the health
of the system. In addition, applicable messages from the Machine Journal application are
displayed.

The System View is the starting point for opening further diagnostic views to get more
details about a particular status.

Figure 11-1: System View

A. Menu bar and Navigation Bar — Select options available from all pages of the Analysis
Dashboard and Breadcrumbs that visualize navigation.

B. Navigation Tree — Navigate through the plant hierarchy of machines and devices.
C. Search bar — Search for machine trains or devices.
D. App switcher — Open other applications.
E. User — View user information and open the log in and log out dialog.
F. System Settings — Change the Alert Hysteresis Percentage and Wireless Noise Threshold

(RMS).
G. Help — Open the online help.
H. Filter — Filter the displayed machines or devices.

I. Key Performance Indicator (KPI) — Overall health status information.
J. List of machines or devices — See items shown based on the KPI selection.

K. System details — Access quick performance details about AMS Machine Works.

The arrangement of the view depends on the browser window settings and Microsoft
Windows display settings.

11.2.1 Navigation Tree
The Navigation Tree is visible on all pages of the Analysis Dashboard and contains the
following elements:
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Navigation Tree Icon

Click the Navigation Tree icon to open the location or source overview.

Figure 11-2: Navigation Tree Icon

Select Location to open a hierarchy of all available locations and the machines configured
under each location. The hierarchy is organized from site to location to machine.

Figure 11-3: Location hierarchy

Select Network to open a hierarchy of all available data sources. The hierarchy is organized
by the device types such as AMS 6500 ATG Asset Source or AMS Wireless Vibration
Monitor Asset Source.
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Figure 11-4: Network hierarchy

Select a machine or device from the hierarchy to get more detailed information. A
diagnostic view of the Analysis Dashboard opens with a detailed analysis view of the
selected machine or device, presenting plots for trends, waveforms, spectra, and other
measurements. See Analysis View for more details. A colored status bar to the left of the
machine or device indicates the status of the machine or device (see Analysis Dashboard
colors and icons).

You can also add new devices as asset sources by clicking the corresponding  icon.

Click the Navigation Tree icon again to close the hierarchy.

Filter

Click the filter icon to open the Filter panel.

Figure 11-5: Filter Icon
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Filter the list of machines or devices using the available filter categories such as by
Location, Network, Asset Class, and Asset Priority.

Figure 11-6: Filter panel

The filter is applied immediately. An applied filter is indicated by the number of selected
filter categories added to the filter icon. Click on the CLEAR ALL button to deactivate the
filter and to reset the filter settings.

Figure 11-7: Filter icon with indication of number of selected categories

Click the X to close the filter panel.

Search bar

Enter text to search for machines or devices.

Figure 11-8: Search

The search starts while entering the search criteria. The search result with a list of
machines or devices is displayed. Going back to the dashboard cancels the search.

App switcher

Click the app switcher icon to open a menu of available apps.

Figure 11-9: App switcher icon
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Click an icon to open the application.

Figure 11-10: App switcher menu

Click the app switcher icon again to close the menu.

User

Click the user icon to open the user menu with information about the currently logged in
user and the log out dialog.

Figure 11-11: User icon

Click Sign out to exit AMS Machine Works, or to log in with a different user and password.

Figure 11-12: User menu
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Click the user icon again to close the menu.

System Settings

Click the settings icon to open the system settings menu.

Figure 11-13: System Settings icon

The system settings menu contain configuration for Alert Hysteresis and Wireless Noise
Threshold.

Figure 11-14: System Settings window

Help

Click the help icon to open the online help.

Figure 11-15: Help icon

11.2.2 Status summary
This view displays the status summary and is the starting point for opening further
diagnostic views to get more details about a particular status. To help the user to focus on
the Key Performance Indicators (KPIs) for machines or devices and their measurements in
alert (advise, warning, or critical), there are options to select or deselect items to be
displayed.
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Figure 11-16: Overview

A. Key Performance Indicator (KPI)
B. List of machines or devices based on the KPI selection
C. System Status

Key Performance Indicator (KPI)

Key Performance Indicator (KPI) diagrams are used to display the status of machines and
devices. A KPI consists of a doughnut chart and a trend diagram showing the alert status
for the last 30 days. The 30 days is an estimate and is subject to data available in the short-
term historian if there is sufficient disk space. There are three KPIs over which you can
hover your cursor to display a description:

Machine Status — Status of all alerts that are configured in AMS Machine Works for a
particular machine train

Device Measurement Status — Status of all measurements for a particular device based
on alerts that are configured in the device. The device measurements alerts are channel,
card, or CHARM-specific alerts including asset status (if applicable)

Device Status — Status of all device level alerts for a particular device. The device alerts
can indicate device malfunction, supply voltage high/low, device temperature high, etc.

The status is divided into the five status levels Unknown, Good, Advise, Warning, and
Critical.

Click a colored section of the doughnut chart or an alert level in the legend to select all
machines or devices in this alert level. The number within the doughnut chart indicates the
number of machines or devices that are in the selected alert level. The selected section of
the doughnut chart is marked by an additional line. The machines or devices in the
selected alert level are listed in the area below the KPIs. If there are more machines or
devices than can be displayed on this view, an icon shows the number of additional
machines or devices that are displayed on a subsequent page.

List of machines or devices

This area shows machines or devices in the same alert level selected on the corresponding
KPI. If there are more machines or devices than can be displayed on this view, an icon
shows the number of additional machines or devices that are displayed on a subsequent
page. Click a machine or a device to get more details – the view changes to the diagnostic
view of the user interface.
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Figure 11-17: List of machines or devices

A. Navigation bread crumbs
B. List of machines or devices

Navigation
bread crumbs

Use the bread crumbs to navigate back to system view.

List of
machines or
devices

This area contains a panel for each machine or device in the selected
alert level, or that matches the Search criteria. A panel has a status bar
on the left colored in accordance to the alert level. Machine details
such as bearings and measurement locations or device details such as
card and channel statuses are colored in accordance with the alert
corresponding levels. Click on a panel to open a more detailed view of
the machine or device. Click a machine or device detail to open the
diagnostic view in context.

System Status

This area contains information about the performance of AMS Machine Works.

System Status The available space for the historical databases is displayed. The
Historian database is maintained automatically.

System Details

Related to You List of the latest system events specifically related to the logged in user.

Latest in the System List of the latest system events to which the user has access.
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11.3 Analysis View
Overview

The Analysis View provides a detailed analysis view of the selected machine or device with
trends, waveform, spectrum and other measurements of interest for the selected
measurement point.

Figure 11-19: Analysis View – Overview

A. Machine or device status panel with measurement locations or channels
B. Trend panel
C. Machine or device information panel
D. Waveform and spectrum panel

Click the arrow icon  in the upper right corner to enlarge a panel. Click it again to reset
the view.

Analysis View - Sub-header

Figure 11-20: Sub-Header - Navigation Bread Crumbs

The subheader contains the navigation bread crumbs, which can be used to navigate back
to either system view, list view, or analysis view depending on the current location. When
viewing specific machines/devices the bread crumbs can be used to navigate to the next/
previous asset or display a drop-down menu of available assets.

Figure 11-21: Sub-header - shortcuts
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The sub-header also contains following shortcuts:

Hotkeys

Figure 11-22: Sub-header - Hotkeys shortcut

Clicking on the Hotkeys icon displays the available hotkeys functions which are:

A - Associated data (both waveform & spectrum)

W - Waveform

S - Spectrum

R - Reload associated data points

View in Vibration Analyzer

Figure 11-23: Sub-header - View in Vib App shortcut

Opens the Vibration Analyzer and displays the selected measurements

Machine Configuration

Figure 11-24: Sub-header - Machine Config shortcut

View or change the selected machine or device configuration

Plot Settings

Figure 11-25: Sub-header - Plot Settings shortcut

Opens the Plot and Unit Settings window
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Figure 11-26: Plot and Unit settings window

Background Click the colored button to open the dialog for the color selection.
Select a color for the plot background. The button color changes to
the selected color. Click the button again to close the dialog.

Axis Click the colored button to open the dialog for the color selection.
Select a color for the axis. The button color changes to the selected
color. Click the button again to close the dialog.

Plot Line Click the colored button to open the dialog for the color selection.
Select a color for the line. The button color changes to the selected
color. Click the button again to close the dialog.

Show Min /
Max / Average
Lines

Place a checkmark in the box to show minimum and maximum lines
on trend plots in addition to the average value line.

Note
Averaged values are shown when there are more trend values present
than can be shown given the current screen resolution. When
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averaged values are shown, you may zoom in until actual values are
displayed.

Unit Settings Allows selecting English, Metric, or SI unit systems for display. The
units used for displaying various types of data are listed below the unit
system options.

11.3.1 Machine or device status panel
This area shows a diagram of the selected machine train or device. Data sources such as
measuring locations, and machine bearings, or device channels are colored accordingly to
the alert levels. Use the previous and next arrows to navigate through the available
machines or devices.

The available machines or devices depends on how you arrived at the diagnostic view.
When arriving from a KPI, the available machines or devices will be those that match the
selected KPI. When arriving from a Search, the available machines or devices will be those
that match the search criteria.

Figure 11-28: Machine train diagram

A. Bearing Indicator
B. Measurement location indicator (sensor placement)

Figure 11-29: Device diagram – AMS Wireless Vibration Monitor

A. Channels
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Figure 11-30: Device diagram – Ovation MHM

A. Channels

Figure 11-31: Device diagram – AMS 9420

A. Channels

Figure 11-32: Device diagram – AMS 6500 ATG

A. Channel – all channels of a card are selected
B. Channel – single channel
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Figure 11-33: Device Diagram – AMS Asset Monitor

A. Charm

Click a data source (bearing, measurement location, channel) to display the assigned
trend data. A selected element is marked with a blinking blue border. Or click the text view

icon  in the upper left corner to open the channel selection menu. Elements
selected in the menu are marked accordingly.

Figure 11-34: Channel selection

Plots for the selected channels will be shown in the other panels. The number of selected
channels is indicated in a blue solid circle on the menu icon. The available measurement
locations or channels depends on the selected machine or device.

Selecting a data source synchronizes, within the same time frame, all the panels such as
trend plots, parameter views, waveforms and spectra, and status indicators.

11.3.2 Machine or device information panel
Several tabs provide information about the selected machine or device.
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Event list

Figure 11-35: Event list

Events associated with the data source selected on the machine or device status panel.

Parameters (default view)

Parameters of the data source selected on the machine or device panel. Select the Bars

Icon  to display the values as bar graphs. Select the Table Icon  to display the
information in tabular form.

Figure 11-36: Parameters – bars

The parameter bars are grouped by measurement location and sorted by alert severity.
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Figure 11-37: Parameters – table

The parameters are grouped by measurement locations and ordered by alert severity.

Machine Journal

If a machine is selected, all journal entries for the selected machine train and its
component machines are listed.

Figure 11-38: Machine Journal

Machine Config

If a machine is selected, you can view details about the machine and the parts it comprises
of.

Analysis Dashboard Online Help
July 2022

96 AMS Machine Works v1.7



Figure 11-39: Machine Config

Device Status

If a device is selected, Device Status can be verified.

Figure 11-40: Device Status

Status information of the device is listed. Each entry has a vertical status bar on the left
colored in accordance with the alert level.

11.3.3 Trend Plots panel
The trend of the data source (measuring location, bearing, or channel) selected on the
machine or device diagram of the last 30 days are displayed. The number of trends
depends on the selected data source. One data source can provide several trends. The
trends are grouped by measurement locations such as all measurements of a selected
bearing. All displayed trends are synchronized within the same time frame.

Click the menu icon in the upper right corner to open the trend selection menu.
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Figure 11-41: Trend selection

A. Measurement locations (or signal source for Devices)
B. Trends selection / list
C. All-selection buttons

The available trends are grouped by measuring locations or channels. Place a checkmark in
the box of the trend to be displayed to select it. Remove the checkmark to hide the trend.
Click the menu icon again to close the trend selection menu.

The trend plots contain several functions to adapt the view to your needs:

Enlarge
trend

Click the outward pointing arrows  to enlarge a trend diagram. To reset
the view change, click the inward pointing arrows .

Trend
cursor

Move the cursor over the trend to display date, time, and average amplitude
of a particular point of the trend. Click to select a point. The selection is
marked with a red dotted line. The same point in time is also marked on all
trends shown on this panel. Waveform and spectrum of the selected data
block are displayed on the waveform and spectrum panel.

Figure 11-42: Trend with selected value

Region
zoom

Enlarge an interesting part of the trend. Place the mouse cursor close to the
area of interest, left-click and hold. Move the mouse to frame the area of
interest. Release the mouse button to enlarge the selected area.

Double left-click on the trend to reset the view.
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Figure 11-43: Region zoom

11.3.4 Associated Data panel
The Associated Data panel consists of the two tabs Associated data and History.

The waveform and spectrum plots under Associated data contain several functions to
adapt the view to your needs:

Cursor Move the cursor over the waveform or spectrum to display data of a particular
point of the plot.

• With a waveform, time and amplitude are displayed.

• With a spectrum, frequency and amplitude are displayed.

Left-click to select that point. The selection is marked with a red solid line.

Figure 11-44: Spectrum with selected data point

Region
zoom

Enlarge an interesting part of the spectrum. Place the mouse cursor close to
the area of interest, click and hold. Move the mouse to frame the area of
interest. Release the mouse button to enlarge the selected area.

Double left-click on the plot to reset the view.

Figure 11-45: Region zoom
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Waveform

Selection of the data block (point) on the trend plot results in displaying the waveform of
the signal contained in this block.

Figure 11-46: Waveform

A. Data block selected on the waveform plots panel
B. Corresponding waveform is displayed

Spectrum

On the spectrum plots panel, the spectrum of the signal contained in the data block,
selected in Trend Plot, is displayed.

Figure 11-47: Spectrum

A. Data block selected on the spectrum plots panel
B. Corresponding spectrum is displayed

Waveform and Spectrum

Both waveform and spectrum of the selected data block are displayed.

Figure 11-48: Waveform and spectrum

A. Data block selected on the waveform and spectrum panel
B. Corresponding waveform and spectrum are displayed
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12 Machine Journal

12.1 Machine Journal Introduction
The Machine Journal is a web application in AMS Machine Works. Machine Journal enables
Analysts to track problems developing in machines. It allows you to track work orders for
your machines and add notes and observations with supporting images and data. It
provides a flexible way of searching and filtering cases and supports complex analysis and
gathering statistics. It also helps create case reports to support work orders.

Machine Journal is also accessible from a menu in the Vibration Analyzer application.

Terms

The following terms are used to describe the Machine Journal functionality.

Case A case is related to a machine asset. It has a title, creation date,
severity, urgency, open or resolved status, and a list of posts.

User Mention A user mention is used to associate a user with a post, which is
different from a Tag. A tag is used to categorize a post by, for
example, fault type. User mentions are prefixed by the @ sign.

Post A post is a note, data link, or image that is associated with a case.

Tag A tag is a word or phrase used to identify or categorize a post.
Tags are prefixed by a # sign.

Urgency Urgency is a property you can assign to a case to indicate how
quickly the problem needs to be fixed. Urgency has a number,
caption, and corresponding color. You can select urgency from a
list of values and create custom values. You can manage the list of
values for urgency. The urgency you set applies only to Machine
Journal cases and does not contribute to the health value of a
machine.

Severity Severity is a property you can assign to a case to indicate how
much impact this problem has on your plant or operations.
Severity has a number, caption, and corresponding color. You can
select severity from a list of default values and create custom
values. You can manage the list of values for severity. Use severity
to indicate the significance of the problem or the impact to your
plant operations. The severity you set applies only to Machine
Journal cases and does not contribute to the health value of a
machine.

Work
Recommendation

The request for action to be tracked and executed on particular
machine asset.
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12.1.1 Machine Journal user interface
The Machine Journal Posts News Feed is the main view from which you navigate the site
and select machines to add or modify cases.

Figure 12-1: Machine Journal user interface

A. Home ribbon menu—options for case creation, search and sort cases, and to create a
report

B. Navigation tree—list of machines that may have cases added to the components under
each machine

C. Posts news feed—list of cases based on the selection in the navigation tree
D. Search bar—list in which you can add or remove search parameters
E. Case history details—a summary of machine information, history, tags, users, and

work recommendations

The information displayed in the navigation tree depends on the responsibilities assigned
to your user. The responsibilities are configured in the user settings, available from the File
→ User Settings menu in Asset Explorer or User Manager.

The home ribbon displays different options depending on what is selected. Options
display in the ribbon menu based on your context in the tree. These options are also
available from a context menu. Right-click a node in the tree to see the available options.

Table 12-1: Home ribbon menu default options

Option Description

Show resolved Show cases that are resolved.

Search Open the search ribbon menu to refine the results displayed in the
cases in the Posts News feed.

Newest First Display newest cases first.

Oldest First Display oldest cases first.

Create Report Open the News Feed view in print preview mode.
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Related information

View the Posts News feed

12.1.2 Launch Machine Journal from the App Switcher
Launch Machine Journal with the App Switcher from any of the utilities such as the Analysis
Dashboard.

Figure 12-2: Machine Journal shown in the App Switcher of the Analysis Dashboard.

12.2 Machine Journal settings

12.2.1 Severity and Urgency
Severity and Urgency are properties of a case that help you describe the impact of a
problem and how quickly the problem needs to be fixed. These categories are used only
within the Machine Journal application and do not contribute to the health value of a
machine.

12.2.2 Customize severity and urgency
You can customize the text, value, and color for the Severity and Urgency categories.

You can add new items to the categories or edit and delete existing items. The default
values can only be deleted if they have not yet been used in the system.

Procedure

1. Select File → Urgency Settings or File → Severity Settings.

Online Help Machine Journal
July 2022

AMS Machine Works v1.7 103



2. Hover over a category.

The row becomes light blue and displays a pencil icon and a trash icon.

3. To add a new category, click Add new.

A new row appears for the category in edit mode.

Figure 12-3: Urgency Settings: Add a new category

4. Edit the number, select a color, and add a text label for the category.

5. To edit an existing category, click the pencil icon or double click the category.

You can change the number, color, or text of an existing item. Each entry must be
unique. Do not select the same color, text, or number used by another category.

6. To delete an existing item, click the item, then click the trash icon.

You can delete an existing category if it is not used in the system. Hovering over the
trash icon displays a message that the category is used in the system. If the
category is not used in the system, the trash icon is dark gray, indicating it is active.
If the category is used in the system, the trash icon is light gray, indicating it is
inactive.

12.2.3 Show or hide resolved cases in the navigation tree
You can show or hide resolved cases. By default, resolved cases are hidden. Resolved cases
must be displayed before you can reopen a resolved case.

Procedure

Click Show Resolved in the Home ribbon to show the resolved cases in the navigation
tree.

The navigation tree shows all resolved cases.
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12.2.4 Show or hide deleted posts in case information
When you select to show deleted posts in the case information, all cases will show all the
deleted posts. Emerson recommends using the default setting, which hides the deleted
posts. You can temporarily show deleted posts to perform an audit of the cases.

Procedure

1. Select File → Settings → Preferences.

2. Place a check mark in Show deleted posts in the case information.

12.3 Procedures

12.3.1 View the Posts News Feed
The Posts News Feed shows all the information below your selection in the navigation tree,
according to your settings. You can modify your view of the Posts News Feed by date and
time order. By default, the news feed shows newest posts first.

Procedure

• In the navigation tree, select the root node to display all open cases.

• Select a machine to display only the cases and posts for the machine.

• Change the sort order by selecting either Oldest first or Newest first in the ribbon.

12.3.2 Set news feed sort and filter options
From the Search ribbon, you can select options for customizing your news feed and posts.

As you select options to customize your search results, the search results are automatically
updated.

Procedure

1. Click Search on the ribbon or place the cursor in the search bar.

A Search Tools ribbon appears.

2. Select any node in the tree to narrow the results to the items below the selected
node. For example, select a folder to display the cases of machines in that area.

3. Reorder the search results by selecting Ascending Order or Descending Order from
the home tab of the ribbon.

4. Type text in the search parameters bar.
The search phrase is compared against case title and post descriptions.

5. In the Search Tools ribbon, select from the filter options to limit the results.

Option Description

State Show cases by state: open, resolved, or deleted. All states are
included by default. This search setting is independent from the
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Option Description

preferences setting to show resolved cases or deleted posts. If you
have Hide Resolved selected in the ribbon, you can still see resolved
cases when you select resolved as a search property.

Urgency Show cases with the urgency selected.

Severity Show cases with a selected severity.

Tag Tags are specified in notes field prefixed by the # symbol.

User Users are specified in notes field prefixed by the @ symbol. List of
users is provided from the User Manager utility.

Asset Type Asset type shown in Asset Explorer.

Date Range Show only results within range defined by the dates. Select only a
start date to show results newer than the specified date and newer.
Select only an end date to show results older than the specified date.
When you choose the date, it appears on the search parameters bar.
If you need to change the date, click the x beside the date to clear
the date.

The results view displays all matching posts.

The search options you select are shown as filters with an x in the search parameters
bar.

6. Remove a search parameter by clicking x.

12.3.3 Create a new case
When creating a new case, some basic information is required such as: title and
description. The title and description are required. Values indicating severity and urgency
are required and set to the highest level by default. You can update the case later, for
example, by adding: images or a post to the case, or by changing the urgency or severity
of the case.

Procedure

1. In the Posts News feed, select a machine from the navigation tree.

Existing cases display in the main pane. If the machine has no cases, the main pane
is empty.

2. Click Add case in the ribbon.

An entry named *New case appears beneath the selected machine. The asterisk (*)
means the case is not saved.

The Create Case view appears with placeholders for you to fill in.

3. Provide a name for the case. Use a name that helps identify the symptom being
diagnosed.

4. Add notes in the description field.
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In the description, you can add tags by entering a # before the word to be tagged.
You can mention users by entering @ and selecting a user from the list.

5. Select a value for Severity. The default is Impending Failure (1).

6. Select a value for Urgency. The default is Critical (1).

7. Click Publish.

The new case name appears (without an asterisk) in the tree in the left panel.

An entry named Case Opened appears in the case. The entry includes the user's name, the
current date and time, the severity and urgency settings, and the description.

Machine details, post history, and summary information display in the case details on the
right side of the case information.

The case status is open.

Related information

Add a post to a case
Add a tag or mention a user to a post
Add a new post to a case from Vibration Analyzer

12.3.4 Add and remove notes and tags on a case
A case shows all the tags from underlying posts. When you add a post to a case, and the
post contains a tag, the tag is associated with the case if the case did not already have the
tag. A machine condition is a type of tag.

To remove a tag from a case, delete the post in the case that contains the tag you want to
remove.

12.3.5 Add a post to a case
When you add a new post to a case, the post contains one note and may contain images,
data links, attachments and work recommendations. You can also change the severity or
urgency of the case. Changes you make to the case while editing the post will be included
in the post. You can add multiple posts to a case. You can add a post to an open case but
not to a resolved case. Once you create the post, you cannot edit the post, but you can
update the case information by adding a reply to the post or creating a new post. For
example, you cannot change the severity or urgency of the case in a post, but can in a
reply.

Prerequisites

The machine has an open case.

Procedure

1. In the navigation tree, select the case you want to update.

The case information displays the case details, posts, and replies.

2. Select Add Post from the ribbon.

The Add Post form appears below the case title.
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Figure 12-4: New post form

3. Add a note, images, or data links as a main part of the post.

4. Click Publish.

The post is added to the case. The user name and current date and time are saved
with the post.

Related information

Create a new case
Add images to a post
Add a tag or mention a user to a post

Add a tag or mention a user to a post
Tags and mentions help you flag any topic or user you want to associate with your case.
You can tag any phrase or mention a user while typing in a post. When you mention a user,
the post or case displays in that user’s Machine Journal Dashboard. When using Search,
select tags and users to limit the results.

Procedure

• To tag a phrase:

a) While typing a note, create a tag by starting a phrase with the # symbol. Text
you type after # is the tag.

As you type the tag, any relevant matching tags appear in a list.

b) Select the existing tag from the list, or continue typing to create a new tag.

When you type a new tag for the first time and save the post, that tag will be
available in future posts.

• To mention a user:

a) While typing a note, mention a user by typing the @ symbol.

b) Select a user from the list that appears by the @ symbol.
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Related information

Add a post to a case
Add a reply to a post

Add images to a post
When adding a post, you can click the + icon beside the notes field to add an image. You
can also drag and drop an image or attachment.

Procedure

1. Click the + icon beside the notes field and select Add image.

2. In the Browse dialog, locate the image to upload. Click OK.
The image appears in the next available box after the + icon.

3. Add more images if desired.

4. To discard one of the uploaded images, click the image in the post.
The Gallery dialog appears.

A. Selected image
B. Delete
C. Next image in gallery
D. Full screen view

5. Click  to delete the selected image.

6. Close the Gallery dialog when finished.

7. Click Publish.

The added images are saved when the post is saved. If the post is discarded, the
added images are also discarded.

Add data from Vibration Analyzer to a post
When adding a post, you can click the + icon beside the notes field to add data from
Vibration Analyzer. This lets you easily launch Vibration Analyzer to select the image to
add. Images added from Vibration Analyzer are standard images in Machine Journal and
are included in the attachments limit.
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Procedure

1. To the right of the notes field, click the + icon to the right of the notes field and
select Add data from VibApp.

2. Vibration Analyzer launches.

3. Finish editing the post and click Publish. The added data is saved when the post is
saved. If the post is discarded, the added data is also discarded.

Add attachments to a post
When adding a post, simply drag and drop an image or document to your post. Or you can
click the + icon beside the notes field to add attachments. The attachments list can
contain up to 64 items (up to 50 MB per document and 15 MB per image). The images
from Vibration Analyzer are standard images and also count in this total. If you add an
image as an attachment, it appears in a documents list, and to see it, you must download
the image first. If you prefer to see preview icons of your images, do not upload it as an
attachment; add it as an image instead.

Procedure

1. To the right of the notes field, click the + icon and select Add attachment.

2. In the Browse dialog, locate the attachment to upload. Click OK.
An Attachment link appears in the post below the image gallery. The number of
attachments displays in parentheses.

3. To view, edit, or discard one of the attachments, click Attachments.
The Attachments dialog displays a list of attachments and actions including
download, edit the description, delete, or add a new attachment.

Figure 12-5: Attachments dialog

4. Click the pencil icon and type a description. Click Save.

Adding a description helps provide other users with more information to identify
the attachment without downloading and opening the attachment.

5. Click Close.

6. Finish editing the post and click Publish. The added attachments are saved when
the post is saved. If the post is discarded, the added attachments are also discarded.
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Add a work recommendation to a post
While adding a post, you can add a recommendation to a case. A work recommendation is
a type of note that lets you categorize work or a suggestion to fix the problem. One way a
work recommendation is helpful is that you can search for cases with work
recommendations. It helps you track information about the work performed on a specific
case as well. You can use the work recommendations like a ToDo list. A case can only be
resolved when its work recommendations are resolved or rejected.

Figure 12-6: Work Recommendations dialog

Procedure

1. Click Add recommendation in the ribbon.

2. In the Work Recommendations dialog, enter a Subject, Priority, and a Description
and click Add.
A Work Recommendations link appears in the post below the image gallery. The
number of recommendations displays in parentheses.

3. To view, edit, or discard one of the work recommendations, click Work
Recommendations.
The Work Recommendations dialog displays a list of work recommendations and
actions including view details, edit, delete, and add.
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Figure 12-7: Work Recommendations dialog

4. Click the pencil icon to edit the description, subject, and status. Click Save.

5. Click Close.

6. Finish editing the post and click Publish.

The recommendation is saved when the post is saved. If the post is discarded, the
recommendation is also discarded.

The work recommendation is created with an active status.

All work recommendations for a case must be resolved or rejected before the case can be
resolved.

Add a reply to a post
A reply is a post that you can use to add more details to the case. You can add a reply to a
post in an open case. For readability, all posts and replies are displayed at the same level of
a case, not nested within posts. If you reply to a post, it appears as a post to the case. The
posts are nested and collapsed by default.

Procedure

1. In the navigation tree, select the case you want to update.

The case information displays the case information, posts, and replies.

2. Click Reply on a post that you want to update.

A reply field appears where you can fill in notes or add images.

3. Click Publish.

The reply appears on the case information screen, under the original post.

12.3.6 Delete a post from a case
You can delete a post from an open case, one post at a time. Deleted posts are marked as
deleted, and by default do not appear in the case information. You can change the
settings to show deleted posts.
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Procedure

1. In the navigation tree, select an open case.
The case information shows posts and replies, if present.

2. Locate the post to delete.

3. In the upper right corner of the post, select ... → Delete post.

4. At the prompt, select OK.

The post no longer appears in the case information. You can select other posts to
delete.

Related information

Show or hide deleted posts in case information

12.3.7 Update a work recommendation
All work recommendations for a case must be resolved before the case can be resolved.
The status can be Completed or Rejected.

Procedure

1. In the Posts news feed, select a machine from the navigation tree.

Existing cases display in the middle pane. If the case has work recommendations,
the case details contain links to the Work Recommendations list.

2. Click All to see all of the work recommendations. Choose other links to see the
items of that status (Active, Completed, or Rejected).

3. In the Work Recommendations list, click the checkmark to mark the work
completed, or click X to reject the work recommendation.

12.3.8 Resolve a case
When you are finished working on a case, mark it resolved so it no longer appears in the
list of cases.

Procedure

1. In the navigation tree, select an open case.

2. Click Resolve case in the ribbon bar.

3. A new post appears with a Resolve case button.

4. Fill in details about why the case is being resolved.

5. Click Resolve Case.

The case status is resolved. The case no longer appears in the navigation tree. You can
show or hide the list of resolved cases by clicking Show Resolved from the Home ribbon.

Related information

Delete a resolved case
Reopen a resolved case
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Show or hide resolved cases in the navigation tree

12.3.9 Delete a resolved case
Prerequisites

Resolve the case. A case status must be set to resolved before it can be deleted.

Deleting a resolved case causes it to become an archive. Once deleted, the case cannot be
reopened. When resolved cases are visible in the navigation tree, you can delete or reopen
a resolved case.

Procedure

1. Click Show Resolved in the Home ribbon to show the resolved cases in the
navigation tree.

2. Select the case you want to delete.

3. Select Delete case from the ribbon.

4. At the prompt, select OK.

The case status is deleted.

By default, deleted cases do not appear in the navigation tree. The case appears in the
navigation tree if Show deleted cases, posts, and replies is enabled in Preferences.

Related information

Show or hide resolved cases in the navigation tree
Show or hide deleted posts in case information

12.3.10 Reopen a resolved case
After a case is resolved, it may be necessary to open the case again. If more work needs to
be done on the same issue, it is convenient to reopen a resolved case instead of creating a
new case.

Procedure

1. Click Show Resolved in the Home ribbon to show the closed cases in the navigation
tree.

2. In the navigation tree, select the case you want to reopen.

3. Select Reopen case from the ribbon.

The Reopen case post view appears.

4. Write an explanation for reopening the case.

5. Click Publish.

The case status is open.

The case appears in the tree in the left panel.

Related information

Show or hide resolved cases in the navigation tree
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12.3.11 Print a report of the Machine Journal screen
You can print the contents of your Machine Journal screen as a PDF report.

Prerequisites

Install a PDF generator as a printer on the computer if you want to save the report as a
PDF. Contact your IT department if you do not have a PDF option in your list of printers.

Procedure

1. In the navigation tree, select a machine to display the cases and posts for the
machine.

2. Select Create Report in the ribbon.

A new window displays a print preview of the report.

3. Print the report.

12.4 Vibration Analyzer

12.4.1 Launch Vibration Analyzer from Machine Journal
You can launch Vibration Analyzer to show the machine you have selected in Machine
Journal.

Prerequisites

Vibration Analysis must be installed on the PC where you are using Machine Journal.

Procedure

1. In the Machine Journal navigation tree, select a machine.

2. Click Vibration Analyzer in the ribbon.

Vibration Analyzer opens to this machine in the Location Navigator.

12.4.2 Create a new case from Vibration Analysis
In Vibration Analyzer you can see a list of existing cases for a machine in the Machine
Journal Browser pane.

You can also create a new case while using Vibration Analyzer.

Procedure

1. In Vibration Analyzer, select a machine in the Location navigator.

2. Select the Machine Journal Case Browser tab.

The tab displays a list of open cases for the selected machine.

3. Select Add Case.
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Machine Journal opens to the new case for this machine.

4. In Machine Journal, fill in placeholders with new case information:

5. Type a title for the case.

a) Select values for Severity and Urgency.

b) Click Publish.

The new case appears in the tree in the left panel.

The user name and current date and time are saved with the new case.

The case status is open.

Related information

Create a new case

12.4.3 Add a new post to a case from Vibration Analyzer
In Vibration Analyzer you can see a list of existing cases for a machine.

You can update a case in Machine Journal by adding a new post while using Vibration
Analyzer.

Procedure

1. In Vibration Analyzer, select a machine in the Location navigator.

2. Select the Machine Journal Case Browser tab.

The tab displays a list of open cases for the selected machine.

3. Locate the case you want to edit and select + in the Add Post column.

Machine Journal opens to a new post for this case.

Related information

Add a post to a case
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13 Vibration Analyzer
AMS Machine Works Vibration Analyzer is a module of AMS Machine Works. You can use it
to diagnose your machines by viewing plots to analyze vibration data collected from
devices that are monitoring machines in your site. A wide variety of plots are available such
as: Spectrum, Trend, Waveform; but also: Orbit, Shaft Centerline, Cascade, Bode/Nyquist
and Full-Spectrum.

You can launch the Vibration Analyzer on the client or server computer where it is
installed. You can do the following:

• Click Start → AMS Machine Works → Vibration Analyzer.

• Select a machine train or component in Asset Explorer and click the Vibration Analyzer
button in the Home ribbon.

• Select the Vibration Analyzer icon from the App Switcher.

Related information

Home ribbon
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13.1 Vibration Analyzer user interface
Figure 13-1: Vibration Analyzer user interface

The workspace lets you organize your screen to display only information that is relevant to
you. It can contain any variation of the following:

A. Label for plotting workspace—identifies the data currently displayed in the plotting
workspace.

B. Plotting workspace—displays plots, plot legends, and information about each plot
type.

C. Primary navigator—displays the Location navigator or Network navigator.
D. Secondary navigator—used to select data within the chosen active tree in Primary

navigator.
E. Details navigator—displays all available measurements for selections from the primary

and secondary navigators.
F. Cursor details—displays details about the cursor location on the plot.
G. Plot information—information about the current plot.
H. Function bar—functions and plot types for a given selection in the primary navigator.

I. Waveform—functions available for waveform single plot being displayed ; click + or – to
expand/collapse.

J. Spectrum—functions for spectrum plots being displayed; click + or – to expand/
collapse.

K. Trend—functions for trend plots being displayed.
L. Common options—functions available to all plots; click + or – to expand/collapse.

Vibration Analyzer Online Help
July 2022

118 AMS Machine Works v1.7



M. Settings—Settings - used to configure selected settings and preferences (e.g. units,
server connection and other).

The Primary, Secondary, and Details navigators are movable windows. Click and drag the
navigator title bar to a desired location; re-dock the navigator by dragging it to the default
position. Use the pushpin icon to hide the navigator. When a navigator is hidden, a tab
displays to the left or at the bottom of the main application window; click this tab to
toggle the navigator's display. You can also click the Settings icon and select Refresh
Hierarchies to return the navigators to their default positions.

Refresh Hierarchies is also used to update the Vibration Analyzer application when
changes are made in Asset Explorer. The software prompts you to do this when changes
are made. If the user wants to keep their custom Navigator locations, they should exit and
re-open the Vibration Analyzer application after edits are made in Asset Explorer, instead
of using Refresh Hierarchies as prompted.

13.1.1 Locations tab
Use the Locations tab in the primary navigator to select machines you want to analyze.

The Locations tab allows you to browse machines in your site, including measurement
point locations. When you have added machines in the Asset Explorer utility, the structure
is also reflected in the Locations tabs, including measurement point locations. When you
click an item in the Locations tab, the sub-navigators and plots display measurements and
functions according to the item selected.
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Figure 13-2: Locations tab in primary navigator

Table 13-1: Location tab bubble states for machine trains

Color Meaning

Red Critical Alert

Orange Warning Alert

Yellow Advise Alert

Green Normal, No alert

Grey Alert not applicable

Alert not received
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Table 13-1: Location tab bubble states for machine trains (continued)

Color Meaning

Black Alert Invalid

No Data

Alert Not Evaluated

Related information

The Location navigator

13.1.2 Network tab
The Network tab displays asset sources (gateways), devices, and the channels of the
devices. Clicking on items in the Network tab displays the data acquired by monitoring
devices (such as the AMS 9420) in the plotting workspace. Items can be selected within
this tree, and based on the Selection Type Preferences settings, the appropriate data will
be available for analysis. Select a device or channel in the tree to display the collections
available for analysis. The collections are displayed in the Collection tab.

When you have added asset sources and devices in the Asset Explorer utility, the structure
is also reflected in the Network tab, including the channels of the devices.
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Figure 13-3: Network tab in the primary navigator

Table 13-2: Network tab bubble states for AMS 6500 ATGs and Ovation Machinery
Health Module

Vibration Analyzer Network tab shows colors that indicate a Channel State provided by the AMS
6500 ATG Interface through Status Evaluator.

Color Channel State

Red Critical Alert (Called a “Danger Alarm” in AMS Machine Studio
for AMS 6500 ATG)

Orange Warning Alert (Called a “Alert Alarm” in Machine Studio for
AMS 6500 ATG)

Yellow Advise Alert (Not used by AMS 6500 ATG)
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Table 13-2: Network tab bubble states for AMS 6500 ATGs and Ovation Machinery
Health Module (continued)

Color Channel State

Green Alert OK (There is an alert defined/enabled and the channel is
NOT in alert)

Quality Alert (Not used by AMS 6500 ATG)

Grey Alert not applicable

Alert not received

Gray is also used for Communications cards, channels with no
alerts, or no status has ever been received in Vibration
Analyzer from Status Evaluator.

Black Alert Invalid

No Data

Alert Not Evaluated

Table 13-3: Network tab bubble states for AMS 9420s and AMS Wireless Vibration
Monitors

Vibration Analyzer Network tab shows colors that indicate a Channel State provided by the AMS
Machine Works Wireless Interface through Status Evaluator.

Color Channel State

Red Danger Alert

Orange Warning Alert

Yellow Advise Alert

Green Normal

No alert

Grey Alert not applicable

Alert not received

Related information

The Network navigator
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13.1.3 Collections tab
When an asset, device, or channel is selected in the Network or Location tab, in the
Secondary navigator, the Collections tab displays the multiple types of data collected from
the same measurement locations.

Figure 13-4: Collections tab

Note
When multiple collections have been selected to display, the data is grouped by collection.

13.1.4 Function bar controls

Functions available to all plots. Click  to display all functions.

Button Function Description

Setup
Options

Change setup options for all the plots in the plotting workspace.

Vertical
Scale

Enable vertical scaling. Click the left icon (+) to increase the scale
and the right icon (-) to decrease the scale.

Horizontal
Scale

Enable horizontal scaling. Click the left icon (+) to increase the scale
and the right icon (-) to decrease the scale.

Horizontal
Pan

Enable horizontal panning. Click click the gray left / right arrow
icons to pan left and right.

Annotate
Plot

Displays a list of plot annotation options.
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Button Function Description

Clear Plot Clear the plotting workspace. Click the arrow to set the default
option for the Clear Plot icon. Choose from Clear Active and Clear
All.

New
Window

Launch active plots in a new window. Click one plot or shift-click
additional plots to activate plots.

Print/Print
Options

Click the Print icon to print an Image Summary Report. Click the
arrow to set the default option for the icon. Choose from Print All,
Print Active, and Print Workspace.

Print
Preview

Preview the Image Summary Report in the Report Viewer. Click the
arrow to set the default option for the icon. Choose from Print
Preview All, Print Preview Active, and Print Preview Workspace.

Save Image Save a single plot or plotting workspace as an image. Click the arrow
to set the default option for the icon.

Hot Keys Launch the Hot Keys list to see the key combinations for features
available for the active plotting workspace. Hot Keys vary
depending on the plots shown in the plotting workspace.

Trend

Functions available for Trend plots. Clicking on the Trend plot icon allows to display
(yellow color) or hide (blue color) Trend plots in the plotting workspace. Click + to view all
available functions.

Spectrum

Display or hide Spectrum plots in the plotting workspace.

Waveform

Display or hide Waveform plots in the plotting workspace.

13.2 Connect Vibration Analyzer to a different AMS
Machine Works server
If you have more than one AMS Machine Works deployment, you can connect Vibration
Analyzer to a different AMS Machine Works server. For example, a site might have
different plants with AMS Machine Works setup independently on different networks, or
service personnel may use the same laptop to connect to different AMS Machine Works
servers as they visit plants and perform analysis on different AMS Machine Works servers.
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Starting from version 1.6, when you have Vibration Analyzer installed, you can switch the
AMS Machine Works server in Vibration Analyzer. This is a convenient option because AMS
Machine Works Vibration Analyzer is a windows-based application. This feature allows a
single installation of Vibration Analyzer to select from a list of AMS Machine Works servers
to connect.

Note
The version of Vibration Analyzer Windows-client application must match the version of
the AMS Machine Works server.

Prerequisites

• Refer to your System Architecture drawings or other installation records for
information about where AMS Machine Works Web Services and AMS Machine Works
Historian are installed. They can be installed on the same server or different server. You
need the server connection information before creating a profile for each AMS Machine
Works server connection.

• Confirm the version of AMS Machine Works Vibration Analyzer you have installed is
compatible with the AMS Machine Works server.

• Confirm the other AMS Machine Works server is available by using your browser to
connect to one of the web-based utilities such as Asset Explorer.

• Install the certificate from the AMS Machine Works server on your PC.

Procedure

1. Click  and select Machine Works Server Setting.

The Change Server Connections dialog appears. By default, the option Use the
default application connection settings is selected.
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Figure 13-5: Change Server Connections dialog

2. To change the server, create a profile for the connection.

a) Select Use a profile to specify different connection settings.

b) Under Select a Profile, click Create.

c) Under Profile Information, enter a name for the profile. Emerson
recommends using the name of the AMS Machine Works server.

d) For AMS Machine Works Web Service, enter the Host name and Port.
The host information for AMS Machine Works Historian is automatically
updated to the same information, by default.
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Note
Only use an IP address if the AMS Machine Works was configured during
installation with the Use IP Address option. Emerson recommends using a
server name instead of an IP address for the setup.

e) If the AMS Machine Works Historian is on a different server, clear the check
box beside Use the same server as AMS Machine Works Web Service.
Then, under AMS Machine Works Historian, enter the Host name and Port.

f) Click Save.

The profile name appears in the Select a Profile menu as the selected profile. You
can edit this information later by clicking Edit. If you need to delete the profile, click
Delete.

3. Under Select a Profile select the profile name from the menu.
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Figure 13-6: Change Server Connections dialog

4. Click Connect.

The Connect button is only active if a profile is selected.

Vibration Analyzer displays information from the different instance of AMS Machine
Works. If there is a problem connecting to the server, an error message displays and
prompts you to edit the configuration settings.
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13.3 Active plots
When you activate a plot, you can perform functions and view details about a specific
point on the plot.

Click on a plot to make it an active plot. You can have more than one active plot by holding
the Shift or Ctrl key and clicking on the plots you want to be active. You can make all plots
in the plotting area active by pressing Ctrl + A.

Most function bar options and hot key commands only operate on an active plot. Some
exceptions are Clear Plot, Print, and Print Preview, which can be set to work on either
active or all plots. The color of the function bar icon is changing from blue to orange if you
turn plot visibility to ON from OFF.

By default, active plots are bright blue and inactive plots are dark blue.

Figure 13-7: Active plot vs inactive plot
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13.4 Cursor modes
The available cursor modes are: single, reference, difference, harmonic, and sideband.
Depending on the plot, one or more cursor modes are available.

Cursor mode Description

Single A single cursor helps you identify a specific point on the plot.
A square identifies a single cursor.

Reference A reference cursor is used to calculate the delta (Dfrq) between the primary cursor
and the point you select as the reference cursor.
A triangle identifies a reference cursor.

Difference Difference cursors are available on waveform plots.
A circle identifies a difference cursor.

Harmonic Harmonic cursors are available on spectrum and waveform plots.
A circle identifies a harmonic cursor.

Sideband Sideband cursors are only available for spectrum plots.
A diamond identifies a sideband cursor.

13.4.1 Mark a single cursor
Procedure

Click on an active plot.
A cursor appears at the nearest data point. The exact cursor position displays in the lower
right-hand corner of the plot legend and updates as the cursor moves.

Related information

Cursor modes

13.4.2 Move a cursor
There are four ways to move a cursor.

Procedure

• Press and hold Ctrl while using the left or right arrow key to move the cursor to a short
distance (micro-cursor movement).

• Press the left or right arrow keys to move from peak to peak.

• Use your mouse by dragging and dropping the cursor or clicking on a different point on
the plot to move the cursor.

• On your keyboard, Press Home to move the cursor to the start of the data, or press End
to move the cursor to the end of the data.

Related information

Cursor modes
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13.4.3 Mark cursors on a single spectrum plot
Procedure

1. Select a data point on the spectrum plot.

2. Right-click the plot and select Mark Cursors → Add.
The cursor is marked by a unique symbol. The symbol type changes each time a
new cursor is marked.

Note
To clear marked cursor symbols, right-click the plot and select Mark Cursors →
Clear.

Related information

Cursor modes

13.4.4 Set a reference cursor
If you have a single cursor placed on a plot, you can set a reference cursor on trend,
spectra, cascade, and waveform plots.

Procedure

1. Mark a single cursor by first clicking on an active plot. A cursor appears at the
nearest data point. The exact cursor position displays in the lower right-hand corner
of the plot legend and updates as the cursor moves.

2. Press Alt and click on the plot again.
A second cursor, the reference cursor, appears at the nearest data point. The
primary cursor remains and can be moved. The plot legend displays the position of
the reference cursor, the primary cursor, and their delta in the X dimension.

3. You can also right-click the plot and select Set Reference Cursor to place the
reference cursor exactly at the position of the primary cursor.

This is useful when measuring the precise frequency difference between two peaks.

13.4.5 Display a harmonic cursor
Harmonic cursors are available on all spectrums and waveforms plots.

Procedure

1. Mark a single cursor by first clicking on an active plot.
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A cursor appears at the nearest data point. The exact cursor position displays in the
lower right-hand corner of the plot legend and updates as the cursor moves.

2. Right-click on the plot and select Cursor Type → Harmonic.

13.4.6 Display a sideband cursor
Sideband cursors are only available for spectrum plots.

Procedure

1. Set a reference cursor.

2. Right-click the plot and select Cursor Type → Sideband.

N sideband cursors are displayed at intervals of the delta of the reference and primary
cursor. You can set the value for N in the Spectrum tab of the Setup Options Editor. See
Related information for details.

Related information

Spectrum tab

13.4.7 Display difference cursors
Difference cursors apply only to waveform plots. On a plot, they are used for measuring
time difference between selected points.

Procedure

1. Set a reference cursor.

2. Right-click the plot and select Cursor Type → Difference.

The primary cursor can be moved relative to the reference cursor, and cursor information
is displayed for both cursors and delta spacing.

13.4.8 Use linked cursors
Linked cursors let you synchronize the movement of cursors on multiple active plots.
Generally, only plots of the same type have linked cursors.

Procedure

1. Display multiple plots of the same type either together or separately.

2. Mark a cursor on one of the plots.

3. Press Ctrl and click the plots you want to activate.

When you move a cursor on one active plot, a cursor appears on all other active plots at
the same location and moves simultaneously.
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13.5 Zoom in or out on a plot
Procedure

1. To zoom in, right-click and hold on the plot, and select the area you want to zoom.
A dotted box shows the selection area.

2. Release the right mouse button. The plot zooms in to display only the portion of the
plot you selected.

3. To zoom out, right-click near the axis of a plot and select Zoom Out. The X and Y
axis can be zoomed in and out separately. Zoom to the original view by clicking the
green scale arrow icons.

13.6 Overlay
An overlay lets you compare two plots of the same type using similar units. You can
generate an overlay by dragging and dropping one plot onto another plot. All plot types
except for cascade plots support overlays.

The image below illustrates two waveform plots with the same amplitude units. The top
waveform was dragged and dropped to the bottom waveform to create an overlay. The
data from the top waveform is displayed in green. This color can be changed in the Plot
Options tab of the Setup Options Editor dialog.

Vibration Analyzer Online Help
July 2022

134 AMS Machine Works v1.7



For all plot types except spectrum plots, a plot can only have one overlay at a time. If
another plot is dragged to a plot that already has an overlay, the current overlay is
replaced.

For spectrum plots, the default view of overlay data can be set in the Spectrum tab of the
Setup Options Editor dialog. Multiple overlays can be displayed by pressing the Ctrl key
and dragging and dropping multiple spectrum plots to a target spectrum plot.

The overlay function generally requires plots to have the same amplitude units. However,
you can overlay spectrum, and waveform plots even if the amplitude units are different.
Overlay units will be converted to the units of the target plot.

You can view information about the overlay by right-clicking the plot and selecting Display
Overlay Info.

Related information

Plot Options tab
Spectrum tab

13.7 Annotate plot
Mark plots with annotations to point out specific areas of interest and make notes.

Procedure

1. Click  on the Common Controls function bar, or right-click on a plot and
select Annotate Plot.

The Adjust Annotations dialog appears.

2. Click the icon for the type of annotation you want to add.

Icon Option Description

New Line
Annotation

Adds a new line to the plot.

New
Rectangle
Annotation

Adds a new rectangle to the plot.

New Ellipse
Annotation

Add a new ellipse to the plot.

New Text
Annotation

Adds new text to the plot.

Advanced
Editing Tools

Lets you specify additional details for the annotation you selected.

3. Click on the annotation and adjust the size by dragging a sizing handle. You can also
move the annotation by dragging it.
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4. Click .

Click  to delete a selected annotation or click  to delete all annotations on the
plot.

Note
Annotations are NOT saved. Save the plotting workspace as an image if you want to
keep the annotations.

13.8 Configure the plotting workspace
Change the type of information to display automatically when you make a selection in the
Navigator.

Procedure

1. Click  and select Selection Type Preferences.
The Selection Type Preferences dialog appears.

2. Expand a selection type and select an option to modify.
Display settings appear on the right pane.

3. Modify your desired settings.

Note
Click Defaults to reset settings to default values.

4. Click OK.

13.8.1 Set the line frequency
Procedure

1. Click  and select General Settings.

2. Enter a value and click OK.

13.8.2 Set unit preferences for the Vibration Analyzer
Procedure

1. Click  and select Units Preferences.

2. Use the drop-down menu to configure unit modes and dB references for the
following:

• Acceleration

• Velocity

• Displacement

• Sound Pressure
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• General Dynamic

• HFD

• Motor Current

• Flux Data

• Shaft Voltage

• Shaft Current

3. For Data Display Units, select English or Metric.

4. Click OK.

13.9 Customize display for plots
Procedure

1. From the primary navigator, select a measurement point to display its plot.

2. Right-click on the plot and select Setup Options. You can also click  from the
Common Controls function bar.
The Setup Options Editor dialog appears.

3. Select from these tabs and make your desired changes.
• Trend—customize display for trend plots.

• Plot Options—customize display for all plots.

• Spectrum—customize display for spectrum plots.

• Waveform—customize display for waveform plots.

• Composite Trend—customize display for composite trend plots.

4. Click OK.

Related information

Plot Options tab
Trend tab
Spectrum tab
Waveform tab
Composite Trend tab

13.9.1 Plot Options tab
Right-click on the plot and select Setup Options → Plot Options tab. The Plot Options tab
provides settings available for most plot types. The user can change: color settings,
labeling preferences, fault frequencies display options, and image saving options.
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Plot Color Setup

Select a color for different element types displayed on a plot. Click Defaults to reset the
color settings to default values.

Miscellaneous

Miscellaneous portion of the Plot Options tab contains the options for Fault Frequencies
and Saved Images.

Option Description

Source Fault frequencies can come from different sources. Select All,
Configuration, or Measurement Location.

Format Select either Lines or Lines and Values. Lines only display fault frequency
lines on the plot while Lines and Values display fault frequency lines on
the plot and the value on the plot legend.

Line Thickness Specify the thickness of the line used to mark the fault frequency position
on the data plot. Select either Thin or Thick.

Match Tolerance
(%/Order)

Specify the percentage per order of tolerance to be applied to consider
the frequency a match.

Specify Colors Change plot colors for specific components of the plot.

Default Frequency
Units

Set the default frequency units. Select either Hz or CPM.

Format for Speed
Values

Set the unit for speed. Select either RPM or RPS.

Plot Font Size Set the size of the text displayed in the plot. Select Small, Medium, Large,
or Extra Large. More information is displayed if a smaller font is chosen.

Auto-hide Function Bar Mark the box to automatically hide the Common Controls function bar
when it is not used. Hiding the function bar increases the size of the plot
area.

Saved Images

Each plot type can be saved as an image file. These settings are:

Option Description

File Format Set the default file format for images. Select: .bmp, .jpeg, .png, or .emf.

Manually Enter
Filename

Mark the box to be prompted to enter a filename when saving an image.

Link Image to Machine
Journal Entry

Select this option to link images to a Journal entry.

Note
Machine Journal is not supported in this release.

Save Image to File on
Local Machine

Save images on your computer in the database system.

File Save Location Location of a file on a Local Machine. The default location is C:\temp.
Click Browse to select a different location.

Defaults Resets all settings in this section to the default values.
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13.9.2 Trend tab
Right-click on the plot and select Setup Options → Trend tab. The Trend tab displays
options for trend plots.

Time Axis Options

Option Description

Fixed Scale Enabled Select the check box to limit the range of the
Time axis to a specified starting and ending
position.

Starting Date If the Fixed Scale Enabled check box is selected,
choose the starting date.

Ending Date If the Fixed Scale Enabled check box is selected,
choose the ending date.

Keep End Date Set to Current on Restart Select the check box to match the end date with
the current date.

Defaults Resets all Time Axis options to default values.

Amplitude Axis Options

Option Description

Independent Scaling Allows each plot to scale independently to maximize data resolution.

Autoscale Across Plots Scales similar data plots to the same amplitude axis scale to make
amplitude differences more visually obvious.

Fixed Scale Enabled Limits the Amplitude Axis range based on specified lower and upper
amplitudes for selected units. Enter the lower scale and upper scale
values. The lower scale sets the lower amplitude and the upper scale sets
the upper amplitude.

Defaults Resets Amplitude Axis options to default values.

Display Options

Option Description

Display Grid Lines Displays grid lines on plots.

Update Spectrum/
Waveform with Trend
Cursor

Select the check box to allow the trend point where the cursor is
positioned to simultaneously display the time-associated spectrum and
waveform, if available.

Alarms Select the check box beside each alarm level you want to display.

Defaults Resets Display options to default values.
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13.9.3 Spectrum tab
Right-click on the spectrum plot and select Setup Options → Spectrum tab. The
Spectrum tab displays options for spectrum plots.

Frequency Axis Options

Option Description

Units Select Hz, CPM, or Orders as the unit used for
the frequency axis.

Type Select either Linear or Log as the scale.

Fixed Scale Enabled Select the check box to limit the frequency axis
range to a specified lower and upper frequency.

Lower Frequency Set the lower frequency for the fixed scale.

Upper Frequency Set the upper frequency for the fixed scale.

Defaults Resets Frequency Axis options to default values.

Amplitude Axis Options

Option Description

Units Select Stored Units, Acceleration, Velocity, or
Displacement as the unit used for the amplitude
axis.

Type Select either Linear or Log as the scale.

Independent Scaling Allows each plot to scale independently to
maximize data resolution.

Autoscale Across Plots Scales similar data plots to the same amplitude
axis scale to make amplitude differences more
visually obvious.

Fixed Scale Enabled Limits the Amplitude Axis range based on
specified lower and upper amplitudes for
selected units. Enter the lower scale and upper
scale values. The lower scale sets the lower
amplitude and the upper scale sets the upper
amplitude.

Defaults Resets Amplitude Axis options to default values.

Display Options

Option Description

Harmonic Cursor Markers Enter the number of harmonic cursors to
display. The default value is 8.

Peaks to List Enter the number of peaks to be listed when the
peak list viewer is displayed. The default value is
24.
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Option Description

Sideband Cursor Markers Enter the number of sideband cursor markets to
display. The default value is 5.

Display Grid Lines Displays grid lines on plots.

Automatic Overlay Type (Periodic and Online) Lets you display an automatic overlay. Select
None, Reference, or Previous.

Limit Type to Plot Lets you display an alarm type on the plot.
Select None, Warning, Alert, Fault, or Envelope.

Apply Runout Compensation When Available If runout compensation is available (either
stored in a particular archive or with the
database), it allows the compensation to be
applied to the display of the archive, live/replay
data, or both.

Defaults Resets Display options to default values.

Peak Label Options

Option Description

Displayed Information Choose the type of information to be displayed. Select Frequency,
Amplitude, or Both.

Automatic Peak
Labelling

Select the check box to automatically display peak levels.

Number of Peaks to
Label

If Automatic Peak Labelling is selected, specify the number of peaks to
label. The default value is 5.

Multiple Spectrum Options

Option Description

Highlight Active Trace Highlights the active spectrum in a multi-
spectral plot.

Display Floor Cursor Select the check box to display a floor-type
cursor.

Display Plane Cursor Select the check box to display a plane-type
cursor.

Opacity If Display Plane Cursor is selected, enter the
opacity of the plane cursor.

Z-Axis Angle Enter the Z-axis angle of spectral data in multi-
spectral plots.

Overlap Percentage Enter the overlap percentage of spectral plots
displayed in multi-spectral plots.

Plot Sequence Lets you choose the direction of time for
spectral data displayed in multi-spectral plots.
Select either Top Down or Bottom Up.

Defaults Resets Multiple Spectrum options to default
values.
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13.9.4 Waveform tab
Right-click on the waveform plot and select Setup Options → Waveform tab. The
Waveform tab displays options for waveform plots.

Time Axis Options

Option Description

Units Select either time or revolutions as the unit used
for the time axis. Revolutions do not apply to
live waveforms.

Independent Scaling Allows each plot to scale independently to
maximize data resolution.

Autoscale Across Plots Scales similar data plots to the same time axis
scale to make time differences more visually
obvious.

Fixed Scale Enabled Limits the range of Time or Revolution to a
specified lower and upper value.

Starting Position Set the starting position for the fixed scale.

Ending Position Set the ending position for the fixed scale.

Defaults Resets all Time Axis options to default values.

Amplitude Axis Options

Option Description

Units Select Stored Units, Acceleration, Velocity, or
Displacement as the unit used for the amplitude
axis.

Independent Scaling Allows each plot to scale independently to
maximize data resolution.

Autoscale Across Plots Scales similar data plots to the same amplitude
axis scale to make amplitude differences more
visually obvious.

Fixed Scale Enabled Limits the Amplitude Axis range based on
specified lower and upper amplitudes for
selected units. Enter the lower scale and upper
scale values. The lower scale sets the lower
amplitude and the upper scale sets the upper
amplitude.

Defaults Resets Amplitude Axis options to default values.

Display Options

Option Description

Number of Cursor Markers Sets the number of cursor markers to display.
The default value is 5.

Mark Normalizing Frequency Displays marks for the normalizing frequency.
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Option Description

Plot in Circular Format Displays the waveform in circular format rather
than X-Y format.

Display In Single Column Displays the analysis pane in a single column.

Display Grid Lines Displays grid lines on plots.

Display Alarm Levels Displays alarm levels on waveform plots.
Selecting this check box enables the four fields
below.

Maximum Peak Acceleration

Maximum Peak Velocity

Maximum Peak Displacement

Maximum Crest Factor

Enter the waveform alarm levels to generate
waveform alarms for points that do not have
measure waveform analysis.

Defaults Resets Display options to default values.

Filter Settings

Option Description

Acceleration Select a filter for each field. The filters are:
• None—No filter is applied to the data.

• 1x—A 1xRPM filter is applied to the data.

• 2x—A 2xRPM filter is applied to the data.

• 3x—A 3xRPM filter is applied to the data.

• Custom—A custom filter is applied to data.

If any filter is selected, type of filter can be set to
Bandpass or Lowpass. The custom filter is
defined by Custom Value - number of harmonic
of rotation speed.

Velocity

Displacement

General Dynamic

Defaults Resets all Filter Settings options to default
values.

13.9.5 Composite Trend tab
Right-click on the composite trend plot and select Setup Options → Composite Trend
tab. The Composite Trend tab display options for composite trend plots.

Time Axis Options

Option Description

Fixed Scale Enabled Select the check box to limit the range of the
Time axis to a specified starting and ending
position.

Keep End Date Set to Current on Restart Select the check box to match the end date with
the current date.
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Display Options

Select the Display Grid Lines check box to display grid lines on all composite trend plots.

13.10 Spectrum plots
A spectrum plot is a graphical representation of vibration amplitudes in the frequency
domain.

To view a spectrum plot, click on a measurement point or channel in the primary
navigator. In the Details navigator, under the Spectra table, select a date/time of interest.

13.10.1 Spectrum function bar

The spectrum function bar is available when:

• a spectrum plot is the only open plot

• a spectrum plot is selected in a plot viewer with multiple plots

Click  to display all functions.
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Button Function Description

Cursor Type Click to toggle cursor types.

Peak Locate Click to locate a peak.

Label Peaks Click to label peaks. Click the arrow to label the primary cursor
or all cursors.

Fault
Frequencies

Click to open the Fault Frequency List Viewer. Click the left or
right buttons to show the previous or next fault frequency.

Peak List Click to open the Peak List Viewer. Click the left or right buttons
to show the previous or next peak.

Harmonic
Family List

Click to open the Harmonic Family Viewer. Click the left or right
buttons to show the previous or next harmonic family.

Note
For multiple spectrum plots, only the Cursor Type, Peak List, and Harmonic Family buttons
are displayed.

13.10.2 Display calculated trend from single spectra, multiple
spectrum, or cascade plots

Procedure

1. Mark a cursor on the plot.

2. Right-click and select Display Calculated Trend → Primary Cursor Location.

The Primary Cursor Amplitude Trend dialog is displayed.

Notes
• If a single cursor is marked on the plot, a calculated trend for the frequency or

order is displayed.

• If the plot has a reference cursor and a primary cursor, an additional option
allows the calculation of a trend for the spectral band bounded by cursors.

• For single spectrum plots, the displayed trend includes a data point for all route
spectra present on the current measurement point.

• For multiple spectrum and cascade plots, the generated trend plot includes data
points only for the displayed data.

13.10.3 Peak List Viewer

To display the Peak List Viewer, click  on the Spectrum function bar.

Online Help Vibration Analyzer
July 2022

AMS Machine Works v1.7 145



Use the Peak List Viewer to:

• Display detailed information about peaks in a spectrum plot.

• Select specific peaks to print detailed information.

• Select specific peaks to label on the plot.

13.10.4 Display harmonic family list
Procedure

1. Open a spectrum plot.

2. Click  on the Spectrum function bar.
The Harmonic Family Viewer dialog appears.

3. Select a harmonic family or difference family.
The plot displays your selection.

4. You can also use the left or right buttons to display harmonic families or difference
families.

13.10.5 Display fault frequencies
You can display fault frequencies in autocorrelation plots, waveforms, and spectra.

Procedure

1. Open a spectrum or waveform plot. To open autocorrelation plot right click on
waveform plot and choose Autocrrelate.

2. Expand the Spectrum or Waveform function bar.

3. Click .
The Fault Frequency List Viewer dialog appears.

4. Select a fault frequency.
The plot displays the selected fault frequency.

5. Select Keep Frequency Displayed if you want the plot to always display your
chosen fault frequency.
A checkmark appears beside the selected fault frequency.

Note
You can select multiple fault frequencies to be always displayed.

6. Otherwise, click Clear Displayed Frequencies if you do not want the plot to show
fault frequencies.

Note
You can also click the left or right buttons to view the previous or next fault
frequency without opening the Fault Frequency List Viewer dialog.
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13.10.6 Match the fault frequency of a cursor location
AMS Machine Works compares all fault frequencies (including harmonics) to the current
cursor location. If the difference between the cursor frequency and a given fault frequency
is less than the match tolerance specified in the Plot Options tab, the frequency will be
considered a match.

Procedure

1. Activate a spectrum plot.

2. Mark a cursor to identify the location you want to match.

3. Press K on your keyboard.
Matches display on the plot for the current cursor.

13.10.7 Match any available fault frequency
You can find a match from the entire peak list to any of the available fault frequencies. If
the difference between the frequency of a peak in the peak list and a given fault frequency
is less than the match tolerance specified in the Plot Options tab, the frequency will be
considered a match.

Procedure

1. Activate a spectrum plot, but do not place a cursor.

If you have a cursor on the plot, remove the cursor.

2. Press K on your keyboard.
Matches display on the plot for the entire peak list.

13.10.8 Locate peaks
When you mark a cursor, the cursor may be near the peak, on a slope instead of a peak.
Use this function to move the cursor so that it is on a precise peak. For example, it can be
used to determine the exact frequency and amplitude of a peak.

Procedure

1. On a spectrum plot, place the cursor on top of the desired peak by clicking near the
peak.

2. Click  on the Spectrum function bar or right-click on the plot and select
Locate Peak.

Note
To remove a peak, right-click on the plot and select Remove Peak.

13.10.9 Label peaks on single spectrum plots
If you have located peaks on a spectrum plot, you can label the peaks. You can label the
primary cursor or all cursors. Use the following methods:

Online Help Vibration Analyzer
July 2022

AMS Machine Works v1.7 147



Procedure

• To label the primary cursor, right-click on the plot and select Label Peak → Primary

Cursor. You can also use the Label Peaks button  on the Spectrum function
bar. Click the down arrow and select Label Primary Cursor.
The primary cursor is labeled with the horizontal axis value of the peak.

• To label all cursors, right-click on the plot and select Label Peak → All Cursors. You can

also use the Label Peaks button  on the Spectrum function bar. Click the
down arrow and select Label All Cursors.
All cursors are labeled with the horizontal axis value of the peaks.

13.10.10 View multiple spectra in one plotting workspace
Multiple spectra plots can be viewed in the plot area together or separately.

Procedure

1. Use the Details navigator to find a measurement point.

2. Press Shift and click on measurement points to select a range of points. You can
also press Ctrl and click more than one measurement point to select multiple,
specific measurement points.
The plots appear separately on the plotting workspace.

3. Right-click on the plotting workspace and select Display Spectra Together.

Note
To change the plot display back to separate plots, right-click and select Display
Spectra Separately.

13.11 Waveform plots
A waveform plot is a graphical representation of how the vibration level changes with
time.

To view a waveform plot, click on a measurement point or channel in the primary
navigator. In the Details navigator, under the Waveform table, select a date/time of
interest.
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13.11.1 Waveform function bar
Functions for waveform plots.

Click  to display all functions.

Button Function Description

Cursor Type Click to toggle cursor types (for example,
Single, Difference, and Harmonic).

Mark RPM Click to display RPM markers. Use the arrow to
select Toggle Markers or Set Markers. Toggle
Markers displays or hides the RPM markers.
Toggle Markers synchronizes the RPM
markers with the current cursor location.

Filter Options Click the left or right button to show the
previous or next filter type. You can select all
the available options for band-pass and low-
pass filters.
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Button Function Description

Fault Frequencies Click to open the Fault Frequency List Viewer.
Click the left or right buttons to show the
previous or next fault frequency.

Peak List Click the left or right buttons to show the
previous or next peak.

Set Rpm Click to open pop-up window allowing to set
correct RPM speed. Cursor can be used to
identify RPM value.

Toggle Display Format Click to change the plot display. You can view
a waveform in standard X/Y format or in
Circular format.

Toggle All/One Revolutions Click to display all revolutions or one
revolution at a time. When displaying one
revolution, click the left or right arrows to
display the previous or next revolution. Click
the first or last arrows to show the first or the
last full revolution (on some data plots,
clicking the arrow again will show the
remaining "partial" revolution"). When
displaying all revolutions, click the arrows to
step through each revolution with the cursor.

Play Audio Click to open the Waveform Audio Replay
dialog and listen to an audio recording of the
waveform.

13.11.2 Use micro-step cursor on waveform plots
Procedure

1. Click on a plot.

2. On keyboard press Ctrl+LEFT ARROW or Ctrl+RIGHT ARROW to move through
different data points.

13.11.3 Display fault frequencies
You can display fault frequencies in autocorrelation plots, waveforms, and spectra.

Procedure

1. Open a spectrum or waveform plot. To open autocorrelation plot right click on
waveform plot and choose Autocrrelate.

2. Expand the Spectrum or Waveform function bar.

3. Click .
The Fault Frequency List Viewer dialog appears.

4. Select a fault frequency.
The plot displays the selected fault frequency.
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5. Select Keep Frequency Displayed if you want the plot to always display your
chosen fault frequency.
A checkmark appears beside the selected fault frequency.

Note
You can select multiple fault frequencies to be always displayed.

6. Otherwise, click Clear Displayed Frequencies if you do not want the plot to show
fault frequencies.

Note
You can also click the left or right buttons to view the previous or next fault
frequency without opening the Fault Frequency List Viewer dialog.

13.11.4 Play waveform audio
Procedure

1. On a waveform plot, click 
The on the waveform function bar. Waveform Audio Replay dialog is displayed.

2. Click  to play and operate the waveform audio recording.

3. You can also save a copy of the audio file by clicking .
The Save Waveform Audio File dialog is displayed. Browse to your selected folder
and click Save.

13.11.5 Replay a waveform
This function is available for Transient Waveforms. When you reply a transient waveform
you can watch the plot and associated measurements changing in the plotting workspace.
It is useful for analyzing vibration behavior of machine during e.g. run-up, passing of
machine through resonance, etc.

Procedure

1. In the waveform plotting workspace, move the subsample (red box) to select a
portion of long waveform to focus on. Right click to adjust resolution of the
subsample (Increase/Decrease Subsample, Subsample Size).
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2. Right click the Region of Interest area (gray colored box, right click must be outside
of the subsampler box) and select Replay Menu.

The Replay Menu dialog is displayed.
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Figure 13-8: Replay Menu

3. On the Replay Menu, go to the Controls tab and set your playback settings.

On the Replay Menu, go to Collection Data tab and select the dates that you want
to play.

4. Click  to play the waveform recording.

The waveform subsample box will move according to the selected playback settings
and collection time.

13.11.6 View each revolution in a waveform
You can view each single revolution in a waveform plot. You can view all the revolutions on
the same plot or display them one at a time.
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Procedure

1. Use the Navigator to find a measurement point.

2. Expand the measurement point and click a waveform.

In the plotting workspace, a waveform is displayed for all the revolutions in the
measurement. The revolutions are selected based on set rotation speed.

You can select multiple waveforms. Press Shift and click the range of points in the
Navigator. You can also press Ctrl and click multiple, specific waveforms.

Figure 13-9: Waveform plot: all revolutions in X/Y mode

3. Click  to toggle from all rotations to one revolution.

Figure 13-10: Waveform plot: one revolution in X/Y mode

4. Click the right and left arrows  to view the next and previous
complete revolutions.

5. Click the first and last arrows  to view the first and last complete
revolutions.

To see a partial revolution after the last complete revolution, click the right arrow.
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6. Click  to toggle from the waveform plot to the circular waveform
plot.

The waveform plot displays all the revolutions in the measurement.

Figure 13-11: Waveform plot: all revolutions in circular mode

7. Click  to toggle from all rotations to one revolution.
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Figure 13-12: Waveform plot: one revolution in circular mode

8. Use the arrows to view each revolution.

13.12 Trend plots
A trend plot shows a set of values of a vibration parameter over a period of time.

To view a Trend plot, click on a measurement point or channel in the primary navigator. In
the Details navigator, under the Trends table, select a date/time of interest.
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Figure 13-13: Trend Plot

13.12.1 Trend function bar
Single trend plots

The following functions are available when a single trend plot is shown on the plotting
workspace:

Button Function Description

Trend On/Off Click the button beside the image to show all functions.

Label Point Displays a label for your selected data point.

Multiple trend plots displayed together

The following functions are available when multiple trend plots are displayed together:
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Button Function Description

Parameter
Correlation

Compares two different parameters.

Amplitude
Display Format

Changes the vertical axis to a relative scale.

13.12.2 View multiple trend plots on one plot
Multiple trend plots may be selected and viewed in the plot area together or separately.

Procedure

1. Use the Details navigator to find a measurement point.

2. Press Shift and click on measurement points to select a range of points. You can
also press Ctrl and click more than one measurement point to select multiple,
specific measurement points.
The plots appear separately on the plotting workspace.

3. Right-click the plotting workspace and select Display Parameters Together.

Note
When you view multiple trend plots together, the Trend Function bar displays the
Parameter Correlation button and the Amplitude Display Format button. See Related
information for more details.

Related information

Trend function bar

13.12.3 Display a correlation plot
Procedure

1. Use the Details navigator to find a measurement point.

2. Press Shift and click on measurement points to select a range of points. You can
also press Ctrl and click more than one measurement point to select multiple,
specific measurement points.
The plots appear separately on the plotting workspace.

3. Right-click the plotting workspace and select Display Parameters Together.

4. Click  on the Trend function bar.
The Select Parameters for Correlation dialog is displayed.

5. Select two different parameters to compare. The first parameter appears on the
horizontal axis and the second parameter appears on the vertical axis.
A plot displays the data points for each parameter matched by date and time.
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13.12.4 View normalized multiple trend plots
The vertical axis is labeled based on the type of data shown, if multiple trend plots are
viewed separately. However, if you view multiple trend plots together, the vertical axis
displays data in absolute terms or mixed units in absolute terms (if more than one
amplitude is present).

Procedure

Click  on the trend function bar to cycle through the following scale options:
• Mixed Units (default)

• Percent Alert

• Percent Fault

• Percent Change from Mean

• Percent Change from Baseline

13.12.5 Show/hide upper danger, warning, and advise alarm
levels
Procedure

Right-click on the trend plot and select Alarm Options.
• To show upper alarm levels, select:

— Show Upper Danger

— Show Upper Warning

— Show Upper Advise

• To hide upper alarm levels, select:
— Hide Upper Danger

— Hide Upper Warning

— Hide Upper Advise

13.13 Transient data
Transient data is a longer recording of a vibration signal, usually covering unsteady
operation conditions of a monitored machine. A length of a transient waveform may differ
significantly depending on the type of events one wants to capture but it may be from
several minutes to more than an hour. The main purpose of collecting transient data is to
analyze the response of the machine to changes in the underlying process (such as
startup, shutdown, increasing or decreasing load). However, it might be also used to
capture rare intermittent events, difficult to record in regular time-based collections. In
either case, a transient waveform is not intended to be analyzed as a whole. For example,
there is no point in calculating a spectrum from the entire recording, analysis of which
requires stable operation of the machine. The goal of transient data analysis is to observe
the variability of an instantaneous state of the machine during the transient conditions.
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This can be accomplished by comparing instantaneous waveforms or spectra at different
moments of the recording (cascade or waterfall plot) or trending amplitudes and phases
of selected harmonics (Bode-Nyquist plots).

The AMS Machine Works 1.7 provides tools for transient data analysis via the Vibration
Analyzer application. A special set of functions is enabled for recordings longer than 4096
points (1600 spectral lines). Transient data analysis is not supported in the Analysis
Dashboard yet.

Within supported devices, the AMS 6500 ATG and Ovation MHM offer the ability to collect
transient data. AMS 6500 ATG can record up to 96000 points in a single data file. Ovation
MHM module collects waveforms in a continuous manner up to the capacity of the
respective Machinery Health Waveform Recorder software. However, they are available in
the AMS Machine Works in packages containing maximum 1048576 points. A transient
analysis is possible on a single data package at a time.

13.13.1 Full spectrum plot

The full spectrum plot is part of the default display when you select a pair of companioned
measurement points under a transient job file in the Navigator. The plot is generated
based on the Subsampler selection of waveforms of the companioned points.

The following context menu options are available for full spectrum plots:

Option Description

Clear Cursor Remove all cursors on the plot.

Set Reference Cursor Place a reference cursor on the plot.

Clear Plot Remove all cursors and labels on the plot.

Amplitude Units Select the amplitude unit for the plot.

Label Peak Label the primary cursor or all cursors.
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13.13.2 Cascade/Waterfall full spectrum plot

The cascade/waterfall full spectrum plot is displayed when you select a measurement
point under an AMS 6500 ATG in the Location Navigator. It is based on the Region of
Interest of waveforms.

Click  to change the plot perspective.

To change the context of your cascade/waterfall plot, modify Block Size in the Region of
Interest Settings dialog. The plot type is also dependent on the Mode:

Mode Plot

Delta RPM Waterfall

Delta Time Cascade

Fixed Number Waterfall

The following context menu options are available for cascade/waterfall plots:

Option Description

Cursor Type Change the cursor type to Single, Harmonic, or
Sideband.

Update Subsampler Updates the Subsampler location on the
transient waveform, thus updating the detail
waveform/spectrum to the specified waterfall
spectrum.

Dynamic Display Control Change the display of spectral overlap and data
perspective.

Display Trend Plot Displays a trend plot across displayed spectral
data, at constant frequency or constant order.
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Option Description

Display Calculated Trend Displays a trend plot based on the primary
cursor location, maximum band amplitude, or
band total energy.

Apply Runout Correction/Clear Runout
Compensation

If a runout waveform is stored in the archive
being analyzed, the data can be adjusted for
runout.

13.13.3 Shaft centerline plot
The shaft centerline plot displays the average shaft position with respect to the bearing
surface.

The bearing clearance value is equal to the difference between the shaft diameter and the
diameter of the bearing journal. The diameter of the displayed circle is equal to the
specified bearing clearance value. The data points represent the average position of the
shaft center. If the shaft is in the exact center of the bearing, it could move a distance in
any direction equal to half the bearing clearance before contacting the inner surface of the
bearing. Thus, data points touching the circle indicate contact between the shaft and the
bearing. The dynamic shaft motion may result in contact between the shaft and the
bearing lining prior to the data points actually touching the circle.

The following context menu options are available for shaft centerline plots:

Option Description

Clear Cursor Remove the cursor on the plot.

Add RPM Labels/Clear RPM Labels Add or remove RPM labels on the plot.

Clear Plot Remove the cursor and revolution markers on
the plot.
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Option Description

Specify Bearing Parameters Override specified resting voltage and bearing
clearance values.

For the AMS 6500 ATG, the shaft centerline plot is part of the default display when you
select a pair of companioned measurement points in the Navigator. The plot is generated
based on the sensor DC values collected from companioned displacement probes as set in
AMS Machine Studio.

13.13.4 Bode/Nyquist plot

Option Description

Filter Options Select how waveform data is filtered. Select 1xRPM, 2xRPM, 3xRPM, or
Custom.

Display Versus Time Opens a new window displaying the plots with Time as the horizontal axis
value.

The Bode/Nyquist plot is part of the default display when you select a pair of companioned
measurement points under a transient job file in the Navigator. The Region of Interest
determines the size and position of the Bode/Nyquist plots.
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13.13.5 Orbit plot
An orbit plot shows the two-dimensional movement of the shaft centerline relative to the
pair of sensors (such as displacement probes) mounted at right angles at the same
location. Orbits are constructed from the waveform data collected from each sensor. The
sensors are typically named with an X and Y to identify the position of the sensor along the
x-axis and y-axis.

The orbit plot displays the sensor location, tachometer location, and direction of rotation.

The following context menu options are available for orbit plots:

Option Description

Filter Options Select how waveform data is filtered.

Clear Cursor Remove the cursor on the plot.

Clear Plot Remove the cursor and revolution markers on
the plot.

Show Rev Markers/Hide Rev Markers Show or hide revolution markers on the plot.

Amplitude Units Select the amplitude unit for the plot.
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Option Description

Specify sensor angles Specify the angular position of X, Y and tach
sensors
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14 Health

14.1 Health calculation
The health of each asset is calculated in the software and displayed as a numerical rating.

Health index

Each extension that interacts with a given asset assigns it a health index between 0–100,
where 0 is completely unhealthy, and 100 is completely healthy. The software calculates
an overall asset health index (or asset health roll-up) based on the entries set by all
sources.

Each asset also has an asset priority that affects its weight in the health calculation
methods. The asset priority represents the importance of an asset with respect to other
assets in the system. The software also uses the health index to derive an asset's status.

Health opinion

A health opinion is reported by the asset source for assets in that asset sources' hierarchy.
The health opinion is presented as a health index number between 0-100.

An asset can have health opinions from varying asset sources. The software takes into
consideration the health opinions to calculate the overall health of an asset.

The health of multiple assets can be aggregated by either creating a generic asset and/or
moving assets around to create parent/child associations.

Related information

Health index conversion
Set the health calculation method
Set the asset priority
Set the priority of health opinions from interfaces or asset extensions

14.2 Health index conversion
Severity to health index

Asset sources, such as devices, monitor machines. When there is a problem with a device
or the machine being monitored by the device, one or more alerts may be reported. The
severity of the alert is determined by comparing a measured value against a group of set
points, also referred to as alert limits.
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Figure 14-1: AMS Machine Works alert types and alert set points mapped to severity
ratings

AMS Machine Works uses multiple measured value severity scores to calculate an overall
asset severity which is subsequently converted to an overall heath index.

Health index = 100 – S where S is device severity as reported in AMS Machine Works

Related information

Health calculation
Set the health calculation method

14.3 System status service
The System Status service listens for health status updates from all other AMS Machine
Works services. It has a complete list of services that are expected to report the status. If
the System Status does not receive updates from a service, it marks the service as
unavailable.

Possible system statuses

There are three possible values for the health status:

• Healthy
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• Degraded

• Unhealthy

Along with the health status, a short description provides more details. Examples:

• Cannot connect to the database

• ATG Interface unavailable (or offline)

• Cannot connect to Historian service

• Device Orphaned (not being handled by any interface)
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15 Asset Explorer
The Asset Explorer utility allows you to set up your site, create locations, add machines and
devices, and arrange them according to how your plant is set up. This utility lets you
centrally manage and view the health status of your plant assets. You can set persona-
specific functions for user accounts by setting responsibilities and permissions in the User
Manager utility. Permissions and responsibilities ensure the user has the proper access to
locations and assets to which he is assigned. You can also do the following from the Asset
Explorer utility:

• Set up your site hierarchy.

• Add assets to AMS Machine Works for asset sources such as AMS Asset Monitor,
Emerson Wireless Gateway, AMS 9420 Vibration Analyzer, AMS Wireless Vibration
Monitor, AMS 6500 ATG, AMS Asset Monitor, and Ovation Machinery Health Waveform
Recorder.

• Configure data collection settings for devices.

• Assign asset class responsibilities to users.

• Launch AMS Machine Works Vibration Analyzer

Related information

Asset Explorer user interface
The Location navigator
The Network navigator
The Library
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15.1 Asset Explorer user interface
Figure 15-1: Asset Explorer user interface

A. Ribbon—contains a link to the File menu and to the Home ribbon, a context-sensitive tab that display actions
and editable settings.

B. Navigation bar—icons and breadcrumbs that help you move through the Location, Network, and Library
navigators.

C. Navigators—displays Navigator trees for the Location, Network, and Library tabs.
D. Contents pane—displays the name, description, class, and health of the item selected in the navigator.
E. Details pane—displays information based on the selection in the Contents panel.
F. User toolbar—allows launching of other applications, utilities, and software. This also displays your account

information, a link to the Online Help, and a button to collapse the ribbon.

15.1.1 File menu
Option Description

System Info This page shows the activation status of the software.

About — view software versions and licenses.
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Option Description

System Settings The settings in this menu are
Health Settings — This option is not used in AMS Machine Works.

Ignored Asset Management — This option is not used in AMS Machine Works.

Plant Calendar Management — This option is not used in AMS Machine Works.

Spam Management — This option is not used in AMS Machine Works.

CMMS Configuration — This option is not used in AMS Machine Works.

User Settings Message Subscription Management — This option is not used in AMS Machine Works.

Junk Management — This option is not used in AMS Machine Works.

Responsibility Settings — set user responsibilities.

Note
User settings are only relevant to your account, and do not affect other users in the system.

Account User Information — lists the user account that is currently logged in.

Sign Out — log out of AMS Machine Works.

Change Password — change your password.

15.1.2 Home ribbon
In the Asset Explorer utility, the home ribbon displays several default actions.

Table 15-1: Home ribbon options in Asset Explorer 

Action Description

Copy Copy the selected location or asset, along with its configuration, to the clipboard.

Cut Cut the selected location or asset, along with its configuration, and place it on the clipboard.

Paste Add the contents of the clipboard as a child of the currently selected location or asset.

Rename Specify a new name for the selected location or asset.

Delete Delete the selected location or asset.

New Asset Add a new machine, machine train, device placeholder, or generic asset as a child of the
currently selected location or asset.

New Location Add a new location folder as a child of the currently selected location.

Failure Effects Opens the Failure Effects selection menu.

Functions Opens the Functions selection menu.

Ignore Asset Ignore the selected asset or manage all ignored assets.

Ignore Location Ignore the selected location and all assets under it.

Edit When a machine is selected, this opens the Machine Configurator dialog, where you can edit
the configuration of the selected machine.

Status If you have a machine train or machine component selected, this launches the AMS Machine
Works Vibration Analyzer in context.

Configure Device Opens the Device Configuration dialog.
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Table 15-1: Home ribbon options in Asset Explorer (continued)

Action Description

Map Channels Opens the Map Channels dialog, where you can associate each channel on an asset source with
a particular measurement location on a machine.

Vibration Analyzer If you have a machine or device selected, this launches the AMS Machine Works Vibration
Analyzer.

Add Asset Source When in the Network navigator, this opens a dialog where you can connect to an asset source.

Note
This requires that the user has the MANAGEASSETSOURCE permission. This button is not
displayed if the user does not have this permission.

Remove Asset Source Available in the Network navigator. Allows you to disconnect asset sources from the system.

Note
This requires that the user has the MANAGEASSETSOURCE permission. This button is not
displayed if the user does not have this permission.

Remove Device Removes the selected device from the system.

15.1.3 Navigation bar
The back arrow moves to the last item selected in the navigator.

The forward arrow is only active if the back arrow has been clicked; it moves to the
item selected before the back arrow was clicked.

Moves up one level in the navigator.

Breadcrumbs The breadcrumb path shows the full path to your current location in the navigator. Go
to any level within the path by clicking its breadcrumb.

Search displays results for locations and assets. By default, it filters based on the level
selected in the navigator.

15.1.4 The Location navigator
The Location navigator lets you organize machines in the Asset Explorer utility in a way
that makes sense to you and your users. It also lets you view information about the
locations and machines you create, and perform operations within the context of a
selected location or machine.

The Location navigator is a logical representation of your site. Each location is represented
by a folder icon. You can expand and collapse locations.
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Figure 15-2: Asset Explorer Location navigator

Generally, the Location navigator is organized by Site → Location → Machine. The top
level in the Location navigator is called the Site. Sites contain locations and machines.
Rename the site to something specific or relevant to your plant setup.

Related information

Add locations to your site
Add assets to your site

15.1.5 The Network navigator
The Network navigator displays monitoring assets that have been added to the software.
The assets are organized by source, then by asset (device).
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Figure 15-3: Asset Explorer Network navigator

The hierarchy in the Network navigator lets you view all assets as they are arranged by
source. Assets in the Network navigator hierarchy cannot be moved.

The Network navigator is also where you can add additional asset sources to the software.

Related information

Add an Emerson Wireless Gateway to AMS Machine Works

15.1.6 The Library
The Library stores configured class instances so you can quickly add them into the Location
or Network navigators.
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Figure 15-4: Asset Explorer Library

15.2 Add locations to your site
Use locations to represent functional areas, floors, or sections of your site. You can nest
locations within locations. You can add asset locations and asset source locations to
locations. However, you cannot add locations to assets or asset source locations.

Procedure

1. In the Asset Explorer utility, select the Location tab, and highlight the site or a
location.

2. From the Home ribbon, click New Location.
A new location appears at the bottom of the navigator. It has a folder icon and is
named New Area. To rename, highlight New Area and, in the Home ribbon, click
Rename.

3. Create and name additional locations at the site level, and structure locations within
the locations to represent different places in your facility.

You can create an unlimited number of locations.

Postrequisites

Add assets and asset sources to your site.

Related information

Add assets to your site
Locations versus assets
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15.3 Add assets to your site
You can add assets at the site level, in locations, or in other assets. Organize the assets in
logical groups similar to how the assets are physically organized in your facility.

Procedure

1. In the Asset Explorer utility, click the Location tab.

2. Highlight the location where you want to add assets, or create a new location.

3. From the Home ribbon, select New Asset:

a) Select Asset (Generic) to create a new generic asset.

b) Select Device to create a new device.

c) Select Machine, then select from the available machine components to
create a machine train.

An asset or device labeled "New" appears below the location. If you added a
machine train, the name you assigned in the Machine Configurator dialog is
displayed.

4. Rename the asset or device to something relevant or appropriate to your plant
setup.

Related information

Add locations to your site
Locations versus assets

15.4 Locations versus assets
Locations and generic assets can contain machines and devices or other generic assets,
but in certain situations, it makes sense to use one instead of the other. You can create
several types of locations and organize them in the Location navigator. All locations have
basic properties, and each additional type of location has additional properties specific to
its type and are represented in the Location navigator with unique icons.

An area is a location represented by a folder. It has the most basic properties of a location,
such as a name and links to the other locations beneath it. It does not have a health score,
because it is not an asset.

An asset location is a type of location represented by its own icon, and can contain other
locations, assets, or devices. An asset location has properties common to all assets, such
as a health score.

A device is a type of location that represents a monitoring device. Specific types of devices
have their own properties and icons. For example, the AMS 9420 Wireless Vibration
Transmitter is represented by a transmitter icon.

A machine is a type of asset location defined by AMS Machine Works. A machine has
specific properties defined for collecting specific measurements such as PeakVue,
vibration, and temperature. This data is analyzed and used to diagnose problems and
schedule maintenance based on an equipment condition, before a failure actually occurs.
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Table 15-2: Assets vs. locations

Property Assets Locations

Asset health score Every asset has a health score,
including generic assets, for which a
health score is calculated by a (user-
defined) method that considers all its
child assets.

Locations have health scores based
on child locations and child assets.

Contents Generic assets can contain any number
of machines or asset sources, but
cannot contain a location.

Locations can contain any number of
child locations, allowing you to
organize your Location navigator in
any way that makes sense to you.

Filtering You can apply filter preferences to
assets so they are easier to find with
the search function.

You cannot apply filter preferences to
locations.

Customization You can customize assets to display
specific icons and images.

The icon for a location is always a
folder.

Related information

Add locations to your site
Add assets to your site

15.5 Map asset source channels to measurement
points
In AMS Machine Works, channels have to be mapped to measurement locations on a
machine to which a sensor is mounted. Mapping assigns the sensor channel of the device
that is monitoring the asset to a measurement point on the asset.

Note
Mapping is also part of the Add a Machine Train to your site process. See Add a Machine
Train to your site. The Map asset source channels to measurement points procedure is just a
way to go back and make edits to mappings without going through the entire Add a
Machine Train process.

Procedure

1. In the Asset Explorer utility, highlight a machine or machine train in the Location
navigator.

2. From the Home ribbon, select Map Channels.

3. In the Map Channels dialog, select channels and measurement locations:

a) Click Add Device.

b) In the Add Device dialog, select a device and click OK. Use the Device Type
selection list as a filter to show only the desired type of device.

Note
If the device you want to add does not show in the Add Device dialog, it may
be because the device has not been discovered by AMS Machine Works.
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Depending on the size and quality of your wireless network, AMS Machine
Works device discovery can take from several minutes to several hours.
Please wait and try adding the device again. A device has completed the AMS
Machine Works discovery when additional parameters from AMS Machine
Works are visible on the Latest values tab in Asset Explorer.

c) In the Network Devices tree, highlight the channel that you want to map to a
measurement location.

d) Either drag and drop the channel to the Acquisition Channel field next to the
desired measurement location, or simply highlight the channel and then click
in an Acquisition Channel field to map it.

Note
The channel must be configured to match the signal type of the
measurement location you want to map to. Otherwise, the Map button does
not appear in the Actions column. Mapping a CML value requires adding a
custom measurement location.

e) Click OK.

Related information

Unbind an asset source location from a device on the network

15.6 Set the asset priority
The priority you assign to an asset affects the health calculation for that asset. By default,
all assets and equipment are assigned a priority of Low.

Note
The priority setting only affects the Weighted Average method.

Prerequisites

Launch the Asset Explorer utility.

Procedure

1. In the Location navigator, select the asset with priority you want to set.

2. On the Details pane Properties tab, click the Priority drop-down menu, and select
an asset priority.

You can select from Not Set, Low, Medium, High, or Very High.

15.7 Ignore an asset or location
Ignore an asset or location when you want to disregard messages and health for that asset
or location for a specific period of time. When you ignore a location, all assets under that
location are also ignored.

Ignore is a global setting across all users and the system. An ignored asset or location only
affects messages and health-related functionality. You still see the health score for an
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ignored asset or location, but it is grayed out and labeled as Ignored. An ignored asset or
location does not contribute to the health calculation.

Prerequisites

Launch the Asset Explorer utility.

Procedure

1. Select an asset or Location, and from the Home ribbon, click Ignore Asset or Ignore
Location.
The Ignore Asset or Ignore Location dialog appears.

2. In the Duration area, specify how long to ignore the asset or location:
• Select Indefinite to ignore the specified asset or location until a user removes

the Ignore status in the Ignored Asset Management dialog.

• Select Specific Date and specify a start and end date to ignore the asset or
location.

• Select Plant Calendar to ignore the specified asset according to range set by a
Plant Calendar entry.
Use the drop-down menu to select from existing Plant Calendar entries. Click
Create New Event to create a Plant Calendar entry to associate with this ignored
asset or location.

 CAUTION

When you ignore a parent asset, all child assets are also ignored.

3. Click OK to save your changes.

15.8 Applying labels: failure effects, functions, and
interfaces
Filter preferences are labels for categorizing system elements to allow grouping and
filtering when using the Search feature.

In the Asset Explorer utility, you can label any asset with one or more of the following
labels:

Failure
Effects

Failure Effects identify and organize assets according to the effects they
cause if there is an equipment failure. For example, you can label a
Machine type Fan with Environmental Control if the purpose of the fan is
to provide cooling to a production environment.

Functions Functions describe the functionality of the asset. For example, for AMS
9420 Wireless Vibration Transmitters, you can apply the Functions
Vibration, Temperature, and Analytical.

Interfaces Interfaces describe how the asset sends and receives information on the
network. Examples include HART and Ethernet.
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Apply labels in the Library navigator

When you add a new asset to the Location navigator, it is created based on the definition
in the Library. When you apply a label to a class in the Library navigator, it becomes a
default.

The General Information for the Location class, by default, has a blank Description and
Priority of Not Set. If all of your locations are Priority Medium or higher, you can set the
default Priority to Medium.

If your site contains many AMS 9420 Wireless Transmitters, you can apply the Functions,
Vibration and Analytical to Asset → Device → Transmitter → CSI → CSI9420.

Apply labels in the Location navigator

After you add a new device to an asset, location, or machine in the Location navigator, you
can update the device's information to describe the specific purpose and effects for this
particular application of the device.

For example, after adding an AMS 9420 that is monitoring temperature, you can apply the
function Temperature. From the Location or Network navigator, right click an asset and
select from one of the label menus.

View all labels applied to individual assets

To see what labels are applied to an asset, select the asset in the navigator. The details
pane displays the labels under Properties  → General Information.

View all assets with a specific label (Search)

You can refine your search results using labels. Begin your search in the navigation bar by
clicking in the search box. You can choose the label type (such as Failure Effects) and one
or more of the labels from the Search ribbon. You can also choose the label type and show
assets that have any label of that type (Any Failure Effects) or no label of this type (No
Failure Effects).

Or, you can begin typing all or part of the name of a label. For example, type the letter E
and "Failure Effects and Interfaces" appear as choices in the predictive search box. Select
one of the options, and a new list appears with the labels. Choose one or more labels.

15.8.1 View and apply labels
Labels help filter the search results thus making search more efficient.

The following are ways to apply labels in the Asset Explorer utility:

Procedure

• Right click an asset in the Location or Network navigator and select from one of the
label menus.

• Highlight an asset in the Location or Network navigator and select a label menu from
the Home ribbon.

• Highlight an asset in the Location or Network navigator and, in the asset's details pane,
below General Information, select the text area beside the label to edit that property.
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The text area becomes a menu and you can select one or more labels from the drop-
down menu.

15.8.2 Manage Failure Effects
You can define or modify Failure Effects in the Library navigator.

Procedure

1. In the Asset Explorer utility, select the Library tab.

2. Right-click Failure Effects and select Manage Failure Effects.
• Click New to create a new Failure Effect.

Note
You can assign up to 25 differently-colored labels.

• Select a Failure Effect and click Rename to change the name an existing Failure
Effect.

• Select a Failure Effect and click Delete to remove the Failure Effect from the list.

3. Click OK to save your changes.
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16 Event Viewer utility
The Event Viewer utility allows you to view system-generated events. You can choose to
display events per module or view all events logged by the system.

The following modules log events:

• Device Configuration—events relating to configuration of connected devices, such as
device discovery errors.

• Asset Explorer—events and configurations in the Asset Explorer utility, such as adding,
editing, and deleting assets and locations, asset binding, and all asset health changes.

• Data Highway—all events occurring in the Data Highway, such as parameter
registration and unregistration.

• Machine Configuration—all machine configurations, such as adding, editing, and
deleting components, bearings, collections, measurement definitions, alarm limits,
and channel mappings.

• User Manager—all events in the User Manager utility, such as adding, editing, and
deleting users and logging in and logging out users.

• AMS Machine Works Vibration Analyzer—all events in the AMS Machine Works
Vibration Analyzer, such as adding, editing, and deleting plot labels and machine
notes, RPM changes, machine health train changes, and alarms.

Events are displayed with the following details:

• Date and Time—date and time the event was recorded.

• Event Type—the type of event to which the interface responds.

• Source—the module associated with the event.

• Asset—the asset associated with the event.

• Attachments—the attachment associated with the event. Events with attachments
have a paper clip icon.

Note
The database in a Tier-1 installation (Limited Storage), Microsoft SQL Server 2017 Express,
has a size limit of 10 GB. If the databases reach this size limit, the software will no longer be
able to store new events.

Related information

View events

16.1 View events
Only system-generated events can be viewed in the Event Viewer utility.

Prerequisites

Launch the Event Viewer utility.
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Procedure

1. On the left pane, select to view events by Application or by Modules:
• Click Application to view all events logged by the system.

• Expand the Modules folder and click on a module to view events recorded for
the specific module.

2. Select an event from the list.

Details display in the bottom pane. If an event has an attachment, a thumbnail of
the attachment is displayed.

16.2 Archive events
Events stored in Plantweb Optics are archived periodically. Archived events are deleted
from the database and stored in an archive file.

By default, events that are older than 180 days are archived. Event archiving automatically
happens every 30 days. You can retrieve archived files in C:\EMERSONCSI\DATA
\Backups\Events. Archive files are in .csv format with the text OpticsEventsArchive
appended in the file name.

Note
Archived events cannot be imported and viewed in the software.
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17 Settings available from Asset Explorer
and User Manager

17.1 User settings
User settings are only relevant to your account, and do not affect other users in the
system. From either the Asset Explorer or User Manager utilities, click File → User Settings
to view or customize settings specific to your user account.

You can specify settings for the following:

• Message subscriptions

• Junked assets

• User class responsibilities and other responsibility types

17.1.1 Edit class responsibilities for your account
Classes define how elements such as assets and asset sources are structured in the system.
Class responsibilities allow you to choose what to show in the Asset Explorer utility's
Location and Network navigator tabs for your user account. You can choose to show assets
and assets sources and narrow them down to their specific types such as asset source,
machines, types of machines, devices, types of devices, device manufacturers, and device
name.

Prerequisites

Launch the Asset Explorer utility.

Procedure

1. Click File → User Settings → Responsibility Settings.

2. In the Class Responsibilities tab, uncheck the classes that you do not want displayed
in Asset Explorer for your user account.

All classes are checked by default.

Note
Newly added assets and asset sources may still display even when the classes are
unchecked. They will update once the system is restarted.

The following class responsibilities are available for AMS Machine Works:

Asset These selections control the machine types you can see in the
Locations tab of Asset Explorer.Asset is a generic type of machine
types you create by selecting Add Asset -> Generic, and visible with
this selection.

Machine These selections control the machine types you can see in the
Locations tab of Asset Explorer. The list consists of each type of
machine registered in the system. Examples include Motor, Pump,
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Fan, and Compressor. If you unselect these, your user will not see
them in the hierarchy.

Device These selections control the devices you can see in the Locations tab
of Asset Explorer. The Analyzer and CSI Analyzer selections are
reserved for future use.

AMS
Machine
Works
Asset

These selections control what you can see in the Locations tab of
Asset Explorer.

Online

• Select OMHM to see Ovation Machinery Health Module devices.

• Select ATG to see AMS 6500 ATG systems.

AMS Machine Works Wireless

• Select 9420 to see the AMS 9420 Wireless Transmitter devices.

• Select 9530 to see the AMS Wireless Vibration Monitor devices.

• Select Asset Monitor to see the AMS Asset Monitor devices

• Select Generic to see the generic devices.

Asset
Source

These selections control what you can see in the Network tab of
Asset Explorer.

ATG Asset Source

AMS Machine Works Asset Source

• OMHM Asse tSource

• Wireless Interface

• DeltaV Interface

• ATG Asset Source

• Asset Monitor Source

3. Click OK.

4. Click OK on the subsequent dialogs to restart the system.

17.1.2 Disable user responsibility for assets and devices tagged
with labels
Assets and devices can be assigned labels, such as Failure Effects, Functions, and
Interfaces. You can choose which assets and devices that have been assigned labels are to
be shown in the Asset Explorer utility's Location and Network navigator tabs for your user
account.

Prerequisites

Launch the Asset Explorer utility.

Procedure

1. Click File → User Settings → Responsibility Settings.

Online Help Settings available from Asset Explorer and User Manager
July 2022

AMS Machine Works v1.7 185



2. Select the Additional Responsibilities tab.

3. Select a responsibility type on the left pane.
• Failure Effects—Labels that identify and organize assets according to the effects

they cause if there is an equipment failure.

• Functions—Labels that describe the functionality of an asset.

• Interfaces—Labels that describe how the asset sends and receives information
on the network.

4. On the right pane, select the Disable Responsibilities check box and select from the
available Failure Effects, Functions, and Interfaces labels check boxes.
Devices and assets tagged with the selected Failure Effects, Functions, and
Interfaces labels will not show in the Asset Explorer utility's Location and Network
navigator tabs for your user account.

5. Click OK.

6. Click OK on the subsequent dialogs to restart the system.

17.2 System settings
System settings are global and affect all items and users across AMS Machine Works.
These settings are available for all user accounts and changes will affect all other users in
the system.

 CAUTION

Use caution when editing system settings. Contact your AMS Machine Works
administrator prior to changing system settings.

Note
These settings may only be changed if the user has the MANAGESYSTEMSETTINGS
permission.

To set the system settings, click File → System Settings from either the Asset Explorer or
User Manager utility.

You can specify system settings for the following, depending on the responsibilities
assigned by your AMS Machine Works administrator:

• Health settings

• Ignored assets

• Plant Calendar

• Spam

Note
Specifying Ignored assets, Plant Calendar, and Spam will have no effect. This option is not
used in AMS Machine Works.
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17.2.1 Set the health calculation method
The software calculates the health of each asset in the system and displays it as a
numerical rating. Each extension that interacts with a given asset assigns it a health score
between 0–100, where 0 is completely unhealthy, and 100 is completely healthy. The
software calculates an overall asset health score based on the entries set by all sources.

The health calculation method you choose allows you to set how the system weighs the
combined health scores of your assets.

Prerequisites

Launch the Asset Explorer utility.

Procedure

1. Select File → System Settings → Health Settings.

2. In the Health Settings dialog left pane, choose Settings.

3. Choose the Health Calculation Method from the drop-down menu.

Item Description

Weighted Average Health calculation based on the average of individually-
weighted health scores of an asset and its children.

Average Health calculation based on the average of the equally
weighted individual health scores of an asset and its
children.

Worst Health calculation based on the worst health score of the
individual health score of an asset and its children.
This is the default setting.

4. Click OK.

17.2.2 Set the priority of health opinions from interfaces or
asset extensions
Interfaces and asset extensions have health opinions that are given priority values. The
assigned priority affects the weight of the health opinion in the health calculation
methods. The priority represents the importance of the health opinion from the interface
or asset extension with respect to other interfaces and asset extensions in the system. The
software also uses the health score to derive an asset's status.

Note
The priority setting only affects the Weighted Average method.

Prerequisites

Launch the Asset Explorer utility.

Procedure

1. Select File → System Settings → Health Settings.
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2. In the Health Settings dialog left pane, select the interface or asset extension for
which you want to set a priority.

3. From the drop-down menu, select the priority.

Priority Weight

Does Not Contribute 0

Low 0.25

Medium 0.5

High 0.75

Very High (default) 1.0

4. Click OK.
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18 User Manager
The User Manager function varies for administrators (those users with MANAGEUSER
permission) and users. From User Manager, administrators can add users to the system, as
well as edit properties, responsibilities, and settings for all currently registered users. For
users without administrator permissions, User Manager displays read-only information
about user properties and responsibilities.

Note
Administrators are users that have been given a MANAGEUSER permission in User
Manager.

Note
Options may not be available in your user account and may only be available for
administrator accounts. Some features may be visible in the user interface but have no
function. For example, tokens are not used by AMS Machine Works.

18.1 User Manager utility user interface

18.1.1 Add a new user
Prerequisites

• Log in to AMS Machine Works as an Administrator.

• Launch User Manager.

• Click the LICENSES tab to confirm there is an available user license.

Procedure

1. Click the USERS tab at the bottom left side of the screen.

2. In the HOME ribbon, click New User.

3. Enter the new user account details:

Field Description

Username The username to access the software. The username must be unique
to the system. Spaces are not allowed.

Email address A valid email address to contact the user. The user receives
notification emails and messages at this address, based on the user's
subscription settings.

First Name The user's first name.

Last Name The user's last name.
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Field Description

Password Password for the user when logging in to the software for the first
time.

Note
The password must meet the complexity set in SETTINGS → Password
Settings.

Confirm Password Enter the password again to ensure that it was entered correctly.

User must change
password on next
logon

Check this checkbox if you want the user to create a new password
when the user logs in for the first time.

Account is
disabled

Check this checkbox if you want to set up the new user now, but want
the user account to remain disabled until a later time.

4. Click OK. The new user is added to the USERS list. You can then assign
responsibilities and locations, and issue mobile tokens for the user.

18.1.2 Delete a user
Prerequisites

• Log in to AMS Machine Works as an Administrator.

• Launch User Manager.

Procedure

1. Click the USERS tab at the bottom left side of the screen.

2. In the user hierarchy on the left side of the screen, select the user to be deleted.

3. In the ribbon, click the Delete User button. The user is deleted.

18.1.3 Change a user's name
Prerequisites

• Log in to AMS Machine Works as an Administrator.

• Launch User Manager.

Procedure

1. Click the USERS tab at the bottom left side of the screen.

2. In the user hierarchy on the left side of the screen, select the user to be deleted.

3. Click Edit next to the user's name on the right side of the screen.
A dialog displays that allows you to edit the user's first and last name.

18.1.4 Disable a user account
A disabled user account cannot login and cannot receive notifications or messages.
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Prerequisites

• Log in to AMS Machine Works as an Administrator.

• Launch User Manager.

Procedure

1. Click the USERS tab at the bottom left side of the screen.

2. In the user hierarchy on the left side of the screen, select the user to be disabled.

3. In the ribbon, click the Disable User button. The user is disabled.

18.1.5 Lock a user account
A locked-out user receives notifications and email messages, but is unable to log in. If
Lockout Settings are enabled, an account can also become locked after a specified number
of failed login attempts.

Prerequisites

• Log in to AMS Machine Works as an Administrator.

• Launch User Manager.

Procedure

1. Click the USERS tab at the bottom left side of the screen.

2. In the user hierarchy on the left side of the screen, select the user to be disabled.

3. In the ribbon, click the Lock User button.
The user account is locked.

18.1.6 Force a user to log out
You can force a user to log out at any time.

Prerequisites

• Log in to AMS Machine Works as an Administrator.

• Launch User Manager.

Procedure

1. Click the USERS tab at the bottom left side of the screen.

2. In the user hierarchy on the left side of the screen, select the user to be logged out.

3. In the ribbon, click the Force Logout button.
The user is logged out after a slight delay. The user is then required to log in again.

18.1.7 Edit user login information
Use the Edit Logins button to change the OpenID Connect Provider and the Claim Value
for a user.

Prerequisites

• Log in to AMS Machine Works as an Administrator.
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• Launch User Manager.

Procedure

1. Click the USERS tab at the bottom left side of the screen.

2. In the user hierarchy on the left side of the screen, select the user whose
information requires editing.

3. In the ribbon, click the Edit Logins button.

4. On the Edit Logins screen, in the OpenID Connect Provider field, select the OpenID
Connect Provider that was created during configuration. For the Claim Value, enter
the claim value provided by the OpenID Connect provider.

5. Click OK.
The user's login information is updated.

18.1.8 Reset a user password
Prerequisites

• Log in to AMS Machine Works as an Administrator.

Note
Administrator privileges are not required to reset your own password, but they are
required to reset other users' passwords.

• Launch User Manager.

Procedure

1. Click the USERS tab at the bottom left side of the screen.

2. In the user hierarchy on the left side of the screen, select the user requiring a
password reset.

3. In the ribbon, click the Reset Password button.
An email is sent to the user with instructions for resetting the user's password.

18.1.9 Refresh the users list
After making changes to user information, it can be helpful to refresh the user list with
updated information.

Prerequisites

• Log in to AMS Machine Works as an Administrator.

• Launch User Manager.

Procedure

1. Click the USERS tab at the bottom left side of the screen.

2. In the user hierarchy on the left side of the screen, select All Users.

3. In the ribbon, click the Refresh Users button. All user information is updated.
All user information is updated.
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18.1.10 Export the users list to a .csv file
The users list .csv file contains information about all users.

Prerequisites

• Log in to AMS Machine Works as an Administrator.

• Launch User Manager.

Procedure

1. Click the USERS tab at the bottom left side of the screen.

2. In the ribbon, click the Export to CSV button on the ribbon to download and open
a .csv file in Excel.

18.1.11 Assign permissions and locations to a user
User Manager provides a way to make changes to a user's permissions and the locations
the user can view in AMS Machine Works.

Prerequisites

• Log in to AMS Machine Works as an Administrator.

• Launch User Manager.

Procedure

1. Click the USERS tab at the bottom left side of the screen.

2. In the user hierarchy on the left side of the screen, select the user requiring a
permissions change.

3. On the right side of the screen, select the RESPONSIBILITIES tab.

4. Click Edit Permissions.
The Edit Permissions screen displays.

5. Click the Enabled checkbox next to the permission you want to provide to this user.
Descriptions of each permission are provided on the screen. There are five different
permissions that can be selected.

a) MANAGEUSER. This permission provides the user with administrator
privileges. Specifically, it allows the user to perform the following actions in
User Manager: manage users; manage templates; manage user, password,
lockout, and OIDC settings.

b) HISTORIZEASSET. This option is not used in AMS Machine Works.

c) CREATEWORKNOTIFICATION. This option is not used in AMS Machine
Works.

d) MANAGEASSETSOURCE. This permission enables the user to add and remove
asset sources in Asset Explorer under the Network tab. Users that do not
have this permission do not see the Add Asset Source button (or similar
buttons) in the ribbon.
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6. Click OK.

7. Click Edit Locations.
The Edit Locations screen displays.

8. Select the checkboxes for the locations the user can view in Asset Explorer.

9. Click OK.

Permissions and locations are assigned.

18.1.12 Create a user template
User Manager allows you to create a template to use when setting up new users.

Prerequisites

• Log in to AMS Machine Works as an Administrator.

• Launch User Manager.

Procedure

1. Click the TEMPLATES tab at the bottom left side of the screen.

2. In the templates hierarchy on the left side of the screen, select the folder where this
new template will be placed.

3. In the ribbon, click the New Template button. The New Template screen displays.

4. In the Name field, enter a name for this template.

5. Click the Enabled checkboxes for each permission to assign to the users created
with this template.

6. Click the locations checkboxes for each location the users will be able to view in
Asset Explorer.

7. Click OK.
The new template is created and shown in the folder selected.

18.1.13 Apply a user template
You can apply a template to users once they have been created. Please note that any
future changes made to the template do not automatically apply to the user's information
that was created using this template. The updated template would have to be applied to
the users again.

Prerequisites

• Log in to AMS Machine Works as an Administrator.

• Launch User Manager.

Procedure

1. Click the TEMPLATES tab at the bottom left side of the screen.

2. In the templates hierarchy on the left side of the screen, navigate to and select the
template you want to use.

3. In the ribbon, click the Apply Template button.
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The Apply Template screen displays.

4. Click the checkboxes next to the names of the users to which you want to apply this
template's settings.

5. Click OK.
The selected users now have the permissions and locations settings specified in the
template.

18.1.14 Delete a user template
Prerequisites

• Log in to AMS Machine Works as an Administrator.

• Launch User Manager.

Procedure

1. Click the TEMPLATES tab at the bottom left side of the screen.

2. In the templates hierarchy on the left side of the screen, navigate to and select the
template you want to delete.

3. In the ribbon, click the Delete Template button.
The selected template is deleted.

18.1.15 Register licenses
You can view the status of and register licenses from User Manager. The license applies to
the entire enterprise. It does not apply to a specific user.

Note
To complete this task, you must have MANAGESYSTEMSETTINGS permission.

Prerequisites

• Log in to AMS Machine Works as an Administrator.

• Launch User Manager.

Procedure

1. Click the LICENSES tab at the bottom left side of the screen.

2. On the screen, the following information displays:

a) Status: The status information indicates if the current license is GOOD, FAIR,
or POOR. A GOOD license is not in any danger of running out. A FAIR license
is getting close to running out. A POOR license is currently running out or is
about to expire.

b) Source: The source information shows the product for which the license is
assigned.

c) Feature: The feature information shows the part of the product to which this
license applies.
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d) Expires: The expiration date information shows when the current license is
set to expire.

3. Select the license to register from the list. Click the Register License button from
the ribbon.

4. Click Choose File and browse to the license file for this feature on your PC. Typically,
license files are emailed to the customer and stored in a folder of their choosing.
You may need to email or call an Emerson representative to update your license.
Follow the instructions on the screen.

5. Click OK.
You will receive email notification that the license has been registered.

18.1.16 Request a license proposal
You can request a proposal for a license from Emerson directly from User Manager.

Prerequisites

• Log in to AMS Machine Works as an Administrator.

• Launch User Manager.

Procedure

1. Click the LICENSES tab at the bottom left side of the screen.

2. Click the Request Proposal button from the ribbon.

3. Click Copy to copy the machine fingerprint needed for the proposal. Email Emerson
requesting a proposal and include the machine fingerprint. Follow the instructions
on the screen.

4. Click OK.
You will receive an email response from Emerson.

18.1.17 View Guardian information
The Guardian Info feature is used to collect information about the server that can be
exported to a file and emailed to an Emerson Guardian employee for help with issues the
user may be having. It is a tool used for customer support.

Prerequisites

• Log in to AMS Machine Works as an Administrator.

• Launch User Manager.

Procedure

1. Click the LICENSES tab at the bottom left side of the screen.

2. Select the license for the proposal from the list. Click the Guardian Info button from
the ribbon.
The Guardian Information screen displays.

3. Click Export to export the Guardian information to a .epm file.
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18.1.18 Change user settings
Prerequisites

• Log in to AMS Machine Works as an Administrator.

• Launch User Manager.

Procedure

1. Click the SETTINGS tab at the top left side of the screen.

2. Click the User Settings button from the ribbon.
The User Settings screen displays.

3. Click the Require Unique Email checkbox to prevent a single email address from
having multiple accounts.

4. Click the Allow Only Alphanumeric User Names checkbox to prevent users from
adding special characters to their user names.

5. Click OK to make these changes.

18.1.19 Change password settings
Prerequisites

• Log in to AMS Machine Works as an Administrator.

• Launch User Manager.

Procedure

1. Click the SETTINGS tab at the top left side of the screen.

2. Click the Password Settings button from the ribbon.
The Password Settings screen displays.

3. In the Required minimum length field, enter a minimum length for user
passwords.

4. Click the Require special character checkbox to require users to include at least
one allowed special character in their passwords.

The following special characters are allowed:

Space; \ / | " * : < > ? , . ; ' " [ ] { } - _ = + ∼`

5. Click the Require lowercase checkbox to require users to include at least one
lowercase letter in their passwords.

6. Click the Require uppercase checkbox to require users to include at least one
uppercase letter in their passwords.

7. Click the Require digit checkbox to require users to include at least one numeric
character in their passwords.

8. Click OK to make these changes.
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18.1.20 Change lockout settings
These settings control the Lock User functions on the User Manager HOME tab.

Note
These changes are not applied until the user restarts the software.

Prerequisites

• Log in to AMS Machine Works as an Administrator.

• Launch User Manager.

Procedure

1. Click the SETTINGS tab at the top left side of the screen.

2. Click the Lockout Settings button from the ribbon.
The Lockout Settings screen displays.

3. Click the Enabled checkbox to enable lockout settings.

4. In the Lockout Time (in minutes) field, enter the amount of time, in minutes, that a
user is prevented from attempting to log in after the account is locked.

5. In the Max Failed Access Attempts field, enter the number of times a user can
incorrectly enter his login credentials before the account is locked.

6. Click OK to make these changes.

18.1.21 Change OIDC settings
The OpenID Connect settings control which options appear in the login page under the
section . These external accounts allow you to log in to AMS Machine Works using your
credentials from another source—for example, from your Google account, or your
Microsoft account, or your Active Directory account. As long as these external providers
implement OpenID Connect, a standard protocol for sharing authentication information
between Web Services, they can be used to link a user in AMS Machine Works External
Account

The OpenID Connect settings are different depending on which OpenID Connect provider
you are using.

Note
These changes are not applied until the user restarts the system.

Prerequisites

• Log in to AMS Machine Works as an Administrator.

• Launch User Manager.

Procedure

1. Click the SETTINGS External tab at the top left side of the screen.

2. Click the OIDC Settings button from the ribbon.
The OpenID Connect Settings screen displays.
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3. On the left side of the screen, select the display name whose settings you want to
change. For example, AFDS.

4. In the Claim Type field, if you are using Active Directory/ADFS, then enter http://
schemas.xmlsoap.org/we/2005/05/identify/claims/upn. If you are using a
different provider, enter the claim type information specific to that provider. The
Claim Type field defines which claim is used to link the user in the Edit Logins
dialog.

5. In the Display Name field, enter the user defined display name. For example, ADFS.

6. In the Scheme Name field, enter the user defined scheme name. For example, adfs.
The Scheme Name must be unique and cannot be the same name as another
OpenID Connect Provider in the software.

7. In the Authority field, use this format for this field, if you are using Active Directory/
ADFS, then enter https://<YOUR ACTIVE DIRECTORY SERVER>/adfs/. If you are
using a different provider, enter the URL specific to that provider in the format of
https://<AUTHORITY>/.well-known/openid-configuration. For example, https://
accounts.google.com/.well-known/openid-configuration.

8. Enter the Callback path specific to the provider you are using.

9. Enter the Client ID specific to the provider you are using.

10. If the provider requires a client secret, check the Enable Client Secret checkbox and
enter the secret in the Client Secret field.

11. Click Add an OIDC Provider to add a provider to the software.

12. Click Delete this OIDC Provider to remove this provider from the software.
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19 OPC UA Server

19.1 Connect to OPC server
Follow these instructions to run the OPC Client (UaExpert) system and connect to the OPC
Server.

Procedure

1. From your Desktop, run the UAExpert OPC Client.

2. Add the OPC Server by clicking on the + sign.

3. Click on <Double click to Add Server>.

4. Before clicking OK, choose if you prefer to connect via username and password or
by providing the OPC UA Client's Certificate. See Connect an OPC UA client. Click
OK.

5. Using the Server Hierarchy (on the left side of the screen), right-click on AMS
Machine Works and click Connect.

19.2 Connect an OPC UA client
Building the plant hierarchy can take several minutes after installing the software and after
rebooting the computer. Allow several minutes after installing or rebooting before
attempting to connect OPC UA clients to the OPC UA Server.

The OPC UA Server has security features that protect your connection and your data. You
may configure these settings after installation and setup.

Prerequisites

• Click the LICENSES tab in User Manager to confirm the OPC UA Server license is enabled

• The OPC UA client certificate must be a trusted certificate of the OPC UA server (AMS
Machine Works server)

Procedure

1. From your OPC UA Client, supply the connection information of the OPC UA server.
The OPC UA URL is opc.tcp://[server]:4840, where [server] is the computer name of
the OPC UA server (AMS Machine Works server).

2. Security Settings—From your OPC UA client, select the security policy and message
security mode that applies to your network. The OPC UA server supports these
security settings:

a) Security Policy

• Basic128Rsa15

• Basic256

• Basic256Sha256
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b) Message Security Mode

• Sign

• Sign and Encrypt

3. Authentication Settings—An OPC UA client may be able to connect to the OPC UA
server via a predetermined username and password, or through certificate
validation. To enable an OPC UA client to connect to the server via username and
password, an Administrator must add the user to the Plantweb Optics OPC UA Users
Windows Group.

19.3 Publish data through OPC UA
Anything that can be represented as a scalar value can be published through OPC UA. This
means that waveforms and spectra cannot be published through OPC UA, however,
derived measurements attached to waveforms and spectra can.

A good visual aide for determining the type of data that can be published trough OPC UA is
the right side pane of a selected machine or device in the Asset Explorer. Any information
contained within that area can be published through OPC UA using the UAExpert client.

Figure 19-1: A highlighted area containing all types of information that can be
published through OPC UA

Information from both the Latest Values and Properties tabs can be published through
OPC UA, as well as the machine/device Health.
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Figure 19-2: Latest Values of an AMS 9530 visible in Asset Explorer

Figure 19-3: Properties of the same AMS 9530 visible in Asset Explorer
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Figure 19-4: Data from both previous figures highlighted within UAExpert
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20 AMS Machine Works Limits
Table 20-1: AMS Machine Works Limits

Item Name Limit Units

Asset Explorer

1 New Asset (Name) 60 characters

2 Name (ATG Name) 60 characters

4 Modbus Port Number 65535 -

5 AMS 6500 ATG
Configuration Port Number

65535 -

6 New Device (Name) 60 characters

8 Asset Generic 500 count

9 Locations 1,000 count

10 Machine Trains 500 count

11 AMS 6500 ATGs 25 count

12 AMS 9420s 400 count

13 Emerson Wireless Gateway 20 count

Device Configuration

14 Measurement Points 2,000 count

15 Collections per AMS 6500
ATG

25 count

16 Measurements per collection 2,000 count

Machine Configuration

Machine Train Details

20 Machine Train Components 3 components

21 Speed 120,000 RPM

22 Machine Train Name 60 characters

23 Machine Train Description 125 characters

24 Machine Train Component
Name

60 characters

25 Machine Train Component
Description

125 characters

Motor

26 Manufacturer 60 characters

27 Model 60 characters

28 Speed (RPM) 120,000 RPM

AMS Machine Works Limits Online Help
July 2022

204 AMS Machine Works v1.7



Table 20-1: AMS Machine Works Limits (continued)

Item Name Limit Units

29 Power 50,000 HP

30 Number of Poles 48

31 Number of Rotor Bars 500

32 Number of Stator Slots 501

33 Frame Size NaN -N

34 Rated Volts 20,000 Volts

35 Full Load Current 1,000 Amps

36 Rated RPM 120,000 RPM

Motor Parts
(similar to turbine parts, blower, centrifuge, compressor, generator, Generic, Spindle)

37 Shaft Name 60 characters

38 Bearing 9 -

Coupling

39 Coupling Name 60 characters

40 Coupling Description 255 characters

Gearbox

41 Gearbox Name 60 characters

42 Gearbox Description 255 characters

43 Manufacturer 60 characters

44 Model 60 characters

45 Gearbox Ratio 100 -

47 Shaft 3 -

48 Gearbox Parts - Shaft Name 60 characters

49 Gearbox Parts - Gear Name 60 characters

50 Gearbox Parts - Number of
Teeth

2,000 -

51 Number of Gears per shaft 2 -

52 Number of Bearings per
shaft

2 per shaft -

Pump

53 Pump Information - Number
of Inlet Pump Vanes

100 -

54 Pump Information - Number
of Outlet Pump Vanes

100 -

55 Pump Stages 20 -
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Table 20-1: AMS Machine Works Limits (continued)

Item Name Limit Units

56 Number of Vanes 100 -

57 Number of Bearings per
Pump

9 -

Fan

58 Fan - Number of Primary Fan
Blades

100 -

59 Fan - Number of Secondary
Fan Blades

100 -

60 Fan Stages 20 -

61 Fan Number of Blades 100 -

62 Number of Bearings per Fan
Shaft

9 -

Machine Configuration

Combined Measurement Location Properties

69 Sensor Angle 360 Degrees

70 Tach. Angle 360 Degrees

71 Resting Voltage 24 Volts

72 Bearing Clearance 1000 Um microns

74 Tach name 60 characters

Misc

75 Point ID 30 characters

76 Point ID Description 60 characters

Machine Journal

General

77 Cases per system 5,000 count

78 Cases (Open) per machine
component

50 count

79 Cases (Resolved) per
machine component

50 count

80 Cases (Open + Resolved) per
machine component

100 count

81 Posts/Replies per system 500,000 count

82 Posts/Replies per case 100 count

83 Replies per post NA count

84 Post text size 102,400 characters

85 Case text size 64 characters
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Table 20-1: AMS Machine Works Limits (continued)

Item Name Limit Units

86 Attachments per post 64 count

87 Attachment (Single image)
size

15 MB

88 Attachment (Single other)
size

50 MB

89 Attachment filename length 256 characters

90 Attachment link length 1,024 characters

91 Attachment description
length

256 characters

92 Tag text size 64 characters

93 Tags per post 50 count

94 Mentioned users per post 20 count

95 Number of severities 100 count

96 Number of urgencies 100 count

97 Severity text size 64 characters

98 Urgency Text Size 64 characters

99 Number values of severities 100 value

100 Number values of urgencies 100 value

101 Attachment size per
download

1 GB GB

102 Work recommendations per
post

64 count

103 Work recommendations per
system

480,000 count

104 Posts per report 200 count

105 Work recommendation
subject length

256 characters

106 Work recommendation
description length

500 characters

107 Work recommendation
comment length

256 characters

Vibration Analyzer

108 Concurrent Users 5

109 Maximum nested hierarchy
levels supported

6
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Glossary

active message
A message that has not been read by the user or has been previously read by the user and
not dismissed.

alert state
A user-defined categorization of the health of an asset. For WirelessHART devices (such as
AMS 9420s), these states are Advise, Maintenance, and Fail.

asset
Any physical component (such as a device or machine) being monitored by AMS Machine
Works, or the logical representation of a physical asset. Examples include: motor, pump,
fan, turbine, AMS Wireless Vibration Monitor, AMS 9420, and Emerson Wireless Gateway.

Asset Explorer
Utility that provides an interface for organizing and interacting with assets, and launching
other utilities.

asset extension
Adds tasks or actions to the software. It can introduce specific classes of assets to the
system, add menu options, and allow users to launch context-based dialogs and
applications.

asset health
A numeric value on a normalized health scale, 0–100, that creates a single health index for
an asset from the individual health score of the asset and from the health score of child
assets, if available.

asset location
A type of location represented by its own icon and can contain other locations, assets, or
devices. It has properties common to all assets, such a health score. A machine is a type of
asset location defined by AMS Machine Works.

asset priority
A value representing the importance of an asset with respect to other assets in the system:
Does Not Contribute, Low, Medium, High, or Very High.

asset source
Anything that collects data to be associated with an asset. For example, an Emerson
Wireless Gateway, an AMS Wireless Vibration Monitor, or AMS 9420 Wireless Vibration
Transmitter.

asset source location
A representation of the real-world, physical position of the asset source. Asset source
locations allow users to arrange assets and asset sources by their physical locations, in
addition to their logical positions in the network.

asset weight
The value associated with an asset, based on its priority, that affects the health calculation.

auto-binding
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Happens when an asset source on the network, such as an AMS Wireless Vibration
Monitor, is automatically bound to an asset source location in the Location navigator when
mapping channels of a machine.

binding
Process of associating a device in the Network navigator with an asset source location or
placeholder in the Location navigator. Binding completes the definition of an asset. There
are two methods of binding: auto-binding and late binding.

channel mapping
The association of each channel on an asset source with a particular measurement location
on a machine.

collection measurements

In Device Configuration, each device has collection measurements that bring in data to
AMS Machine Works.

dashboard

AMS Machine Works dashboard provides status, measurement, and health information of
machines and devices at-a-glance.

dynamic variable data
Four data values you can configure an AMS 9420 or any WirelessHART device to measure:
primary value, secondary value, tertiary value, and quaternary value (PV, SV, TV, QV).

event

Any occurrence in AMS Machine Works that a service or utility wants the system to record
and possibly react to. Certain events initiate a message that is delivered to users
subscribed to receive messages for the event type. A user should have access to the asset
as assigned by the AMS Machine Works administrator.

You can view all system events in the Event Viewer utility.

Event Viewer
Utility that allows you to view system-generated events.

failure effects
A filter option. Failure Effects identify and organize assets according to the effects they
cause if there is an equipment failure. For example, you can label a Machine type Fan with
Environmental Control if the purpose of the fan is to provide cooling to a production
environment.

filters
Labels for categorizing system elements to allow grouping and filtering using the Search
feature. In the Asset Explorer utility, you can label any asset with one or more of the
following labels: Failure Effects, Functions, Interfaces.

functions
A filter option. Functions describe the functionality of the asset. For example, for AMS
9420 Wireless Vibration Transmitters, you can apply the Functions Vibration,
Temperature, and Analytical.

ignore
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An asset state in which the messages and health of an asset is disabled for a user-specified
time period.

individual health score
The health of an asset calculated using the individual health score calculation method,
from the modules' health opinions reported on the asset.

interfaces
Extends the software by adding connectivity and communications to asset sources, such
as external devices or systems. An interface allows data to be stored and accessed in the
software.

interfaces
A filter option. Interfaces describe how the asset sends and receives information on the
network. Examples include HART and Ethernet.

late binding
The process of manually binding a placeholder to an asset source discovered on the
network.

Library
Stores configured class instances so you can quickly add them into the or navigators.

location
A logical representation of an area in a facility. You determine how to organize your facility
into locations.

Location navigator
An area in the Asset Explorer utility where you can create and organize your site, view
information about the locations and assets you create, and perform operations within the
context of a selected location or asset.

measurement location
The physical location where data is acquired; usually the physical location of a sensor.

Network navigator
An area in Asset Explorer that displays assets that have been added to the Network tab.
The assets are organized by their Asset Source Interface, then by asset.

Plant Calendar
Used to schedule plant activities and events such as plant maintenance outages.

spectrum

A spectrum plot is a graphical representation of vibration frequencies and their amplitude.
In AMS Machine Works you can view spectra in the Vibration Analyzer application or in the
AMS Machine Works Dashboard.

store on alert

Store on alert lets you capture data as specific measurement parameters go in or out of
alert states.

trends

A trend plot shows a number of measurements of a parameter over a period of time. In
AMS Machine Works you can view trends in the Vibration Analyzer application or in the
AMS Machine Works Dashboard.
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User Manager
Utility that lets you control and monitor access to various components of the software.

Vibration Analyzer
A module of AMS Machine Works that lets you analyze periodic vibration data collected
from supported devices connected to machines in your site.

waveform

A waveform plot is a graphical representation of how the vibration level changes with
time. In AMS Machine Works you can view waveforms in the Vibration Analyzer application
or in the AMS Machine Works Dashboard.
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spectrum plot (continued)
harmonic family list 146
label peaks 147
locate peak 147
mark cursors 132
peak list viewer 145
remove peak 147
view 144
view multiple spectrums in one plotting workspace
148

status summary 86
store on alert 29
Store on Alert
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AMS Asset Monitor 42
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switch accounts 170
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T
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display correlation plot 158
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show upper warning 159
view 156
view multiple plots on one plot 158
view normalized multiple trend plots 159

U

User Manager
Delete user 190
Disable user account 190
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lock a user account 191

V

Vibration Analyzer
change server 125

Vibration Analyzer (continued)
connection profile 125

W
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